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• Documentation and Release Notes on page xxi

• Documentation Conventions on page xxi

• Documentation Feedback on page xxiii

• Requesting Technical Support on page xxiv

Documentation and Release Notes

To obtain the most current version of all Juniper Networks
®
technical documentation,

see the product documentation page on the Juniper Networks website at

https://www.juniper.net/documentation/.

If the information in the latest release notes differs from the information in the

documentation, follow the product Release Notes.

Juniper Networks Books publishes books by Juniper Networks engineers and subject

matter experts. These books go beyond the technical documentation to explore the

nuances of network architecture, deployment, and administration. The current list can

be viewed at https://www.juniper.net/books.

Documentation Conventions

Table 1 on page xxii defines notice icons used in this guide.
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Table 1: Notice Icons

DescriptionMeaningIcon

Indicates important features or instructions.Informational note

Indicates a situation that might result in loss of data or hardware damage.Caution

Alerts you to the risk of personal injury or death.Warning

Alerts you to the risk of personal injury from a laser.Laser warning

Indicates helpful information.Tip

Alerts you to a recommended use or implementation.Best practice

Table 2 on page xxii defines the text and syntax conventions used in this guide.

Table 2: Text and Syntax Conventions

ExamplesDescriptionConvention

To enter configuration mode, type the
configure command:

user@host> configure

Represents text that you type.Bold text like this

user@host> show chassis alarms

No alarms currently active

Represents output that appears on the
terminal screen.

Fixed-width text like this

• A policy term is a named structure
that defines match conditions and
actions.

• Junos OS CLI User Guide

• RFC 1997,BGPCommunities Attribute

• Introduces or emphasizes important
new terms.

• Identifies guide names.

• Identifies RFC and Internet draft titles.

Italic text like this

Configure themachine’s domain name:

[edit]
root@# set system domain-name
domain-name

Represents variables (options for which
you substitute a value) in commands or
configuration statements.

Italic text like this
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Table 2: Text and Syntax Conventions (continued)

ExamplesDescriptionConvention

• To configure a stub area, include the
stub statement at the [edit protocols
ospf area area-id] hierarchy level.

• Theconsoleport is labeledCONSOLE.

Represents names of configuration
statements, commands, files, and
directories; configurationhierarchy levels;
or labels on routing platform
components.

Text like this

stub <default-metricmetric>;Encloses optional keywords or variables.< > (angle brackets)

broadcast | multicast

(string1 | string2 | string3)

Indicates a choice between themutually
exclusive keywords or variables on either
side of the symbol. The set of choices is
often enclosed in parentheses for clarity.

| (pipe symbol)

rsvp { # Required for dynamicMPLS onlyIndicates a comment specified on the
same lineas theconfiguration statement
to which it applies.

# (pound sign)

community namemembers [
community-ids ]

Encloses a variable for which you can
substitute one or more values.

[ ] (square brackets)

[edit]
routing-options {
static {
route default {
nexthop address;
retain;

}
}

}

Identifies a level in the configuration
hierarchy.

Indention and braces ( { } )

Identifies a leaf statement at a
configuration hierarchy level.

; (semicolon)

GUI Conventions

• In the Logical Interfaces box, select
All Interfaces.

• To cancel the configuration, click
Cancel.

Representsgraphicaluser interface(GUI)
items you click or select.

Bold text like this

In the configuration editor hierarchy,
select Protocols>Ospf.

Separates levels in a hierarchy of menu
selections.

> (bold right angle bracket)

Documentation Feedback

We encourage you to provide feedback so that we can improve our documentation. You

can use either of the following methods:

• Online feedback system—Click TechLibrary Feedback, on the lower right of any page

on the Juniper Networks TechLibrary site, and do one of the following:
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• Click the thumbs-up icon if the information on the page was helpful to you.

• Click the thumbs-down icon if the information on the page was not helpful to you

or if you have suggestions for improvement, and use the pop-up form to provide

feedback.

• E-mail—Sendyourcommentsto techpubs-comments@juniper.net. Includethedocument

or topic name, URL or page number, and software version (if applicable).

Requesting Technical Support

Technical product support is available through the JuniperNetworksTechnicalAssistance

Center (JTAC). If you are a customer with an active Juniper Care or Partner Support

Services support contract, or are covered under warranty, and need post-sales technical

support, you can access our tools and resources online or open a case with JTAC.

• JTAC policies—For a complete understanding of our JTAC procedures and policies,

review the JTAC User Guide located at

https://www.juniper.net/us/en/local/pdf/resource-guides/7100059-en.pdf.

• Product warranties—For product warranty information, visit

https://www.juniper.net/support/warranty/.

• JTAC hours of operation—The JTAC centers have resources available 24 hours a day,

7 days a week, 365 days a year.

Self-Help Online Tools and Resources

For quick and easy problem resolution, Juniper Networks has designed an online

self-service portal called the Customer Support Center (CSC) that provides youwith the

following features:

• Find CSC offerings: https://www.juniper.net/customers/support/

• Search for known bugs: https://prsearch.juniper.net/

• Find product documentation: https://www.juniper.net/documentation/

• Find solutions and answer questions using our Knowledge Base: https://kb.juniper.net/

• Download the latest versions of software and review release notes:

https://www.juniper.net/customers/csc/software/

• Search technical bulletins for relevant hardware and software notifications:

https://kb.juniper.net/InfoCenter/
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• Join and participate in the Juniper Networks Community Forum:

https://www.juniper.net/company/communities/

• Create a service request online: https://myjuniper.juniper.net

Toverify serviceentitlementbyproduct serial number, useourSerialNumberEntitlement

(SNE) Tool: https://entitlementsearch.juniper.net/entitlementsearch/

Creating a Service Request with JTAC

You can create a service request with JTAC on theWeb or by telephone.

• Visit https://myjuniper.juniper.net.

• Call 1-888-314-JTAC (1-888-314-5822 toll-free in the USA, Canada, and Mexico).

For international or direct-dial options in countries without toll-free numbers, see

https://support.juniper.net/support/requesting-support/.
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PART 1

Introduction to the NorthStar Controller

• NorthStar Controller Overview on page 3

• NorthStar Controller Web UI Introduction on page 13
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CHAPTER 1

NorthStar Controller Overview

• Understanding the NorthStar Controller on page 3

• NorthStar Controller Features Overview on page 6

Understanding the NorthStar Controller

The Juniper Networks NorthStar Controller is an SDN controller that enables granular

visibility andcontrol of IP/MPLS tunnels in large serviceprovider andenterprise networks.

Network operators can use the NorthStar Controller to optimize their network

infrastructure through proactivemonitoring, planning, and explicit routing of large traffic

loads dynamically based on user-defined constraints.

The NorthStar Controller provides networkmanagers with a powerful and flexible traffic

engineering solution with some important features:

• Complex inter-domain path computation and network optimization

• Comprehensive network planning, capacity, and topology analysis

• Ability to address multilayer optimization with multiple user-defined constraints

• Specificorderingandsynchronizationofpathssignaledacross routednetworkelements

• Global view of the network state formonitoring, management, and proactive planning

• Ability to receive an abstracted view of an underlying transport network and utilize the

information to expand its packet-centric applications

• Active/standby high availability (HA) cluster

• System and network monitoring

The NorthStar Controller relies on PCEP to instantiate a path between the PCC routers.

The path setup itself is performed through RSVP-TE signaling, which is enabled in the

network and allows labels to be assigned from an ingress router to the egress router.

Signaling is triggered by ingress routers in the core of the network. The PCE client runs

on the routers by using a version of the Junos operating system (JunosOS) that supports

PCEP.

The NorthStar Controller provisions PCEP in all PE devices (PCCs) and uses PCEP to

retrieve the current status of the existing tunnels (LSPs) that run in the network. By

providing a view of the global network state and bandwidth demand in the network, the

3Copyright © 2019, Juniper Networks, Inc.



NorthStar Controller is able to compute optimal paths and provide the attributes that

the PCC uses to signal the LSP.

NOTE: NorthStar supports functions related to LSPs and links for both
physicaland logical systems.However, for logical systems, real-timeupdates
to the topologyarenotpossiblebecause there isnoPCEPfor logical systems.
Instead, you can perform periodic Netconf collection for updated logical
topology information.

The following sections describe the architecture, components, and functionality of the

NorthStar Controller:

• Architecture and Components on page 4

• Interaction Between the PCC and the PCE on page 5

• Dynamic Path Provisioning on page 6

Architecture and Components

Based on the Path Computation Element (PCE) architecture as defined in RFC 5440,

the NorthStar Controller provides a stateful PCE that computes the network paths or

routes based on a network graph and applies computational constraints. A Path

Computation Client (PCC) is a client application that requests the PCE perform path

computations for thePCC’sexternal label-switchedpaths (LSPs). ThePathComputation

Element Protocol (PCEP) enables communication between a PCC and the NorthStar

Controller to learn about the network and LSP path state and communicate with the

PCCs. The PCE entity in the NorthStar Controller calculates paths in the network on

behalf of thePCCs,which request path computation services. ThePCCs receive and then

apply the paths in the network.

The stateful PCE implementation in the NorthStar Controller provides the following

functions:

• Allows online and offline LSP path computation

• Triggers LSP reroute when there is a need to reoptimize the network

• Changes LSP bandwidth when an application demands an increase in bandwidth

• Modifies other LSP attributes on the router, such as explicit route object (ERO), setup

priority, and hold priority

A TCP-based PCEP session connects a PCC to an external PCE. The PCC initiates the

PCEP session and stays connected to the PCE for the duration of the PCEP session.

During thePCEP session, thePCC requests LSPparameters from the stateful PCE.When

receiving oneormore LSPparameters from thePCE, thePCC resignals theTELSP.When

the PCEP session is terminated, the underlying TCP connection is closed immediately,

and the PCC attempts to reestablish the PCEP session.
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The PCEP functions include the following:

• LSP tunnel state synchronization between a PCC and a stateful PCE—When an active

stateful PCE connection is detected, a PCC synchronizes an LSP state with the PCE.

PCEP enables a fast and timely synchronization of the LSP state to the PCE.

• Delegation of control over LSP tunnels to a stateful PCE—An active stateful PCE

controls one or more LSP attributes for computing paths, such as bandwidth, path

(ERO), and priority (setup and hold). PCEP enables such delegation of LSPs.

• Stateful PCE control of timing and sequence of path computations within and across

PCEP sessions—An active stateful PCEmodifies one or more LSP attributes, such as

bandwidth, path (ERO), andpriority (setupandhold). PCEPcommunicates these new

LSP attributes from the PCE to the PCC, after which the PCC resignals the LSP in the

specified path.

Interaction Between the PCC and the PCE

For the NorthStar Controller, the PCC runs in a new Junos OS daemon, the Path

Computation Client Process (PCCD), which interacts with the PCE andwith the Routing

Protocol Process (RPD) through an internal JunosOS IPCmechanism. Figure 1 on page 5

shows the interaction among the PCE, PCCD, and RPD.

Figure 1: PCCD as Relay/Message Translator Between the PCE and RPD

The PCCD is stateless so it does not keep any state other than current outstanding

requests, and does not remember any state for established LSPs. The PCCD requests

the state after the response comes back from the PCE and then forwards the response

to the RPD. Because the PCCD is stateless, the RPD only needs to communicate with

thePCCDwhen the LSP is first created. After theRPD receives the results from thePCCD,

the results are stored (even across RPD restarts), and the RPD does not need to

communicatewith thePCCDagain until the LSP is rerouted (when the LSP configuration

is changed or the LSP fails).

5Copyright © 2019, Juniper Networks, Inc.
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Dynamic Path Provisioning

To provide dynamic path provisioning, each ingress label-edge router (LER) must be

configured as a Path Computation Client (PCC). Through PCEP, each PCC informs the

NorthStar Controller (PCE server) asynchronously about the state of LSPs, including LSP

operational state, admin state, and protection in-use events. The LSP state update and

LSP provisioning depend on the TCP/PCEP connection state. If the TCP connection goes

down as a result of connection flaps or PCC failure, the NorthStar Controller waits

approximately 60 seconds for PCC reconnection then removes the LSP state.

Related
Documentation

NorthStar Controller Features Overview on page 6•

NorthStar Controller Features Overview

TheNorthStar Controller software provides traffic-engineering-based solutions forWAN

and edge (data center edge andWAN edge) networks. After the NorthStar Controller

has connected to the network and dynamic topology acquisition is performed to provide

a real-time routing view of the network topology, you can view the network model from

theNorthStarControllerUI. Youcan thenplan, analyze, andassess the impactof network

changes you want to make before implementing them.

Highlights of supported use cases and features include:

• Multi-user login—Multiple full-accessuserscanbe logged intoNorthStar simultaneously

and a single user can log into NorthStar multiple times from different devices. This is

achieved with an architecture that distributes the responsibilities of the NorthStar

server.

• Web UI—Provides Operator access to the NorthStar Controller application. Features

available byway of thewebUI are defined by user role. ThewebUI is accessed through

a webserver URL, using amodern web browser.

NOTE: Planner functionality isnotavailable through thewebUI.Toperform
simulationswithout affecting the livenetwork, youmustuse theNorthStar
Planner Java client UI.

• Dynamic topology acquisition—Use routing protocols (IS-IS, OSPF, and BGP-LS) to

obtain real-time topology updates.

• Label-switched path (LSP) reporting—Label edge routers (LERs) use PCEP reports to

report all types of LSPs (PCC_controlled, PCC_delegated, and PCE_initiated) to the

NorthStar Controller.

• LSPprovisioning—Create LSPs fromtheNorthStarController or update LSPs that have

been delegated to the NorthStar Controller. You can also create multiple LSPs at one

time.

• Symmetric pair groups—Design a pair of LSPs so that the LSP from the ingress LER to

the egress LER follows the same path as the LSP from the egress LER to the ingress

Copyright © 2019, Juniper Networks, Inc.6

NorthStar Controller User Guide



LER.Youcanaccess this feature in thewebUIbynavigating toApplications>Provision
LSP, and clicking on the Advanced tab.

• Diverse LSPs—From the NorthStar Controller UI, design two LSPs so that the paths

are node, link, or SRLG diverse from each other.

NOTE: TheNorthStarController supportsdiversepoint-to-point LSPs.The
provisioning of diverse point-to-multipoint LSPs is not supported.

• Standby and secondary LSPs—Provide an alternate route in the event the primary

route fails. The tunnel ID, fromnode, to node, and IP address of a secondary or standby

LSP are identical to that of the primary LSP. However, secondary and standby LSPs

have the following differences:

• A secondary LSP is not signaled until the primary LSP fails.

• A standby LSP is signaled regardless of the status of the primary LSP.

• Time-based LSP scheduling—Schedule the creation of LSPs based on future

requirementsbyusing time-basedcalendaring.YoucanscheduleanLSPasaone-time

event or recurring daily event for a specified period of time to schedule setup,

modification, and teardown of LSPs based on the traffic load, bandwidth, and setup

and hold priority requirements of your network over time. The scheduling of an LSP is

configured on the primary path, and the scheduled time applies to all paths (primary,

secondary, and standby).

• LSP templates—The NorthStar Controller supports LSP templates configured on the

router. A template defines a set of LSP attributes to apply to all PCE-initiated LSPs

that provide a namematch with the regular expression (regex) name specified in the

template. By associating LSPs (through regex namematching) with an LSP template,

you can automatically enable or disable LSP attributes across any LSPs that provide

a namematch with the regex name that is specified in the template. In the NorthStar

UI, the same attributes are applied.

• Auto-bandwidth support—Auto-bandwidth parameters are figured on the router, even

when the LSP has been delegated to the NorthStar Controller. You can enable

auto-bandwidth parameters by way of a template on the router so that any

PCE-controlled LSP that provides a namematch with a regular expression (regex)

name defined in a template inherits the LSP attributes specified in that template. The

NorthStar Controller applies the same attributes and displays them in the UI.

NOTE: The bandwidth specified in a PCE-initiated LSPmust be greater
than or equal to theminimum bandwidth that is specified in an
auto-bandwidth template, or the template should not contain a
minimum-bandwidth clause. In addition, the bandwidth specified in a
PCE-initiated LSP should not exceed themaximum bandwidth that is
specified in the template.
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Auto-bandwidth behavior varies depending on the LSP type:

• Router-controlled (PCC-controlled) LSPs—The NorthStar Controller must learn

about router-controlled LSPs. The PCC performs statistical accounting of LSP

bandwidth andLSP resizing is drivenbybandwidth threshold triggers. TheNorthStar

Controller is updated accordingly.

• NorthStar Controller-managed (PCC-delegated) LSPs —The PCC performs

bandwidth accounting for these LSPs. When bandwidth thresholds are reached, a

PCReqmessage is sent to theNorthStarController’sPathComputationServer (PCS)

to compute the Explicit Route Object (ERO). The PCC determines how to resize the

LSP while the PCS provides the ERO that meets the constraints. These LSPs are

delegated as usual, and PCRpt messages are sent with the Delegation bit set.

When bandwidth threshold triggers are reached on the PCC, a PCRpt message is

sent to the PCE. The PCRpt message includes the vendor TLV specifying the new

requested bandwidth. The following conditions apply:

• If a new path is available, make-before-break (MBB) signaling is attempted and

a new path is signaled. The PCRpt message from the PCC to PCE reports the

updated path.

• If a new path is not found, the process described above is repeated whenever the

adjust interval timer is triggered.

• NorthStar Controller-created (PCE-initiated) LSPs—When an LSP is created from

the NorthStar Controller UI, a template defines the auto-bandwidth attributes

associatedwith theLSP,whichallows thePCCto treat theLSPasanauto-bandwidth

LSP. All other LSP behavior is the same as the NorthStar Controller-managed LSP.

• LSP optimization—Analyze and optimize LSPs that have been delegated to the

NorthStar Controller. You can use the Analyze Now feature to run a path optimization

analysis and create anoptimization report to help youdeterminewhether optimization

should be done. You can also use the Optimize Now feature to automatically optimize

paths, with or without a user-defined timer. A report is not created when you use

Optimize Now, and the optimization is based on the current network conditions, not

on the conditions in effect the last time the analysis was done.

• Enable or disable LSP provisioning from the NorthStar Controller—The administrator

can globally enable or disable provisioning of LSPs for all NorthStar Controller users

by navigating toAdministration>SystemSettings. If provisioning is disabled, changes
can still be made in the UI, but they are not pushed out to the network.

• Schedule maintenance events—Select nodes and links for maintenance. When you

schedule a maintenance event on nodes or links, the NorthStar Controller routes

delegated LSPs around those nodes and links that are scheduled for maintenance.

After completion of the maintenance event, delegated LSPs are reverted back to

optimal paths.

• Run simulations for scheduledmaintenance events—Run simulations from the

NorthStar Controller on scheduledmaintenance events for different failure scenarios

to test the resilience of your network, or run simulations before the event occurs.

Network simulation isbasedon thecurrentnetwork state for theselectedmaintenance
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events at the time the simulation is initiated. Simulation does not simulate the

maintenance event for a future network state or simulate elements from other

concurrent maintenance events. You can run network simulations based on selected

elements for maintenance or extended failure simulations, with the option to include

exhaustive failures.

• TE++ LSPs—A TE++ LSP includes a set of paths that are configured as a specific

container statement and individual LSP statements, called sub-LSPs, which all have

equal bandwidth.

For TE++ LSPs, a normalization process occurs that resizes the LSPwhen either of the

following two triggers initiates the normalization process:

• A periodic timer

• Bandwidth thresholds are met

When either of the preceding triggers is fired, one of the following events can occur:

• No change is required.

• LSP splitting—Add another LSP and distribute bandwidth across all the LSPs.

• LSPmerging—Delete an LSP and distribute bandwidth across all the LSPs.

For a TE++ LSP, the NorthStar Controller displays a single LSPwith a set of paths, and

the LSP name is based on thematching prefix name of all members. The correlation

between TE-LSPs is based on association, and the LSP is deleted when there is no

remaining TE LSP.

NOTE: TE++ is supported on PCC (router) controlled LSPs and delegated
LSPs, but TE++ LSPs cannot be created on the NorthStar Controller.

• Multilayer support—Improves the quality of NorthStar Controller path computations

by factoring in a level of information about the transport domain thatwould otherwise

not be available. The topology information is pushed to the NorthStar Controller client

in the formof aYANG-baseddatamodel over RESTCONFandRESTAPIs. This ensures

that theclientand the transport networkentity cancommunicate. Formore information

about YANG datamodeling, see draft-ietf-teas-yang-te-topo-01, YANGDataModel for

TE Topologies.

• OpenStack support using a two-VMmodel—TheNorthStar Controller can be installed

and run using a two-VMOpenStack model. The NorthStar Controller application is

installed on top of the Linux VM. The JunosVM is provided in Qcow2 format.

• User authentication with an external LDAP server—You can specify that users are to

be authenticated using an external LDAP server rather than the default local

authentication.Thisenables in-houseauthentication.Theclient sendsanauthentication

request to the NorthStar Controller, which forwards it to the external LDAP server.

Once the LDAP server accepts the request, NorthStar queries the user profile for

authorization and sends the response to the client. The NorthStar web UI facilitates

LDAP authentication configuration with an admin-only window available from the

Administration menu.
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• Secondary loopback address support—The NorthStar Controller supports using a

secondary loopback address as the MPLS-TE destination address. When youmodify

a node in the web UI, you have the option to add destination IP addresses in addition

to the default IPv4 router ID address, and assign a descriptive tag to each. You can

then specify a tag as the destination IP address when provisioning an LSP.

NOTE: A secondary IP addressmust be configured on the router for the
LSP to be provisioned correctly.

• P2MP support—The NorthStar Controller receives the P2MP names used to group

sub-LSPs together from the PCC/PCE, by way of autodiscovery. In the NorthStar

Controller web UI, a new P2MPwindow is now available that displays the P2MP LSPs

and their sub-LSPs. Detailed information about the sub-LSPs is also available in the

Tunnel tab of the network information table. From the P2MPwindow, right-clicking a

P2MP name displays a graphical tree view of the group.

• Admingroups—Admingroups, alsoknownas link coloringor resourceclassassignment,

aremanually assigned attributes that describe the “color” of links, such that links with

the same color conceptually belong to the same class. You can use admin groups to

implement a variety of policy-based LSP setups. Admin group values for PCE-initiated

LSPs created in the controller are carried by PCEP.

TheNorthStar ControllerwebUI also supports setting admin group attributes for LSPs

in the Advanced tab of the Provision LSP and Modify LSP windows. The admin group

for PCC-delegated and locally controlled LSPs can be viewed in the web UI as well.

For PCC-delegated LSPs, existing attributes can bemodified in the web UI.

• High availability (active/standby)—The NorthStar Controller high availability (HA)

implementation provides an active/standby solution, meaning that one node in the

cluster (the active node) runs the active NorthStar components (PCE, Toposerver,

Path Computation, REST), while the remaining (standby) nodes run only those

processes necessary tomaintain database and BGP-LS connectivity unless the active

node fails. HA is an optional feature.

• Multiple Network-Facing Interfaces for High Availability Deployments—A total of five

monitored interfaces are now supported, one of which is designated by the user as the

cluster communication (Zookeeper) interface. The net_setup.py script allows

configurationof themonitored interfaces inboth thehost configuration (Host interfaces

1 through5), and JunosVMconfiguration (JunosVM interfaces 1 through5). InHASetup,

net_setup.py enables configuration of all of the interfaces on each of the nodes in the

HA cluster.

• Source Packet Routing in Networking (SPRING), also known as segment

routing—Segment routing is acontrol-planearchitecture that enablesan ingress router

to steer a packet through a specific set of nodes and links in the network. For more

information about segment routing, see the following Junos OS documentation:

Understanding Source Packet Routing in Networking (SPRING). Adjacency segment ID

(SID) labels (associated with links) and node SID labels (associated with nodes) can

be displayed on the NorthStar topological map and SR-LSP tunnels can be created

using both adjacency SID and node SID labels.
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• Health monitoring—A process in the NorthStar Controller architecture that provides

healthmonitoring functionality in the areas of process, server, connectivity, and license

monitoring, and themonitoringofdistributedanalytics collectors inanHAenvironment.

Navigate to Administration > SystemHealth to viewmonitored parameters. Critical

health monitoring information is pushed to a web UI banner that appears above the

Juniper Networks logo.

• Analytics—Streamsdata fromthenetworkdevices, viadatacollectors, to theNorthStar

Controller where it is processed, stored, andmade available for viewing in the web UI.

The NorthStar Controller periodically connects to the network in order to obtain the

configuration of the network devices. It uses this information to correlate IP addresses,

interfaces, and devices. The collection schedule is user-configured. Junos Telemetry

Interface (JTI) sensorsgeneratedata fromthePFE(LSPtrafficdata, logical andphysical

interface traffic data), and send probes through the data-plane. In addition to

connecting the routing engine to the management network, a data port must be

connected to thecollector ononeof yourdevices. The restof thedevices in thenetwork

canuse that interface to reach thecollector. Viewsandwork flows in thewebUI support

visualization of collected data so it can be interpreted.

• Netconf Persistence—Allows you to create a collection task for netconf and display

the results of the collection. Netconf collection is used by the Analytics feature to

obtain the network device configuration information needed to organize and display

collected data in a meaningful way in the web UI.

• Provisioning of LSPs via Netconf—As an alternative to provisioning LSPs (P2P) using

PCEP (the default), you can now provision using Netconf. And with Netconf, you can

provision P2MP LSPs as well. To use Netconf, the NorthStar Controller must rely on

periodic device collection to learnabout LSPsandother updates to thenetwork.Unlike

with PCEP, the NorthStar Controller with Netconf supports logical systems.

Related
Documentation

• Understanding the NorthStar Controller on page 3
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CHAPTER 2

NorthStar Controller Web UI Introduction

• NorthStar Application UI Overview on page 13

• NorthStar Controller Web UI Overview on page 17

• User Management on page 21

• Work Order Management on page 30

NorthStar Application UI Overview

NorthStar has two user interfaces (UIs):

• NorthStar Controller UI (web)—for working with a live network

• NorthStar Planner UI (Java client)—for simulating the effect of various scenarios on

the network, without affecting the live network

UI Comparison

Table 3 on page 13 summarizes the major use cases for the Controller and Planner.

NOTE: All user administration (adding, modifying, and deleting users) must
be done from the web UI.

Table 3: Controller Versus Planner Comparison

NorthStar Planner (Java client)NorthStar Controller (web client)

Design, simulate, and analyze a network offline.Manage, monitor, and provision a live network in real-time.

Network topology map shows simulated or imported data for
nodes, links, and LSP paths.

Live network topologymap shows node status, link utilization,
and LSP paths.

Network information table shows simulated or imported data
for nodes, links, and LSPs.

Network information table shows live status of nodes, links,
and LSPs.

Import or add nodes, links, and LSPs for network modeling.Discover nodes, links, and LSPs from the live network using
PCEP or NETCONF.

Add and stage LSPs for provisioning to the network.Provision LSPs directly to the network.
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Table 3: Controller Versus Planner Comparison (continued)

NorthStar Planner (Java client)NorthStar Controller (web client)

Create or schedule simulation events to analyze the network
model from failure scenarios.

Create or schedule maintenance events to re-route LSPs
around the impacted nodes and links.

Report manager provides extensive reports for simulation and
planning.

Dashboard reports shows current status and KPIs of the live
network.

Import interface data or aggregate archived data to generate
historical statistics for querying and chart displays.

Analytics collects real-time interface traffic or delay statistics
and stores the data for querying and chart displays.

The NorthStar LoginWindow

You connect to NorthStar using amodern web browser such as Microsoft Edge, Google

Chrome, or Mozilla Firefox.

Your external IP address is provided to you when you install the NorthStar application.

In the address bar of your browser window, type that secure host external IP address,

followed by a colon and port number 8443 (for example, https://10.0.1.29:8443). The

NorthStar login window is displayed, as shown in Figure 2 on page 15. This same login

window grants access to the NorthStar Controller UI and the NorthStar Planner UI.

NOTE: If you attempt to reach the login window, but instead, are routed to
amessage window that says, “Please enter your confirmation code to
complete setup,” youmust go to your license file andobtain the confirmation
code as directed. Enter the confirmation code along with your administrator
password to be routed to thewebUI login window. The requirement to enter
the confirmation code only occurs when the installation process was not
completedcorrectly and theNorthStar applicationneeds to confirm that you
have the authorization to continue.
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Figure 2: NorthStar LoginWindow

WARNING: To avoid a Browser Exploit Against SSL/TLS (BEAST) attack,
whenever you log in to NorthStar through a browser tab or window, make
sure that the tab or windowwas not previously used to surf a non-HTTPS
website.Abestpractice is tocloseyourbrowserand relaunch itbefore logging
in to NorthStar.

NorthStarController featuresareavailable through thewebUI.NorthStarPlanner features

are available through the Java Client UI.

A configurable User Inactivity Timer is available to the System Administrator (only). If

set, any user who is idle and has not performed any actions (keystrokes ormouse clicks)

is automatically loggedoutofNorthStar after the specifiednumberofminutes.Bydefault,

the timer is disabled. To set the timer, navigate to Administration > SystemSettings in
the NorthStar Controller web UI.

Logging In to and Out of the NorthStar ControllerWeb UI

Table 4 on page 15 shows the Internet browsers that have been tested and confirmed

compatible with the NorthStar Controller web UI.

Table 4: Internet Browsers Compatible with the NorthStar Controller Web UI

BrowserOS

• Google Chrome versions 55, 56

• Mozilla Firefox version 53

• Microsoft Edge version 38.14393

Windows 10
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Table 4: Internet Browsers Compatible with the NorthStar Controller Web UI (continued)

BrowserOS

• Google Chrome versions 58

• Mozilla Firefox version 53

Windows 7

• Google Chrome versions 56

• Mozilla Firefox version 53

CentOS 6.8/6.9

• Google Chrome versions 58

• Apple Safari version 10.1.1

Mac OS

To access the NorthStar Controller web UI, enter the username and password provided

to you when you installed the NorthStar application. Optionally click the Enable Full
Access check box. Click Launch on the Controller side of the login window.

NOTE: Youwill be required to change your password after logging in for the
first time.

To log out of the web UI, click the User Options drop-downmenu (person icon) in the

upper right corner of the main window and select Log Out. Figure 3 on page 16 shows
the User Options drop-downmenu. If you close the browser without logging out, you are

automatically logged out after 10 seconds.

Figure 3: User Options Menu

Logging In to and Out of the NorthStar Planner Java Client UI

To access the NorthStar Planner, enter your credentials on the initial login window and

click Launch on the Planner side of the login window. The default memory allocation for
NorthStar Planner is displayed, which you canmodify. Click Launch in the memory
allocation window.

Depending on the browser you are using, a dialog boxmight be displayed, asking if you

want to open or save the .jnlp file, accept downloading of the application, and agree to

run the application. Once you respond to all browser requests, a dialog box is displayed

in which you enter your user ID and password. Click Login.
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You can also launch the NorthStar Planner fromwithin the NorthStar Controller by

navigating toNorthStar Planner from the More Options menu as shown in

Figure 4 on page 17:

Figure 4: More Options Menu

To log out of the NorthStar Planner, select File > Exit to display the Confirm Exit screen.

Click Yes to exit.

NorthStar ControllerWeb UI Overview

The NorthStar Controller web UI has five main views:

• Dashboard

• Topology

• Nodes

• Analytics

• Work Orders

Figure 5 on page 17 shows the buttons for selecting a view. They are located in the top

menu bar.

Figure 5: Web UI View Selection Buttons

NOTE: The availability of some functions and features is dependent on user
group permissions.

TheDashboard view presents a variety of status and statistics information related to the

network, in the form of widgets. Figure 6 on page 18 shows a sample of the available

widgets.
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Figure 6: Dashboard View

The Topology view is displayed by default when you first log in to the web UI.

Figure 7 on page 19 shows the Topology view.
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Figure 7: Topology View

The Topology view is the main work area for the live network you load into the system.

The Layout and Applications drop-downmenus in the topmenu bar are only available

in Topology view.

The Nodes view, shown in Figure 8 on page 19, displays detailed information about the

nodes in the network. With this view, you can see node details, tunnel and interface

summaries, groupings, and geographic placement (if enabled), all in one place.

Figure 8: Nodes View

TheAnalytics view, shown in Figure9onpage20, providesa collectionof quick-reference

widgets related to analytics.
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Figure 9: Analytics View

TheWorkOrders view, shown inFigure 10onpage20,presentsa table listingall scheduled

work orders. Clicking on a line item in the table displays detailed information about the

work order in a second table.

Figure 10:Work Orders View

Functions accessible from the right side of the topmenu bar have to do with user and

administrative management. Figure 11 on page 20 shows that portion of the topmenu

bar. These functions are accessible whether you are in the Dashboard, Topology, Nodes,

Analytics, or Work Orders view.

Figure 11: Right Side of the TopMenu Bar

The user and administrative management functions consist of:

• User Options (user icon)

• Account Settings

• Log Out

• More Options (menu icon)
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• Active Users

• Administration (the options available to any particular user depend on user group

permissions)

NOTE: The “Admin only” functions can only be accessed by the Admin.

• System Health

• Analytics

• Authentication (Admin only)

• Device Profile

• Task Scheduler

• License (Admin only)

• Logs

• Subscribers (Admin only)

• System Settings (Admin only)

• Transport Controller

• Users (Admin only)

• Documentation (link to NorthStar customer documentation)

• Planner (launches theNorthStarPlanner JavaclientUI,withoutclosingyourNorthStar

Controller web UI)

• About (version and license information)

Related
Documentation

NorthStar Application UI Overview•

User Management

In theNorthStarController application, a user hasaccess toboth theNorthStarController

web UI and the NorthStar Planner. Users and user groups that are created in either

Controller or Planner are carried over into the other. Because the available group

permissions are different in the Controller versus the Planner, you can adjust them in

either application.

User Groups and Permissions

When you first launch NorthStar, the pre-configured user groups available depend on

whether you are installing for the first time or upgrading from an earlier release.

• If you are installing theNorthStar Controller application for the first time (fresh install),

one user group is automatically created–Administrators. The Administrators user

group, bydefault, has full permissions in theworkordermanagement system–tocreate,
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approveor reject, andactivatework orders. See “WorkOrderManagement” onpage30

for more information about theWork Order management system.

In a fresh install, the only user pre-added to this group is the Admin. The Admin is a

special user who can access all features and functionality within NorthStar, including

those related to systemsettings, licensemanagement, authenticationmethodcontrol,

andusermanagement.Beingassigned to theAdministratorsusergroupdoesnotmake

a user an Admin. But the Admin is assigned to the Administrators user group.

• If you are upgrading fromaNorthStar release older than Release 4.1.0, two user groups

are automatically created–Administrators and Viewers.

IMPORTANT: All existing full-access users from the older release are pre-added to

the Administrators user group during the upgrade process. All view-only users from

the older release are pre-added to the Viewers user group. We recommend that the

Admin immediately access the User Management system (Administration >Users)
to create additional user groups, assign them appropriate permissions for handling

work orders, and assign each existing user to the appropriate user group based on

those permissions. The Admin is the only user who can access the User Management

system.

User and User GroupManagement (Admin Only)

User permissions are determined by the user group to which the user is assigned. Only

the Admin has access to the User Management systemwhere groups are created,

permissions are assigned to groups, and users are created. Every user must be assigned

to a group. Access the User Management system by navigating to Administration from
the More Options menu icon, and selectingUsers. The User Management window is

displayed as shown in Figure 12 on page 22.

Figure 12: User ManagementWindow

There is a relationship between the permissions users have and the functions in the

Administrationmenu that they can access (More Options in the upper right corner of the

NorthStar Controller window), as follows:

• All users (including users with ActivateWork Orders, ApproveWork Orders, or even no

permissions at all) can access:

• System Health

• Device Profile
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• Task Scheduler

• Logs

• Users with CreateWork Orders or Auto-ApproveWork Orders can additionally access:

• Analytics

• Transport Controller

• Additional functionality only the Admin can access:

• Authentication

• License

• Subscribers

• System Settings

• Users

There is also a relationship between user permissions and functions available in the

Applicationsmenu, as follows:

• Users with Create or Auto-Approve permission have access to the following functions:

• Provision LSP

• Provision Diverse LSP

• Provision Multiple LSPs

• Configure LSP Delegation

• Device Configuration

• Path Optimization

• Bandwidth Calendar

• Event View

• Reports

• Top Traffic

NOTE: Add, Modify, and Delete buttons are available in the Network
Information table.

• Users with any other permission(s) have access only to the following functions:

• Device Configuration (limited view-only))

• Bandwidth Calendar

• Event View
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• Reports

• Top Traffic

NOTE: Add, Modify, and Delete buttons are not available in the Network
Information table for these users.

Creating a User Group and Assigning Permissions

To create a new user group:

1. ClickManageUserGroups in the upper right corner of theUserManagementwindow.
The Manage User Groups window appears as shown in Figure 13 on page 24.

Figure 13: Manage User GroupsWindow

2. Click Add Group in the lower left corner. You are prompted to enter the name of the
new group. ClickOK. The new group is added to the list of groups in the Manage User

Groups window.

3. Select the new group in the list. On the right side of the window, click in the check

boxes for the permissions you want to assign to this group. A group can have any

combination of the available permissions selected, except that the first two

(Auto-ApproveWorkOrders andCreateWorkOrders) aremutually exclusive because

Auto-Approve permission includes Create permission. By default, none of the

permissions are checked as shown in Figure 14 on page 25.
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Figure 14: Selecting Permissions for a NewGroup

See “Work Order Management” on page 30 for more information about the available

permissions and how the work order management system functions.

4. Click Apply to complete the addition.

Creating, Modifying, and Deleting Users

Once the groups are created, you can create newusers and assign each to a group.When

you create a new user, youmust assign them a username, a password, and a group. To

create a new user:

1. Click Add in the User Management window. The Add User window is displayed as

shown in Figure 15 on page 26.
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Figure 15: Add UserWindow

2. Complete theUsername, Password (this is the initial password that the user can later

change), and Confirm Password fields. Click the down arrow beside the Group field

to select a group for this user from the list of existing groups. Profile Name, Email, and

Phone are optional fields.

3. Click Submit to complete the addition.

Tomodifyanexistinguser, either select theusernamefromtheUserManagementwindow

and clickModify, or just double click the username. Both actions display theModify User
windowwhere you canmodify the values you previously assigned.

To delete an existing user, select the username in the User Management window and

click Delete.

NOTE: There is no warning that you are about to delete the user, so be sure
of your intention before you clickDelete.

Modifying and Deleting User Groups

Tomodify the permissions assigned to a user group, click Manage User Groups in the

upper right corner of the User Management window to display the Manage User Groups
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window. Select the group to bemodified in the left side of the window and revise the

permissions in the right side of the window.

NOTE: Whenyouchange thepermissionsof agroup, all themembersof that
group are affected.

Before you can delete a group, youmust delete the users assigned to it, or reassign users

in that group to another group. To delete an empty group, select the group name in the

Manage User Groups window and click Delete.

NOTE: There is nowarning that you are about to delete the group, so be sure
of your intention before you clickDelete.

Active Users

The Active Users window shows who is currently logged in to the system, when they

logged in, how long they have been logged in, their user group, and whether they are

logged in to the web UI or the NorthStar Planner. This window is available to all users,

but is a particularly good user management tool for the Admin.

Access the Active Users window from the Menu icon (horizontal bars) in the upper right

corner of the web UI.

Figure 16 on page 27 shows the Active Users window, including the sorting and column

selection options that are available when you hover over a column heading and click on

the down arrow that appears.

Figure 16: Active UsersWindow

The Force Log Out button is available only to the Admin, for the purpose of selectively
disconnectingNorthStarController (asopposed toPlanner)user sessions. Todisconnect

a user session, select the user name to disconnect and click Force Log Out.
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User Account Settings

The Account Settings window is available to all users for purposes of updating their own

information. Click the user icon in the upper right corner of the web UI to view the User

Options drop-downmenu, which includes Account Settings and Log Out.

Figure 17 on page 28 shows the user options menu.

Figure 17: User Options Menu

Select Account Settings to display the Account Settings window shown in

Figure 18 on page 29.
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Figure 18: Account SettingsWindow

The Account Settings window allows you to change your password, create or change a

profilename(likeanickname) for yourself, enter your contact information (e-mail address

and telephone number), and set up date/time and time zone preferences for your web

UI display. You cannot change your username. ClickUpdate to save your changes, or
Cancel to discard them.

Related
Documentation

Work Order Management on page 30•
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Work Order Management

Work order management provides authorization and tracking for two kinds of change

requests:

• Requests related to the provisioning of LSPs

• Configuration change requests to be pushed to network routers using the Device

Configuration tool (Applications > Device Configuration)

Change requests (additions, deletions, andmodifications) are captured as work orders

andmust be approved and activated (provisioned) before they can take effect and be

seen in the network information table and in the topology (in the case of LSPs), or in the

router configurations (in the case of device configuration updates). Users can perform

the various functionswithin thework ordermanagement systembasedon their assigned

user group.

The life cycle of a work order is typically:

1. Created/submitted

2. Approved or rejected

3. Activated (if approved) - this step actually provisions the LSP(s) or pushes the

requested configuration change to the router(s)

4. Closed

All users canmonitor the status ofwork orders using theWorkOrderswindowaccessible

from the topmenu bar in the web UI.

Work orders are stored in the Cassandra database, each with a number of attributes

such as:

• Work order ID and state

• Identification of the submitter, approver, activator, and closer

• Comments added at any stage of the work order life cycle

• Provisioning status

• Error messages, if any

• Details of the action requested

• List of affected network elements and the pending actions on them

The Cassandra database is queried to populate theWork Orders window. Changes in

theWork Orders window are immediately saved back to the Cassandra database and

broadcast to all users in real time, so everyone has the most current information.
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Permissions In theWork Order Management System

What any individual user can do within the work order management system is based on

their user group. Each user group has permissions associated with it, allowing users in

that group to perform various tasks. At this time, the defined permissions are:

• CreateWork Orders

User can access the web UI window appropriate for the desired request, such as

Provision LSP, Modify LSP, Provision Multiple LSPs, Device Configuration, and so on.

Once the user clicks Submit (or Provision), a work order is created.

• Approve (or Reject)Work Orders

User can approve or reject work orders created by anyone, including those he himself

created (if he also has CreateWork Orders permission).

• Auto-ApproveWork Orders

User can create work orders which are automatically approved and activated. Create

and Auto-Approve are mutually exclusive because Auto-Approve includes Create.

Auto-Approve permission does not enable a user to approve work orders submitted

by other users. Auto-Approve permission also applies to the REST API, making

automated northbound integration possible with third-party systems or scripts.

NOTE: When activation is executed as a separate step, the user is offered
the opportunity to schedule the provision for a future date/time, and in the
case of device configuration, to launch a device collection task. But when
a user with Auto-Approve permission creates and submits a work order,
theapprovalandactivationare immediate,bypassingthescheduling/device
collection step.

• ActivateWork Orders

User can activate (provision) approved work orders created by anyone.

A user with none of these permissions can view the status of work orders, but cannot

alter them in any way.

See User Management for information about creating user groups and assigning

permissions to them.

Creating and Submitting aWork Order

AuserwithCreateorAuto-Approvepermissioncanaccess thewebUIwindowappropriate

for thedesired request, suchasProvisionLSP,ModifyLSP,ProvisionMultipleLSPs,Device

Configuration, and so on. Complete the fields in thewindow, and clickSubmit (for LSPs)
or Provision (for device configuration). This creates a work order and submits it into the
work order management system.

The newwork order appears in theWork Orders window, accessible from the top Menu

Bar in the web UI. The Status column lists the work order as Submitted. The Submitter
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Comment column is populated automatically. To modify the comment, clickModify
Submitter Comment in the upper right corner, enter your new comment, and clickOK.
For LSP provisioning work orders, the automatically-generated Submitter Comment

reflects the action (such as add or modify). For device configuration work orders, the

automatically-generated Submitter Comment reflects the action (such as add) and the

configuration template (configlet) name.

Figure 19 on page 32 shows theWork Orders windowwith work orders listed in the top

portion. The bottom portion of the window (Details) shows detailed information for the

highlighted work order, an LSP provisioning work order in this example.

Figure 19: Work OrderWindow

Figure 20 on page 32 and Figure 21 on page 33 show the Details section for an example

device configuration work order. There are two tabs: Details Status and Configuration.

The Configuration tab lists the CLI being pushed to the device(s).

Figure 20: Details for Device ConfigurationWork Order, Details Status Tab
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Figure 21: Details for Device ConfigurationWork Order, Configuration Tab

The Details part of the window for a Modify work order shows both the old and new

values.

Approving and Activating aWork Order

Work orders submitted by users with Auto-Approve permission are automatically

approvedandactivatedwhen theyare submitted, and their status is updated toActivated
in theWork Orders window. All other submitted work ordersmust be approved by a user

with Approve permission.

Toapproveawork order, highlight the row in theWorkOrderswindowandclickWorkflow
in the upper right corner of the window. Select Approve or Reject from the drop-down

window. Optionally, add a comment when prompted. The status for the work order is

updated accordingly.

A user with Activate permission must then activate the approved work order for it to

actually takeeffect. Toactivateaworkorder, highlight the row in theWorkOrderswindow

and clickWorkflow in the upper right corner. Select Activate from the drop-downmenu

todisplay theScheduleWorkOrderwindow.TheScheduleWorkOrderwindow isdifferent,

depending on whether the work order is related to LSP provisioning or to device

configuration.

NOTE: TheScheduleWorkOrderwindow is not presentedwhenwork orders
areauto-approved.Suchworkordersareapprovedandactivated immediately
upon submission.

Figure 22 on page 34 shows the ScheduleWork Order window for an LSP provisioning

work order. The calendar is displayed when you click the calendar icon.
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Figure 22: ScheduleWork OrderWindow for an LSP ProvisioningWork Order

Figure 23 on page 35 shows the ScheduleWork Order window for a device configuration

work order. In addition to being able to schedule the work order to take effect at a future

dayand time, youcanalsoopt to rundevice collection immediately afterwards, toupdate

the NorthStar topology.
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Figure 23: ScheduleWork OrderWindow for a Device ConfigurationWork Order

You can opt to provision the work order immediately or at a future date and time.

Optionally, youcanaddacommentwhenprompted.Onceactivated,NorthStarattempts

toprovision theLSP(forLSPworkorders), and theLSPappears in thenetwork information

table (Tunnel tab) and in the topology. When device configuration work orders are

activated, the configuration statements are pushed to the network devices according to

the instructions in the work order. Verify the provisioning is successful. TheWork Orders

window includes a column for Provisioning Status.

Best Practices

The followingbestpracticeshelp tokeep theWorkOrderswindowcurrentandmeaningful

over time:

• Submitters: close your work orders when they are no longer needed.
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Work orders are consideredopenuntil they aremanually closed; only openwork orders

are displayed in theWork Orders window.We recommend that you keep this display

as streamlined as possible by closing activated or rejected work orders when they are

no longer needed, thereby removing them from theWorkOrderswindow. Close awork

order by highlighting the row in the work orders table and clickingWorkflow in the

upper right corner of the window. Select Close.

NOTE: Only the user who submitted a work order can close it. Not even
the Admin can close awork order submitted by another user. A work order
can be closed by the user who submitted it as long as the status is
Submitted, Rejected, or Activated.

• Approvers and Activators: Monitor theWork Orders window regularly and advance

work orders promptly to keep themmoving through the work order management

system.

• All Users: Consider adding meaningful comments.

The submitter, approver, and activator comments are retained and displayed as part

of the work order record to help clarify what is happening with the work order at each

step in the process. The submitter comment is populated automatically and can be

changed.Theapproverandactivator commentsarecompletelyoptional, butpotentially

valuable.

Related
Documentation

• User Management

• Provision LSPs

• Push Configuration to Network Devices fromWithin the NorthStar Application on

page 91
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PART 2

NorthStar Controller Features

• Interactive Network Topology on page 39

• LSPManagement on page 99

• Path Computation and Optimization on page 149

• Working with Transport Domain Data on page 181

• High Availability on page 203

• SystemMonitoring on page 207

• Network Monitoring on page 219

• Data Collection and Analytics on page 231
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CHAPTER 3

Interactive Network Topology

• Topology View Overview on page 39

• Navigation Functions in the Topology View on page 41

• Interactive Map Features on page 42

• Layout Menu Overview on page 52

• Manage Layouts on page 53

• Configuration Viewer on page 54

• Applications Menu Overview on page 56

• Group and Ungroup Selected Nodes on page 57

• Distribute Nodes on page 60

• Reset Topology by Latitude and Longitude on page 61

• Left Pane Options on page 62

• Network Information Table Overview on page 79

• Sorting and Filtering Options in the Network Information Table on page 81

• Network Information Table Bottom Tool Bar on page 83

• Push Configuration to Network Devices fromWithin the NorthStar

Application on page 91

Topology ViewOverview

When you first log in to the web user interface, the initial window displays the Topology

view by default, as shown in Figure 24 on page 40.
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Figure 24: Topology View

The Topology view is the main work area for the live network you load into the system,

andhas the followingpanes (numberscorrespond to thecallouts inFigure24onpage40):

1. Left Pane—Drop-downmenu of map presentation options. Your selections are

reflected in the topology map pane.

2. Interactive graphical topology map pane—Use the topology map to access element

information and further customize the map display. The color legend at the bottom

is configurable and is tied to the Performance selection from the drop-downmenu in

the Left Pane.

3. Network information table—The network information table at the bottom of the

window has Node, Link, Tunnel, SRLG, Interface, P2MP, Demand, and Maintenance

tabs across the top of the table. Click a tab to display the properties for the network

elements of the type selected. TheMaintenance tabdisplays scheduledmaintenance

events, which are scheduled failures of selected network elements.

NOTE: If the Topology view should ever fail to refresh as expected, we
recommend you click the refresh button at the bottom of the window,
below the network information table.

Related
Documentation

Navigation Functions in the Topology View on page 41•

• Left Pane Options on page 62
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Navigation Functions in the Topology View

Many familiar navigation functions are supported in the Topology window, and are

summarized in Table 5 on page 41.

Table 5: Supported TopologyWindowNavigation Functions

MethodFunction

Left-click an element, hold while repositioning the cursor, then release.Drag and drop

Click a link or node to select it.Select an element

1. Hold down the Shift key and left mouse button while dragging the mouse to create a
rectangular selection box. All elements within the box are selected.

2. Hold down the Shift key and click multiple items, one at a time.

One application for selecting multiple elements is creating node groups.

Select multiple elements

Double click a link or node to display only that element in the network information table.Filter the network information
table to display an element

1. Use the mouse scroll wheel.

2. Click the +/- buttons in the upper right corner of the window.

Zoom in and out

Click the circular button that looks like a bull’s eye in the upper right corner of the window
to size and center the topology map to fit the window.

Zoom to fit

Right-clickablankpartof the topologymaporonamapelement toaccesscontext-relevant
functions.

Right-click to access functions

You can hover over some network elements in the topology map to display the element
name or ID.

Hover

When a left, right, up, or down arrow appears at the margin of a pane, you can click to
collapse or expand the pane.

Collapse/expand pane

You can click and dragmany of the panemargins to resize the panes in a display.Resize panes
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Interactive Map Features

The topologymap is interactive, meaning that you can use features within themap itself

to customize the map and the network information table. Themap uses a geographic

coordinate reference system. Some features enabled by that system include:

• Constrained zooming: NorthStar Controller performs coordinate checking so the view

is constrained to the coordinates of the earth.

• World wrapping/map wrapping: Scrolling the map in one direction is like spinning a

globe. This enables representation of links across an ocean, for example.

The following sections describe additional map features and functionality:

• Right-Click Functions on page 42

• Topology Menu Bar on page 45

• Topology SettingsWindow on page 46

Right-Click Functions

Right-click a node, selected nodes, or node group on the topology map to execute

node-specific filtering as shown in Figure 25 on page 42 and described in

Table 6 on page 43.

Figure 25: Right-Click Options for Nodes or Groups
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Table 6: Right-Click Options for Nodes or Groups

FunctionOption

Filters the nodes displayed in the network information table to display only
the selected node(s) or node group(s).

Filter in Node Table

Labels the nodes in the topology with the node SIDs from the perspective
of the node on which you right-clicked.

Node SIDs from selected node

Opens the Configuration Viewer, displaying the configuration of the node
onwhich you right-clicked. SeeConfiguration Viewer for prerequisites for the
configuration to be available.

Show Config

Opens a newwindow displaying the neighbors of the node on which you
right-clicked.

Show Neighbors

Filters the tunnels displayed in the network information table to include only
those that meet the On or Thru Node criteria.

Tunnels On or Thru Node

Filters the tunnels displayed in the network information table to include only
those that meet the Starting at Node criteria.

Tunnels Starting at Node

Filters the tunnels displayed in the network information table to include only
those that meet the Ending at Node criteria.

Tunnels Ending at Node

Prompts you to give the group of nodes a name, after which the group can
be expanded or collapsed on the topology map. This is a shortcut to the
Layout > Group selected nodes function.

Group selected nodes

Ungroups the nodes in the selected group. This is a shortcut to the Layout
> Ungroup selected nodes function.

Ungroup selected nodes

Ungroups the nodes in all groups. This is a shortcut to the Layout>Ungroup
All function.

Ungroup All

Arranges the selected nodes in a roughly circular patternwith the nodes and
links separated asmuch as possible. This is a shortcut to the Layout>Circle
selected nodes function.

Circle selected nodes

Forces the selected elements away from each other andminimizes overlap.
This is a shortcut to the Layout > Distribute selected nodes function.

Distribute selected nodes

Aligns the selected nodes in a linear pattern. This is a shortcut to the Layout
> Straighten selected nodes function.

Straighten selected nodes

Right-click a link on the topology map to execute link-specific filtering as shown in

Figure 26 on page 44 and described in Table 7 on page 44.
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Figure 26: Right-Click Options for Links

Table 7: Right-Click Options for Links

FunctionOption

Filters the tunnels displayed in the network information table to display only the selected
link.

Filter in Link Table

Filters the tunnels displayed in the network information table to include only those that
meet the On or Thru Link criteria.

Tunnels On or Thru Link

Opens a newwindow in which you select the time range for the events you wish to view.
Click Submit to open the Events window.

View Link Events

Opensanewtab in thenetwork information tableat thebottomof thewindow,displaying
the interface traffic.

View Interface Traffic

Opensanewtab in thenetwork information tableat thebottomof thewindow,displaying
interface delay over time.

View Interface Delay

Opensanewtab in thenetwork information tableat thebottomof thewindow,displaying
packet loss statistics.

View Packet Loss

NOTE: To clear the tunnel filter so that all tunnels are again displayed, click
a different tab (Node, for example), and then click the Tunnel tab again.

Right-click blank space in the topology map pane to access the whole-map functions

shown in Figure 27 on page 45 and described in Table 8 on page 45.
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Figure 27: Right-Click Options for the Topology Map as aWhole

Table 8: Right-Click Options for the Topology Map as aWhole

FunctionOption

Distributesall thenodes in themap,pushingelementsaway fromeachother
andminimizing overlap. This is a shortcut to selecting all nodes and
navigating to Layout>Distribute selected nodes.

Distribute All Nodes

Saves the current layout as your default. The default layout is displayed
when you first log in to NorthStar Controller. If you already have a default
layout, this function overrides the existing default. You can also designate
a default layout by navigating to Layout>Manage Layouts.

Save Default Map Layout

Selects all nodes on the topology map. This is a shortcut to using
shift-left-click to create a selection box around all nodes or individually
shift-clicking on all nodes.

Select All Nodes

Refreshes the display of link colors based on RSVP utilization.

NOTE: Updates are periodically pushed to the client by the server.

Refresh Utilization

Reloads the network to update the display.Reload Network

TopologyMenu Bar

On the right side of the topologywindow is amenubar offering various topology settings,

as shown in Figure 28 on page 46.
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Figure 28: Topology Settings Menu Bar

From themenu bar, you can:

• Center the topology in the window (target icon).

• Enlarge the topology in the window (plus symbol).

• Reduce the size of the topology in the window (minus symbol).

• Access the topology settings window (settings icon).

Topology SettingsWindow

Access the Topology Settingswindow by clicking on the settings icon (gear) in the upper

right corner of the topology window. Figure 29 on page 46 shows the settings icon.

Figure 29: Settings Icon to Access Topology Settings

The Topology Settingswindow containsmany topology display settings, all in one place.

Figure 30 on page 47 shows the Topology Settings windowwith the two tabs that group

related settings.

On theElements tab, youcanselect asmanysettingsas you likebyclicking theassociated

check boxes. When you select to Show Label for nodes or links, you can select only one

label from the corresponding drop-downmenu.

NOTE: NorthStar does not display node or link labels over a certain quantity,
even if the Topology Settings call for labels to be displayed. This improves
performance when redrawing a large number of graphic elements.
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Figure 30: Topology SettingsWindow, Elements Tab

NOTE: Drawing down links as a solid, rather than dashed, line can improve
performance when redrawing the topology.

A few of these settings might not be self-explanatory:

• Hide Partially Visible Links
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Removes from the display any links for which both end nodes are not within the field

of view. This is useful for focusing on a subset of a large network.

• Wrap Links as Great Arcs

Distinguishes links that would have to wrap around the world map. An example is

shown in Figure 31 on page 48.

Figure 31: Wrap Links as Great Arcs Example

The Options tab offers a variety of topology display preferences, as shown in

Figure 32 on page 49.
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Figure 32: Topology SettingsWindow, Options Tab

Topology View section

The two options available in this section are mutually exclusive; select one radio button

or the other. Clusters and Bundles is useful where the display of a large number of nodes

and links obscures visualization of the network as a whole. Clusters (of nodes) and

bundles (of links) simplify visualization by representing groups of nodes that are close

together as single, color-coded circles (clusters). Bundles (of links) are derived from the

links between nodes and clusters. Figure 33 on page 50 shows an example of how a

portion of a large network looks when represented as clusters and bundles.
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Figure 33: Clusters and Bundles Example

The number in each circle indicates the number of nodes in the cluster. The color coding

of the clusters corresponds to the number of nodes in the cluster. You can customize the

ranges by clicking on the color legend in the lower left corner of the map window as

shown in Figure 34 on page 50.

Figure 34: Customizing the Clusters Legend
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NOTE: When you select Clusters and Bundles, node and link labels are not
displayed.

Map Style section

The Light and Dark options available in this section are mutually exclusive; select one

radio button or the other. Figure 35 on page 51 shows an example of the light and dark

map styles.

Figure 35: Light and Dark Map Styles

If you select to ShowWorldMap, you can opt to display graticules (a grid of lines parallel

to meridians of longitude and parallels of latitude) and labeling of major populated

places (both shown in Figure 35 on page 51).

NOTE: Even if you deselect ShowWorld Map, the topology still behaves
according to geographical coordinates in terms of displaying the topology
within the field of view.

General section

Select the check boxes for as many of the options in this group as you like:

• ShowTooltips: Displays additional information about a node or link in the bottom right

corner of the map pane when youmouse over a network element.

• ShowMaintenance Marker: Displays a red M over any link currently part of a

maintenance event.

• Zoom to Selected Node from Table: With this option enabled, when you click on a

node entry in the network information table (Node tab), the topology automatically

centers the view on that selected node.

Use the Label Size drop-downmenu to select a font size for node and link labels.

Related
Documentation

Navigation Functions in the Topology View on page 41•

• Group and Ungroup Selected Nodes on page 57
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• Distribute Nodes on page 60

• Configuration Viewer

• Event View on page 220

Layout Menu Overview

The Layout drop-downmenu in the topmenu bar includes a number of options for

arranging elements on the topology map. Figure 36 on page 52 shows the Layout

drop-downmenu options.

Figure 36: Layout Drop-DownMenu

FromtheLayoutmenu, youcangroupandungroupnodes, distributenodesusingdifferent

models, reset the topology map according to geographical coordinates, save layouts,

andmanage saved layouts.

The import and export options allow you to:

• Import a layout from a CSV file.

• Import a layout from a GeoJSON file. JSON format is stricter than CSV, requiring

key-value pairs.

• Export a layout to a CSV file, which has headers only for hostname, longitude, latitude,

and group (less information than the GeoJSON file has).

• Export a layout to a GeoJSON file which you could then use in various mapping

applications that support GeoJSON format.
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Related
Documentation

Group and Ungroup Selected Nodes on page 57•

• Distribute Nodes on page 60

• Reset Topology by Latitude and Longitude on page 61

• Manage Layouts on page 53

Manage Layouts

To save a layout so you can quickly load it into the topology map pane at any time,

navigate to Layout>Manage Layouts. The Map Viewwindow is displayed as shown in

Figure 37 on page 53.

Figure 37: Map ViewWindow

Click Save. The Save Map window is displayed as shown in Figure 38 on page 53.

Figure 38: SaveMapWindow

Enter a nameanddescription for the current layout and specifywhether the saved layout

is to be shared by all operators (shared) or is to be available only to you (private). Click

Submit.

From the Map Viewwindow, where all your saved layouts are listed, you can click the

check box beside the layout you want as your default. The default layout is displayed

initially whenever you log in to NorthStar Controller.
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NOTE: You can also right-click a blank part of the topologymap pane and
select Save Default Map Layout to save the current layout as your default.
This action saves the current layout as your default, but does not change the
name of the default in the Manage Layouts window.

Selecta layoutanduse thebuttonsat thebottomof thewindowtoperformthe functions

listed in Table 9 on page 54.

Table 9: Map ViewWindow Buttons

FunctionButton

Save a new layout or update an existing layout.

NOTE: If you select an existing layout and click Save, the existing layout is replaced
by the new layout, without changing the name of the layout in the Manage Layouts
window.

Save

Load the layout into the map pane.Load

Edit the name or description of the selected layout.Edit

Delete the selected layout from your saved layouts.Delete

Related
Documentation

Layout Menu Overview on page 52•

• Group and Ungroup Selected Nodes on page 57

• Distribute Nodes on page 60

• Reset Topology by Latitude and Longitude on page 61

Configuration Viewer

You can view (view-only) the configuration of a router in the network using the

Configuration Viewer. Youmust set up the Device Profile (Administration > Device
Profile) and Device Collection (Administration > Task Scheduler) to retrieve the
configuration files before they are available in the Configuration Viewer.

To access the viewer for a node in the topology, right-click a node in the topology map

and select ShowConfig.

Figure 39 on page 55 shows an example of the configuration viewer.
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Figure 39: Configuration Viewer

The left pane displays the router configuration file. The right pane displays an outline

viewthatgroups theconfigurationbystatementblocks inwhichyoucandrill down.When

you click a specific statement in the right pane, it is displayed in context in the left pane.

The colored text in the configuration file in the left pane highlights nested levels, version,

password, and comment statements.

Clicking the triangle icon in the upper right corner of the viewerwindowopens the search

field at the bottom of the window. Enter your search text and click Find or Find Prev to
move forward or backward through the search results.

You can also access the Configuration Viewer from the Integrity Checks report. After you

perform device collection, the router configuration files are scanned and the NorthStar

Controller flags anything suspicious. The resulting report provides hints as towhatmight

need attention.

To inspect the router configuration file from this report, right-click a line item in the report

and select ShowConfig to open the Configuration Viewer. If the report line item is for an

LSP, the configuration viewer opens a separate tab for each end of the tunnel so you can

see both relevant configuration files.

Related
Documentation

Scheduling Device Collection for Analytics via Netconf•

• Reports Overview on page 227
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ApplicationsMenu Overview

From the Applicationsmenu in the topmenu bar, you can perform some of the functions

also available in the network information table including provisioning LSPs, diverse LSPs,

andmultiple LSPs. You can also configure LSP delegation, set up optimization, and

access reports.

The Top Traffic option displays a pane on the right side of the Topology window that

lists the computedTopNTraffic over Xperiodof timebyNode, Interface, LSP, or Interface

Delay. Select N and X by clicking on the currently selected settings in the lower right

corner of the display.

Two utilities that open in separate browser windows or tabs are also launched from this

menu:

• Bandwidth Calendar—Used to visualize andmanage scheduled LSPs.

NOTE: Thebandwidth calendar timeline is emptyuntil you schedule LSPs.

• Event View—Displays events coming in from the topology server. You have a number

of options for how this information is organized and displayed.

Figure 40 on page 56 shows the Applications drop-downmenu.

Figure 40: Applications Drop-DownMenu

Related
Documentation

Provision LSPs on page 104•

• Provision Diverse LSP on page 119

• Provision Multiple LSPs on page 121
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• Configure LSP Delegation on page 126

• Path Optimization on page 149

• Maintenance Events on page 170

• Reports Overview on page 227

• Bandwidth Calendar on page 142

• Event View on page 220

Group and Ungroup Selected Nodes

You can represent a collection of nodes on the topology map as a single entity by first

selecting the nodes, and then navigating to Layout>Group selected nodeswhere you
are prompted to give the groupaname. Toungroup thenodes in a group, select the group

on themap and then navigate to Layout>Ungroup selected nodes.

NOTE: A shortcut to these functions is available. Select the nodes to be
included in the group and then right-click on any one of them.

Using the Groups list in the left pane, you can control how the group is displayed in the

topologymap—asasinglegroupentity or as individualmembernodes.Whenyouexpand

a group in the Groups list using the plus (+) sign next to the group name, all themember

nodes are listed in the left pane and are displayed in themap.When you collapse a group

in the Groups list using theminus sign (-), only the group name appears in the left pane,

and the group is represented by a single icon in the map. Figure 41 on page 58 shows a

collapsed group in the Groups list in the left pane and the resulting representation of the

group in the topology map.
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Figure 41: Topology Mapwith Collapsed Group List

As shown in Figure 42 on page 58, when the group is expanded in the Groups list, the

individual nodes are displayed in the map instead of a single group icon.

Figure 42: Topology Mapwith Expanded Group List

Auto Grouping

You can auto group nodes by navigating to Layout > Auto Grouping.

The Auto Grouping option allows you to usemultiple rules in sequence to group nodes,

using rule set builder functionality. Figure 43 on page 59 shows the AutoGroupWindow

Copyright © 2019, Juniper Networks, Inc.58

NorthStar Controller User Guide



with two levels of grouping configured. In this example, nodes are to be grouped first by

ISIS area and then by site.

Figure 43: AutoGroupWindow

When you click the Add button (+) to add a new rule, you then specify rule type as either

City, Country, Continent, AS, ISIS Area, OSPF Area, Site, or Regular Expression. You can

change the order of the rules by clicking on a rule and using the up and down arrows to

reposition the rule in the list. You can also select to apply auto-grouping to all nodes or

just to the nodes that you have selected on the topology map. To delete a rule, select it

and click the Delete button (trash can). The Edit function (pencil icon) is only available

for Regular Expression rules.

WhenyouselectRegular Expressionas the rule type, theRegular ExpressionRulewindow

is displayed as shown in Figure 44 on page 60.

59Copyright © 2019, Juniper Networks, Inc.

Chapter 3: Interactive Network Topology



Figure 44: Regular Expression RuleWindow

Use the drop downmenu to select Hostname, Name, IP Address, or Type. Then enter

the text in the Find the first match for field. Click the check box if you want the match
to be case sensitive.

Related
Documentation

Layout Menu Overview on page 52•

• Left Pane Options on page 62

• Distribute Nodes on page 60

• Reset Topology by Latitude and Longitude on page 61

• Manage Layouts on page 53

Distribute Nodes

From the Layoutsmenu, you can selectmultiple nodes and redistribute them to improve

visual clarity or for personal preference. You can select all the nodes in the topology to

applyadistributionmodel, or youcanselecta subset suchasedgedevicesor coredevices.

Three models are available as described in Table 10 on page 60.

Table 10: Node Distribution Models

DescriptionModel

Arranges the selected nodes in a roughly circular pattern with the nodes and links separated
as much as possible.

Circle

Forces the selected elements away from each other andminimizes overlap.Distribute

Aligns the selected nodes in a linear pattern.Straighten
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NOTE: A shortcut is available to access the distribution options. Select the
nodes on the topologymap and then right-click on any one of them.

Related
Documentation

Layout Menu Overview on page 52•

• Group and Ungroup Selected Nodes on page 57

• Reset Topology by Latitude and Longitude on page 61

• Manage Layouts on page 53

Reset Topology by Latitude and Longitude

You can reset the distribution of nodes on the topology map according to geographical

coordinates if youhave set the latitudeand longitude valuesof thenodes. It canbeuseful

to have the country map backdrop displayed when you use this distribution model.

To configure latitudeand longitude for a node, select thenode in thenetwork information

table at the bottom of the Topology view, and clickModify in the bottom tool bar. In the

Modify Node window, click the Location tab. Figure 45 on page 61 shows the Location

tab of the Modify Node window.

Figure 45: Modify NodeWindow

Click the Location tab and enter latitude and longitude values using signed degrees

format (DDD.dddd):

• Latitudes range from -90 to 90.

• Longitudes range from -180 to 180.
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• Positive values of latitude are north of the equator; negative values (precede with a

minus sign) are south of the equator.

• Positive longitudes are east of the Prime Meridian; negative values (precede with a

minus sign) are west of the Prime Meridian.

NOTE: You can either enter the values directly or you can use the up and
down arrows to increment and decrement.

You can optionally enter a site name in the Site field.

Click Submit.

To redistribute the nodes in the topology map according to the latitude and longitude

values of the nodes, navigate to Layout>Reset by Coordinates.

Turning on theWorld Map also triggers a reset by latitude and longitude. To turn on the

World Map in the topology window, click the Tools icon (gear) on the right side of the

topology window and select the Options tab. Click the check box for ShowWorld Map.

You can also set node latitude and longitude coordinates in theNorthStar Planner client,

and copy those values to the nodes in the Live Network model. Any existing coordinate

values in theLiveNetworkmodelareoverwrittenby thisaction, an importantconsideration

since the Live Network model is shared by all users.

Related
Documentation

Layout Menu Overview on page 52•

• Group and Ungroup Selected Nodes on page 57

• Distribute Nodes on page 60

• Manage Layouts on page 53

Left Pane Options

The left pane drop-downmenu offers several ways to filter the data that is displayed in

the NorthStar Controller topology map pane, as well as several views related to status

and network properties. When you first log in to the web user interface, the initial view

shows Network Status. Table 11 on page 62 summarizes the left pane drop-downmenu

choices.

Table 11: NorthStar Controller Topology View Left Pane Options

DescriptionOption

Displays a summary of the current status of network elements.Network Status

Displays a list of timestamped network events. You can use filtering to
narrow the display to specific types of event. This information can be
useful for debugging purposes.

Timeline
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Table 11: NorthStar Controller Topology View Left Pane Options (continued)

DescriptionOption

Lists node types you can opt to display or hide on the topology map.Types

Displays user-created groups with or without listing the member nodes.
Expanded groups are represented on the topology map by individual
node icons. Collapsed groups are represented on the topology map by
group icons, and the individualmembernodesarenotdisplayed.All nodes
start out as ungrouped.

Nodes/Groups

Current (live network) and historical groups of performance options.Performance

Selects protocols to include in the topologymap. Nodes configuredwith
selectedprotocolsaredisplayed.Thedefault option includesall protocols.

Protocols

Selects autonomous systems (ASs) to include in the topology map.AS

Selects ISIS areas to include in the topology map.ISIS Areas

Selects OSPF areas to include in the topology map.OSPF Areas

Displays path optimization statistics and information.Path Optimization Status

Provides bit-level link coloring.Link Coloring

Reflects the multilayer feature. If you have amultilayer license,
information can be displayed that has been parsed fromTransport Layer
vendors. The topology map shows interlayer links between nodes as
dotted lines.

Layers

The following sections describe the left pane display options:

• Network Status on page 64

• Timeline on page 65

• Types on page 67

• Nodes/Groups on page 68

• Performance on page 70

• Protocols on page 70

• AS on page 71

• ISIS Areas on page 72

• OSPF Areas on page 73

• Path Optimization Status on page 74

• Link Coloring on page 75

• Layers on page 76
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Network Status

Figure 46 on page 64 shows an example of the Network Status display in the left side

pane of the Topology view. Network Status is the view that is displayed in the left pane

when you first launch the NorthStar Controller application.

Figure 46: Left Pane Network Status Example

The panel displays the percentage and count of the network’s active paths, active links,

and active PCCs that are in anUP state. The display is updated every one to twominutes,

dependingon the frequencyof incomingevents.Thebusier thenetwork, themore frequent

the update.

The number of paths detoured and LSPs in the process of being provisioned are also

noted. Detoured paths are those using a bypass LSP.

These numbers could differ fromwhat is reported in the network information table:
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• Active Paths: by design, the Active Paths reported in the Network Status display is not
thesameaswhat is reported in theTunnel tabof thenetwork information tablebecause

the Tunnel tab includes secondary paths and the Active Paths display does not. If you

have a secondary path for any LSPs, the Active Paths display and the Tunnel tab in

the network information table do not match.

• Active Links: should always match the Link tab in the network information table if the
internalmodel is in syncwith the live network. If they don’tmatch, it can be a symptom

that the internal model has become out of sync with the live network. On a regular

basis,when the internalmodel is updated, it iswithchanges to the livenetwork topology,

notwitha rebuildingof theentire topology. Soover time, themodel and the livenetwork

can become out of sync. To correct this problem, replenish the internalmodel with the

entire live network information using Sync Network Model under Administration >
SystemSettings.

• Active PCC: by design, the Active PCC reported in the Network Status display is not
the sameaswhat is reported in theNode tabof thenetwork information table because

the Node tab includes pseudo nodes and the Active PCC display does not. The Active

PCC display only includes nodes that are routers; it does not include pseudo nodes

such as Ethernet nodes or AS nodes. If you have pseudo nodes in the network, the

Active PCC display and the Node tab in the network information table do not match.

Timeline

Figure 47 on page 66 shows an example of the Timeline display in the left side pane of

the Topology view.
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Figure 47: Left Pane Timeline Example

The timeline lists activities and status checkpoints with the most recent notations first.

You can use the Timeline to track chronological events as they occur in the network, in

order to take appropriate action in real time. You can also use the scroll bar to view past

network activities, going back as far as needed.

You can use the filtering box at the bottom of the pane to narrow the display to specific

types of event, or to events associated with a specific day or time.

When the timeline is not current, a message is displayed at the top of the Timeline pane

inviting you to “click here” to update the display.

You can assess the stability of the MPLS network by tracking changes in the number of

LSP Up and Down events over time. You can then analyze whether the occurrence of

specific other events affects the number of LSP Up and Down events.

The following event types are included in the Timeline:
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Related to nodes:

• PCEP session goes Down

• PCEP session goes Up

• PCEP session becomes ACTIVE

Related to links:

• Link goes Up

• Link goes Down

Related to LSPs:

• Change in the number of LSPs that are Up

• Change in the number of LSPs that are Down

• Change in the number of LSPs that are being provisioned

Related to NorthStar Controller:

• Path optimization start and end times

• Maintenance events start and end times

Types

The Types list in the left pane of the Topology view includes categories of nodes and

links found in the network. Figure 48 on page 67 shows a sample Types list.

Figure 48: Left Pane Types List
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Different types are associated with different icons, which are reflected in the topology

map. The example shown in Figure 48 on page 67 includes transport and interlayer link

types associated with the Coriant transport controller vendor.

You can select or deselect a type by checking or clearing the check box beside it. Only

selected options are displayed in the topology map. Click Check All to select all check
boxes; click Clear All to clear all check boxes.

You can right-click on a node type and select Properties to choose the icon that will

represent that node type in the topology map. You can also upload your own icon from

there.

Figure 49 on page 68 shows the icon selection window.

Figure 49: Icon SelectionWindow

NOTE: All nodes of one type use the same icon.

Nodes/Groups

You can create groups of nodes using the topologymap and the Layoutmenu. Once you

have groups in your topology, the Groups list in the left pane of the Topology view shows

all your node groups, and lists all nodes not included in any group under the heading

UNGROUPED.

When you expand a group listing using the plus (+) sign next to the group name, all the

member nodes are listed.When you collapse a group listing using theminus sign (-), only

thegroupnameappears. InFigure50onpage69,Group1andUNGROUPEDareexpanded,

and Group 2 is collapsed.
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Figure 50: Groups List Showing Expanded and Collapsed Groups

The topology map reflects the expansion and collapse of the groups in the groups list.

For an expanded group, all individual nodes are displayed in the topology map, without

indication ofwhich group they belong to. For a collapsed group, the individual node icons

are collectively represented by a group icon. Hover over or click on the group icon in the

map todisplay thegroupname. If youcollapseUNGROUPED in theGroups list, thenodes

disappear from the topology map. Figure 51 on page 69 shows the arrangement from

Figure 50 on page 69 along with the corresponding topology map.

Figure 51: Topology Map Showing a Collapsed Group
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Performance

Under Performance, you have the option to display on the topology map current (live

network) or historical (analytic traffic collection) data as shown in Figure 52 on page 70.

Figure 52: Performance Options

Click the radio button for the option you want displayed on the topology map. You can

only have one option selected at a time. The color legend at the bottom of the topology

map changes to correspond with your selection. See “Topology Map Color Legend” on

page 152 for information about customizing the legend.

For the historical options, there is a slide bar in the upper left corner of the map, visible

in Figure 52 on page 70. See “ViewingAnalytics Data in theWebUI” on page 258 formore

information about how to use this feature to help visualize and interpret analytics data.

Click Settings at the bottom of the Performance options window to select the amount

of historical data to load.

Protocols

The Protocols list includes all protocols present in the current topology.

Figure 53 on page 71 shows an example.
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Figure 53: Protocols List

Protocols can be selected or deselected by selecting or clearing the corresponding check

boxes. Only network elements that support selected protocols are displayed in the

topology map.

NOTE: SelectDefault to display all protocols on the topologymap. If you do
not want elements supporting all protocols to be displayed on the topology
map, be sure to clear the Default check box.

Click Check All to select all check boxes; click Clear All to clear all check boxes.

AS

The autonomous systems (AS) list assigns a color, for purposes of representation on the

topology map, for each AS number configured in the network. In Figure 54 on page 72,

routers configured with AS 11 appear on the topology map as red dots. NONE shows the

color assigned to routers with no AS configured.
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Figure 54: AS List

Select or deselect AS numbers by selecting or clearing the corresponding check boxes.

Only selected AS numbers are displayed in the topology map.

Click Check All to select all check boxes; click Clear All to clear all check boxes.

ISIS Areas

The ISIS Areas list assigns a color, for purposes of representation on the topology map,

for each IS-IS area identifier configured in the network. Thearea identifier is the first three

bytesof the ISOnetworkentity title (NET)address. InFigure55onpage73, routerswhose

NET addresses include area identifier 11.0007 appear on the topology map as red dots.

Thosewith area identifier 49.0011 appear as green dots. NONE shows the color assigned

to routers with no NET address configured.
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Figure 55: ISIS Areas List

ISIS area identifiers can be selected or deselected by checking or clearing the

corresponding check boxes. Only selected area identifiers are displayed in the topology

map.

Click Check All to select all check boxes; click Clear All to clear all check boxes.

OSPF Areas

TheOSPF Areas list assigns a color, for purposes of representation on the topologymap,

for eachOSPF area configured in the network. NONE shows the color assigned to routers

with no OSPF area configured.

In Figure 56 on page 74, routers with OSPF area 0 configured appear on the topology

map as red dots. Those with OSPF area 1 appear as green dots. NONE shows the color

assigned to routers with no OSPF area configured.
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Figure 56: OSPF Areas List

Select or deselect OSPF areas by selecting or clearing the corresponding check boxes.

Only selected areas are displayed in the topology map.

Click Check All to select all check boxes; click Clear All to clear all check boxes.

Path Optimization Status

Figure 57 on page 75 shows an example of the Path Optimization Status display in the

left side pane of the Topology view.
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Figure 57: Left Pane Path Optimization Status Example

Displays path optimization statistics and information, such as the number of paths that

were last optimized, the percent of bandwidth savings achieved, the percent hop count

savings, and the time and date of the next optimization if one is scheduled.

Link Coloring

This option offers bit-level link coloring as shown in Figure 58 on page 76.
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Figure 58: Bit-Level Link Coloring

Layers

The Layers list gives you the option to exclude or include individual layer information in

the topology map.

Figure 59 on page 77 shows an example of the Layers list with IP and transport layer

options.
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Figure 59: Layers List

Use the Layers list to select the layers (IP or Transport or both) that you want to display.

If you are not using the Multilayer feature, the Layers list contains only IP and is not an

applicable filter.

Click Check All to select all check boxes; click Clear All to clear all check boxes.

Figure 60 on page 78 shows an example of a topology map that includes both IP Layer

and Transport Layer elements. The dotted link lines indicate interlayer links.
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Figure 60: Topology with IP and Transport Layers

Related
Documentation

Topology View Overview on page 39•

• Viewing Analytics Data in theWeb UI on page 258
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Network Information Table Overview

Network information is displayed in the pane at the bottom of the Topology view, below

the topology map. An example of the table is shown in Figure 61 on page 79.

Figure 61: Network Information Table

Tabsappear across the topof thenetwork information table. Thecolumnsof information

change according to the tab you select (Node, Link, Tunnel, Demand, Interface,

Maintenance, P2MP Group, SRLG). Within the tables, each row represents an element.

The element information can be rearranged and, in some cases, added to, filtered,

modified, or deleted. When you select an element in the network information table, the

corresponding element is selected in the topology map.

On any element, you can right-click for options relevant to that element. For example, if

you right-click a tunnel, you have the options shown in Figure 62 on page 79.

Figure 62: Right-Click Options Example
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If you select View Events, for example, you are first prompted to select a time range and

clickSubmit, afterwhich awindowsimilar to the example shown in Figure63onpage80

is displayed.

Figure 63: View Events Example

NOTE: The events included in the View Events window are restricted to
external communication toandfromNorthStar.Mostof thecommunications
internal to NorthStar are captured only in the log files. This allows you to
focus on the informationmost likely to be useful to you as a NorthStar
operator.

Onanyelement, youcandoubleclick fordetailed informationabout that specific element.

For example, if you double click a node, you see information similar to that shown in

Figure 64 on page 80.

Figure 64: Example of Information Displayed by Double Clicking a Node

The teardrop-shaped icon in the upper right corner of the details window controls the

pin behavior described in Table 12 on page 81.
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Table 12: Pin Behavior in Network Element Detail Windows

BehaviorPin State

When unpinned, double clicking a second element in the network information table replaces the
contents of the first details windowwith the details of the second element. In this scenario, there is
only one details window open at a time.

Unpinned

When pinned, double clicking a second element in the network information table opens a newdetails
window, leaving the first window intact.

TIP: If you double click a second element, but you still only see one details window, try moving the
window to the side by clicking-and-dragging the window heading. The windowsmight be stacked.

Pinned

The Node, Link, and Tunnel tabs are always displayed. The other tabs are optionally

displayed. Click the + sign in the tabs heading bar to add a tab as shown in

Figure 65 on page 81.

Figure 65: Adding a Tab to the Network Information Table

Click the X beside any optionally displayed tab heading to remove the tab from the

display.

Related
Documentation

Sorting and Filtering Options in the Network Information Table on page 81•

Sorting and Filtering Options in the Network Information Table

For many of the columns in the network information table, sorting and filtering options

become available when you hover over the column heading and click the down arrow

that appears.

Table 13 on page 82 describes the sorting and filtering options that could be available,

depending on the data column.
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Table 13: Sorting and Filtering Options

DescriptionOption

Sorts the list of elements from lowest to highest.Sort Ascending

Sorts the list of elements from highest to lowest.Sort Descending

Click the check boxes to add or remove columns in the network information table.Columns

For some columns, the Filters option provides a search box. For other columns, the Filters
option allows you to enter values in greater than (>), less than (<), or equal to (=) fields. To
remove a filter, clear the check box next to the Filters option.

Filters

NOTE: In some topologies, the list of network elements can includemultiple
pages of data. NorthStar only offers sorting capabilities on the active page.
In that case, try filtering to narrow down the number of rows displayed.

Using the Filters option, you can filter the devices that are included in the display by

activating a filter on any column. For example, if you want to display only the tunnels

that have 103 in their configured IP Z address, hover over the IP Z column heading, click

the down arrow that appears, and enter 103 in the filter box. The Filters check box is
automatically selected, and the display is filtered accordingly. The IP Z column heading

appears as italicized to indicate an active filter on the column. Figure 66 on page 82

illustrates this example.

Figure 66: Example: Filtering on a Column

To remove a filter, clear the Filters check box. You do not need to remove the filter text,

allowing you to toggle the filter on and off without reentering the text.
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Related
Documentation

Network Information Table Overview on page 79•

Network Information Table Bottom Tool Bar

The bottom tool bar in the network information table has tools for navigating through

the network element data, as well as Add, Modify, and Delete buttons for performing

actions on elements.

The Add, Modify, and Delete buttons behave differently, depending on which type of

element you are working with; these functions are not always allowed. When they are

not allowed, the buttons are grayedout. TheModify andDelete buttons becomeenabled

when an individual element row is selected, as long as the action is allowed on that

element.

The topology server (Toposerver) requires that certain conditions bemet before it will

allow you to delete a link or node.

• To delete a link:

• The link’s operational status must be down. The operational status is changed to

down when Toposerver receives the first LINKWITHDRAWmessage from NTAD.

• The link cannot have active IS-IS or OSPF adjacencies. IS-IS and OSPF adjacencies

are droppedwhen Toposerver receives the second LINKWITHDRAWmessage from

NTAD.

To delete a node:

• The nodemust be isolated, meaning that all links associated with the node have

been deleted (after the link deletion conditions have beenmet).

• Thenodecannothave IS-IS,OSPF, orPCEPconnections. IS-ISandOSPFadjacencies

are cleared when Toposerver receives a NODEWITHDRAWmessage from NTAD

and the PCEP session has been terminated. This workflow ensures that TED and

Toposerver are synchronized.

For some elements, you canmodify or delete multiple items at once (bulk modify) by

Ctrl-clicking or Shift-clicking multiple line items in the table. For example, if you select

multiple items in the Tunnel tab and clickModify, the Modify LSP (X LSPs) window is

displayed as shown in Figure 67 on page 84.
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Figure 67: Modify Multiple LSPsWindow

The window supports deleting the contents of a field, leaving the contents unchanged,

or changing the contents to a specific value. Depending on the type of data the field

contains, you can click to toggle, use the up and down arrows to select a value, or

double-click to set a value. For fieldswhere a blank value is not allowed (required fields),

the option to delete is not available.

Navigation Tools

The tools in the network information table bottom tool bar are available to help you

navigate through rows of data, refresh the display, and change the number of rows per

loaded page. These tools are especially useful for large models with many elements.

Table 14 on page 84 describes the tools in the bottom tool bar. Not all of the tools are

available for all element types (node, link, interface, and so on).

Table 14: Navigation Tools in the Network Information Bottom Tool Bar

DescriptionTool or Button

Displays the first page of data.<<

Displays the previous page of data.<

Displays the specific page of data you enter.Page __ of <total pages>

Displays the next page.>

Displays the last page.>>
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Table 14: Navigation Tools in the Network Information Bottom Tool Bar (continued)

DescriptionTool or Button

Manually refreshes the data.

Downloads the table information to spreadsheet.

Opens a search criteria field. Enter the search criteria and click the Filter button on
the far right of the field. The table and the topology display only the results of the
search.

After a search, restores the topology to the full network display.

Click the down arrow to specify a grouping for the table contents.

Specifies the number of rows per loaded page.

Actions Available for Nodes

For nodes, Add is not a supported function. Delete is allowed as long as the prerequisites

for node deletion have beenmet, as described earlier in this topic. Modify is allowed and

is optionally used to set or change the latitude and longitude of a node, change node

properties, or add IP addresses.

Figure 68 on page 86 shows the Properties tab of the Modify Node window. All of the

fields on this tab can bemodified.
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Figure 68: Properties Tab of the Modify NodeWindow

Figure 45 on page 61 shows the Location tab of the Modify Node window. NorthStar

Controller uses latitude and longitude settings to position nodes on the country map,

and also to calculate distances when performing routing by distance.

Figure 69: Location Tab of the Modify NodeWindow

Enter latitude and longitude values using signed degrees format (DDD.dddd):

• Latitudes range from -90 to 90.

• Longitudes range from -180 to 180.
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• Positive values of latitude are north of the equator; negative values (precede with a

minus sign) are south of the equator.

• Positive longitudes are east of the Prime Meridian; negative values (precede with a

minus sign) are west of the Prime Meridian.

Enter a site name in the Site field.

NOTE: When provisioning diverse LSPs, NorthStar might return an error if
the value you enter in the Site field contains special characters, depending
on the version of Node.js in use. We recommend using alphanumeric
characters only.

Figure 70 on page 87 shows the Addresses tab of the Modify Node window.

Figure 70: Addresses Tab of the Modify NodeWindow

The NorthStar Controller supports using a secondary loopback address as theMPLS-TE

destination address. In the Addresses tab of the Modify Node window, you have the

option to add destination IP addresses in addition to the default IPv4 router ID address,

and assign a descriptive tag to each. You can then specify a tag as the destination IP

address when provisioning an LSP.

NOTE: A secondary IP addressmust be configured on the router for the LSP
to be provisioned correctly.

Click Add to create a new line where you can enter the IP address and the tag.

Click Submit to complete the nodemodification.
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Actions Available for Links

For links, Add is not a supported function. Delete is allowed as long as the prerequisites

for link deletion have beenmet, as described earlier in this topic. Modify is available and

is primarily used in support of the Multilayer feature. Sometimes, when interlayer links

are initially loaded into themodel, only the source is known. In those cases, you can select

Node Z (the remote node name) from the drop-downmenu, and enter IP Z (the

corresponding IP link end on Node Z) to manually connect the Transport Layer to the IP

Layer. You can also specify the Type of the link and add your comments for reference.

On the Advance tab, you can specify Delay and AdminWeight values for the link. On the

User Properties tab, you can add properties not already defined. The Properties tab of

the Modify Link window is shown in Figure 71 on page 88.

Figure 71: Modify LinkWindow, Properties Tab

Actions Available for Tunnels

For tunnels, Add, Modify, and Delete are available functions for PCE-initiated tunnels.

Delegated tunnels cannot be added or deleted.

Figure 72 on page 89 shows the Provision LSP window.
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Figure 72: Provision LSPWindow

NOTE: You can also reach the Provision LSPwindow from the Applications
menu in the topmenu bar by navigating toApplications>Provision LSP. See
Provision LSPs for descriptions of the data entry fields in this window.

The Modify LSP window has the same data entry fields as the Provision LSP window

(not all of which can bemodified).

Actions Available for SRLGs

Shared Link Risk Group (SRLG) information can come from two sources:

• BGP-LS

• Transport controller

The information from these sources ismerged and presented in thewebUI. You can also

Add, Modify, and Delete user-defined SRLGs.
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Actions Available for Maintenance Events

Add, Modify, and Delete are available functions in the network information table for

maintenance events. You can also reach the Add Maintenance Event window from the

Applications menu in the topmenu bar by navigating to Applications>Maintenance.
See “Maintenance Events” on page 170 for descriptions of the data entry fields in theAdd

Maintenance Event window.

TheModifyMaintenanceEventwindowcontains thesamefieldsas theAddMaintenance

Event window.

NOTE: You can access the Maintenance Event Simulation window by
right-clicking in amaintenance event row and selecting Simulate.

Actions Available for Interfaces

Interfaces cannot be added, modified, or deleted from the network information table.

Actions Available for P2MPGroups

Add,Modify, andDeleteareavailable functions in thenetwork information table forP2MP

groups. These functions are for P2MP groups only, not for sub-LSPs within a group. To

modify or delete sub-LSPs, use the Tunnel tab.

See “Provision andManage P2MPGroups” on page 134 for descriptions of the data entry

fields in the Add P2MP Group window.

Actions Available for Demand

The Demand tab displays LDP Forwarding Equivalent Class (FEC) data compiled as a

result of LSP collection tasks. This data cannot be added, modified, or deleted from the

network information table. See LDP Traffic Collection for information about this data.

The Demand tab also displays demands resulting from the Netflow Collector, which you

candelete, but not addormodify. Demandsarenever automatically deleted. SeeNetflow

Collector for more information about Netflow Collector data.

Related
Documentation

Network Information Table Overview on page 79•

• Sorting and Filtering Options in the Network Information Table on page 81

• Maintenance Events on page 170

• Provision and Manage P2MP Groups on page 134

• LDP Traffic Collection

• Netflow Collector
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Push Configuration to Network Devices fromWithin the NorthStar Application

Using the Device Configuration tool, together with theWork Order Management tool,

you can push configuration statements to Juniper devices in the network, without leaving

the NorthStar application. Users with the necessary permission can create templates

(called “configlets”), where you specify which routers should receive the configuration

and the specific Junos OS configuration statements to include. Once a template is

provisioned, the request enters theWork Order Management system. Logical systems

and a view-only mode are supported.

NOTE: At present, only Juniper devices are supported.

The following sections describe using the Device Configuration tool:

• Overview on page 91

• Creating a Configuration Template on page 91

• Role of theWork Order Management System on page 96

• Modifying or Deleting Configlets on page 97

• More About ViewMode on page 97

Overview

TheDeviceConfiguration tool inNorthStarusesconfiguration templatescalled “configlets”

topush JunosOSconfiguration statements to Junosdevices in thenetwork. Eachconfiglet

specifies the configuration statements to include and the routers that are to receive the

configuration. Before actually pushing the configuration, you have the option to verify

the statements in the context of Junos syntax, leveraging the Junos commit check
function.

Only users with Create or Auto-Approve permission can create, modify, or delete

templates. These users can also tag templates as being available in ViewMode, where

all users can see them. Untagged templates are not available in viewmode. This tagging

method can be used to keep works in progress from being viewed by all users, or to

separate what different teams have access to.

See User Management for information about how permissions are assigned to groups,

and therefore, to users.

Creating a Configuration Template

To create a new configlet:
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1. Navigate to Applications >Device Configuration to display the Device Configuration
window as shown in Figure 73 on page 92. This window lists all the previously saved

configlets (if any) and indicateswhether or not they are available in ViewMode. There

are no default templates, so if none have been created, the list is blank.

Figure 73: Device ConfigurationWindow

ClickAdd in the upper right corner of thewindow to display the AddConfigletwindow

as shown in Figure 74 on page 92.

Figure 74: Add ConfigletWindow
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2. In the Properties tab:

• Give the configlet a name.

• If you want the configlet to be visible in ViewMode, click the ViewMode check box.

Otherwise, leave it blank.

• All of the eligible Junos devices in the network are listed under Applies To. Click the

check box for each one that is to receive the configuration. If you want all the listed

devices to receive the configuration, click the check box beside ID.
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NOTE: Logical systems are supported. Not all networks have logical
devices, but for every physical device that has a corresponding logical
device, there is an information icon beside the physical device in the list
of devices. Click the information icon to see the logical device. An
example is shown in Figure 75 on page 94.

Figure 75: Physical Device with Associated Logical Device

3. In the CLI Commands tab:

• Enter the configuration statements, one statementper line. This is the configuration

that is to be pushed to the routers.
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NOTE: If you want a logical device to receive configuration, youmust
select the corresponding physical device and include configuration
statements that are appropriate to logical devices in the list of
commands. In the same list, you can have statements that affect the
physical device, statements that affect the logical device, or some of
each.

• Toverify thestatements in thecontextof Junossyntax, leveraging the Junoscommit
check function, click Validate in the lower left corner of the window. This button is
also available on the Properties tab. A Validate CLI Commands feedback window

lets youknow if thevalidationwassuccessful. Performing this checkdoesnot submit

the work order or push the configuration to the routers.

An example configuration statement is shown in Figure 76 on page 95.

Figure 76: Add ConfigletWindow, CLI Example

Figure 77 on page 96 shows the feedback you would see if the validation were

unsuccessful and if it were successful.
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Figure 77: Validate Button Feedback

4. Click Submit to save the template.

Role of theWork Order Management System

Deviceconfiguration requestsmustbesubmitted to theworkordermanagementsystem,

and then be approved and activated before the configurations are actually pushed to

the devices. Group permissions and the assignment of users to groups dictate which

users can perform the various functions in the work order management system. See

“WorkOrderManagement” onpage30 to learn how thework ordermanagement system

works and what the various permissions enable users to do.

Specifically in relation to device configuration:

• A user with CreateWork Orders permission can create, modify, and delete configlets

and submit them to the work order management system.

• A user with Approve (or Reject) Work Orders permission can approve or reject device

configuration work orders created by anyone, including those he himself created (if he

also has CreateWork Orders permission).

• A user with Auto-ApproveWork Orders can create device configuration work orders

whichareautomaticallyapprovedandactivated.CreateandAuto-Approvearemutually
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exclusivepermissionsbecauseAuto-Approve includesCreate.Auto-Approvepermission

does not enable a user to approve work orders submitted by other users.

• AuserwithActivateWorkOrders canactivate (provision)approveddeviceconfiguration

work orders created by anyone.

This is the work flow to complete a device configuration work order:

1. In the Device Configuration window, a user with Create or Auto-Approve permission

clicks the check boxes for one or more configlets to be pushed to the devices. If you

select multiple configlets, a work order is created for each one.

2. The user clicks Provision in the lower left corner of the window. This creates the work
order. If the submitter has Auto-Approve permission, the work order is automatically

approved and activated. Otherwise, a user with Approve permission takes the next

step.

3. A user with Approve permission approves (or rejects) the device configuration.

4. A user with Activate permission activates the approved work order. Once activated,

the configuration is pushed to the specified devices.

Modifying or Deleting Configlets

From the Device Configuration window, you canmodify or delete an existing configlet

by selecting the rowandclickingModifyorDelete in theupper right corner of thewindow.
If youmodify a configlet, you should submit it to thework ordermanagement system for

updating on the router(s). Deletions do not create work orders.

More About ViewMode

Users who do not have Create or Auto-Approve permission can only access Device

Configuration in ViewMode. Figure 78 on page 97 shows what the navigation to

Applications > Device Configuration looks like for the view-only user. Note the limited
options in the Applications menu.

Figure 78: View-Only Navigation to Device Configuration

Figure 79 on page 98 shows what the Device Configuration window looks like in View

Mode.
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Figure 79: Device ConfigurationWindow in ViewMode

Only configlets that were tagged ViewMode are visible. Select a configlet and clickView
in the upper right corner of the window to see details of the configlet. No changes can

bemade in ViewMode.

Related
Documentation

• User Management

• Work Order Management on page 30
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CHAPTER 4

LSP Management

• Understanding Label-Switched Paths on the NorthStar Controller on page 99

• Understanding the Behavior of Delegated Label-Switched Paths on page 102

• Provision LSPs on page 104

• Provision Diverse LSP on page 119

• Provision Multiple LSPs on page 121

• Configure LSP Delegation on page 126

• Templates for Netconf Provisioning on page 127

• Provision and Manage P2MP Groups on page 134

• Bandwidth Calendar on page 142

• Creating Templates to Apply Attributes to PCE-Initiated Label-Switched

Paths on page 143

• Creating Templates with Junos OS Groups to Apply Attributes to PCE-Initiated

Label-Switched Paths on page 145

Understanding Label-Switched Paths on the NorthStar Controller

The NorthStar Controller uses PCEP or Netconf to learn about LSPs in the discovered

network topology, and all LSPs and their attributes can be viewed from the NorthStar

Controller user interface. However, the LSP type determines whether the Path

Computation Client (PCC) or NorthStar Controller maintains the operational and

configuration states.

The following LSP types are supported on the NorthStar Controller:

• PCC-controlled LSP: The LSP is configured locally on the router, and the router

maintains both theoperational state andconfiguration state of the LSP. TheNorthStar

Controller learns these LSPs for the purpose of visualization and comprehensive path

computation. Using Netconf, these LSPs can be created or modified in NorthStar.

• PCC-delegatedLSP:TheLSP isprovisionedon thePCC(router)andhasbeendelegated

to the NorthStar Controller for subsequent management. The operational state and

configuration state of the LSP is stored in the PCC. For delegated LSPs, the ERO,

bandwidth, LSPmetric, andpriority fieldscanbechanged fromtheNorthStarController

user interface. However, the NorthStar Controller can return delegation back to the

PCC, in which case, the LSP is reclassified as PCC-controlled.
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• PCE-initiated LSP: The LSP is provisioned from the NorthStar Controller UI. For these

LSPs, only the operational state is maintained in the router, and only NorthStar can

update the LSP attributes.

NOTE: There are a couple of circumstances under which the NorthStar
Controller would discover these LSPs from the router, even though they
are PCE-initiated:

• A PCE-initiated LSP could be created by a controller other than the
NorthStar Controller, and then discovered by NorthStar from the router.

• When you reset the topology in the NorthStar Controller, NorthStar
re-learns the LSPs from the router.

TheNorthStar Controller supports thediscovery, control, and creation of protection LSPs

(standbyandsecondaryLSPs). ForprotectionLSPs, theprimary, secondary, andstandby

LSPmust be of the same type (PCC-controlled, PCC-delegated, or PCE-initiated). Each

LSP can have its own specific bandwidth, setup priority, and hold priority or can use the

values of the primary LSP (the default). A primary LSPmust always be present for

controller-initiated LSPs.

ProvisioningMethod

NorthStar Controller supports twomethods for provisioning andmanaging LSPs: PCEP

andNetconf.When you provision an LSPusing PCEP, the LSP is added as aPCE-initiated

LSP. When you provision using Netconf, the LSP is added as a PCC-controlled LSP.

NOTE: At this time, NorthStar Controller supports Netconf provisioning on
Juniper devices only.

Table 15 on page 100 summarizes the provisioning actions available for each type of LSP

in the NorthStar Controller.

Table 15: NorthStar Provisioning Actions by LSP Type

Delete LSPModify LSPProvision LSPLSP Type

NetconfNetconfNetconfPCC-controlled LSP

NetconfPCEPN/APCC-delegated LSP

PCEPPCEPPCEPPCE-initiated LSP

NOTE: NorthStar does not offer a way to directly provision a new
PCC-delegated LSP.What you can do though, is provision a new
PCC-controlled LSP using Netconf and then delegate the LSP to NorthStar
Controller by navigating to Applications > Configure LSP Delegation.
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In NorthStar, both PCEP andNetconf device collection discover the same LSP attributes

(in other words, there are no additional LSP attributes discovered only by device

collection).

The followingactionsareperformedor availablewhenLSPprovisioning is doneviaPCEP,

but not when done via Netconf:

• Automatic reprovisioninguponprovisioning failure: If provisioning viaNETCONF fails,
such as when there is a commit failure or the NETCONF session is down, NorthStar

does not retry the provisioning and youwould need to resubmit the provisioning order.

This is applicable to any provisioning for PCC-controlled LSPs and deletion of

PCE-delegated LSPs.

• LSP rerouting: When receiving an LSP down event from the network, NorthStar does

not automatically recompute and reprovision a new path for PCC-controlled LSPs.

• Path Optimization: When you run path optimization, PCC-controlled LSPs are not

optimized.

• Maintenance: PCC-controlled LSPs are not rerouted to avoid scheduledmaintenance
events.

RoutingMethod and Path Selection

When provisioning PCC-controlled LSPs via Netconf in NorthStar, you have the option

to specify that NorthStar should compute and provision the path for the LSP, or not. You

specify this option by setting the LSP routing method:

• routeByDevice routing method—This is the default routing method when a

PCC-controlled LSP is created or learned by NorthStar. When a PCC-controlled LSP

has routeByDevice routing method, the NorthStar Controller does not compute and

provision a path.

• Other routing methods (default, delay, and so on)—When a PCC-controlled LSP has

a routing method that is not routeByDevice, the NorthStar Controller computes and

provisions the path as a strict explicit route when provisioning the LSP. The LSP’s

existing explicit routemight bemodified to a NorthStar-computed strict explicit route.

For example, a loose explicit route specified by the user or learned from the router

would bemodified to a strict explicit route.

NOTE: NorthStar saves the computed strict explicit route with Preferred
path selection. This allows NorthStar, when it needs to re-compute the
LSP path, to try to follow the strict explicit path, while still enabling it to
compute an alternate path if the strict explicit path is no longer valid.

Deletion of LSPs on the Router

When an LSP is removed from the router, and therefore from the network, it is

automatically deleted from NorthStar unless it has beenmodified by a NorthStar user

(via the web UI or REST APIs), and therefore has a Persist state associated with it. Any
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LSP with a Persist state that is deleted from the router would require manual deletion

in NorthStar.

Related
Documentation

Understanding the NorthStar Controller on page 3•

• Understanding the Behavior of Delegated Label-Switched Paths on page 102

Understanding the Behavior of Delegated Label-Switched Paths

You can delegate the management of a router-configured label-switched path (LSP)

to the NorthStar Controller by configuring the LSP from the router to be externally

controlled. Any router-controlled LSP on the PCC can be delegated to the NorthStar

Controller.

WhenanLSP is externally controlled, thecontrollermanages the followingLSPattributes:

• Bandwidth

• Setup and Hold priorities

• LSPmetric

• ERO

Any configuration changes to the preceding attributes performed from the router are

overriddenby thevaluesconfigured fromthecontroller. Changesmade to theseattributes

from the PCC do not take effect as long as the LSP is externally controlled. Any

configurationchangesmade fromthePCCtakeeffectonlywhen theLSPbecomes locally

or router controlled.

In both standalone and high availability (HA) cluster configurations, whenever a PCEP

session goes down on a PCC, all the LSPs that originated from that PCC are removed

from NorthStar except those with design parameters saved in NorthStar Controller.

Examples of LSPs with design parameters include:

• PCE-initiated LSPs

• PCC-delegated LSPs with LSP attributes such as path, that have beenmodified by

NorthStar

The following sections provide additional information:

• Behavior of Delegated LSPs That Are Returned to Local PCC Control on page 102

• Modifying Attributes of Delegated LSPs on the NorthStar Controller on page 104

Behavior of Delegated LSPs That Are Returned to Local PCC Control

When an LSP is externally controlled, any attempt to change the configuration of the

LSP from the PCC (except for auto-bandwidth parameters) results in the display of a

warning message from the router CLI. For delegated LSPs, any parameters configured

from the PCC take effect only after the LSP is returned to local (PCC) control. When the

LSP is returned to local control, the PCEP report messages report the state to the

NorthStar Controller. If the NorthStar Controller is not available when the PCC

Copyright © 2019, Juniper Networks, Inc.102

NorthStar Controller User Guide



configuration is changed locally, but becomesavailable some timeafter the configuration

changes are made, the LSP is delegated with the reports carrying the latest state. When

an LSP is externally controlled, configuration changes to bandwidth, setup and hold

priorities, LSPmetric, andEROareoverriddenby thecontroller. Anyconfigurationchanges

to these attributesmade from the PCC do not take effect as long as the LSP is externally

controlled. Only after the LSP becomes locally or router controlled will any configuration

changesmade fromthePCC takeeffect. Table 16onpage 103 shows theLSPparameters

that can and cannot be configured from the PCC.

Table 16: Behavior of LSP Configurations Initiated from PCC

DescriptionConfiguration Statement

Not applicable to packet LSP.admin-down

Results in an MBB. The new LSP is reported; the old LSP is reported with the R-bit set.admin-group

PCCautomatically adjustsbandwidthbasedon the traffic on the tunnel. Supportedon Juniper
Networks routers only.

auto-bandwidth

Results in an MBB. The new LSP is reported; the old LSP is reported with the R-bit set.bandwidth

Results in an MBB. The new LSP is reported; the old LSP is reported with the R-bit set.bandwidth ct0

No change reported from PCE.class-of-service

No change reported from PCE.description

LSP is deleted on the router. The PCRpt message is sent with R-bit.disable

No change reported from PCE.entropy-label

Results in detour path setup; the detours are not reported to the controller.fast-reroute

LSP name change results in a new LSP being signaled, and the old LSP is deleted. The new
LSP is reported through PCRpt message with D-bit. The old LSP is removed.

from

The prefix is applied locally and is not reflected to the PCE.install

Results in an MBB. The new LSP is reported, and the old LSP is reported with the R-bit set.metric

LSP name change results in a new LSP being signaled, and the old LSP is deleted. The new
LSP is reported through PCRpt message with D-bit. The old LSP is removed.

name

No change is reported from PCE. The LSP is brought down and then brought back up again.
This sequence does not use an MBB.

node-link-protection

Results in an MBB. The new LSP is reported; the old LSP is reported with the R-bit set.priority

Implementation of stateful path protection draft along with association object; see section
5.2.

standby
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Table 16: Behavior of LSP Configurations Initiated from PCC (continued)

LSP name change results in a new LSP being signaled, and the old LSP is deleted.to

Modifying Attributes of Delegated LSPs on the NorthStar Controller

When an LSP is externally controlled, local path computation is disabled, and you can

modify the following attributes for the delegated LSP from the NorthStar Controller:

• priority—Modifying this attribute results in a make-before-break (MBB) operation.

• admin-group—Modifying this attribute results in an MBB operation.

• ERO—Modifying this attribute results in an MBB operation. The new LSP state is

reported, and the old state is deleted.

Related
Documentation

Understanding Label-Switched Paths on the NorthStar Controller on page 99•

Provision LSPs

LSPs can be provisioned using either PCEP or NETCONF. Whether provisioned using

PCEPorNETCONF,LSPscanbe learnedviaPCEPorbywayofdevicecollection. If learned

by way of device collection, then the NorthStar Controller requires periodic device

collection to learn about LSPs andother updates to the network. See “SchedulingDevice

Collection forAnalytics” onpage250 formore information.Once youhavecreateddevice

collection tasks, NorthStar Controller should be able to discover LSPs provisioned via

NETCONF. Also unlike PCEP, the NorthStar Controller with NETCONF supports logical

systems.

For more information about managing logical nodes, see ConsiderationsWhen Using

Logical Nodes later in this topic.

Provisioning LSPs

Toprovision an LSP, navigate toApplications>Provision LSP. TheProvision LSPwindow
is displayed as shown in Figure 80 on page 105.
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Figure 80: Provision LSPWindow, Properties Tab

NOTE: You can also reach the Provision LSPwindow from the Tunnel tab of
the network information table by clicking Add at the bottom of the pane.

As shown in Figure 80 on page 105, the Provision LSP window has several tabs:

• Properties

• Path

• Advanced

• Design

• Scheduling

• User Properties
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From any tab, you can click Preview Path at the bottom of the window to see the path

drawn on the topology map, and click Submit to complete the LSP provisioning. These
buttons become available as soon as Name, Node A, and Node Z have been specified.

Table 17 on page 106 describes the data entry fields in the Properties tab of the Provision

LSP window.

Table 17: Provision LSPWindow, Properties Fields

DescriptionField

Use the drop-downmenu to select PCEP or NETCONF. The default is NETCONF.

See “Templates for Netconf Provisioning” on page 127 for information about using customized
provisioning templates to support non-Juniper devices.

NOTE: For IOS-XR routers, NorthStar LSPNETCONF-based provisioning has the same capabilities
as NorthStar PCEP-based provisioning.

Provisioning Method

A user-defined name for the tunnel. Only alphanumeric characters, hyphens, and underscores are
allowed. Other special characters and spaces are not allowed. Required for primary LSPs, but not
available for secondary or standby LSPs.

Name

Required. The nameor IP address of the ingress node. Select from the drop-down list. You can start
typing in the field to narrow the selection to nodes that begin with the text you typed.

Node A

Required. The name or IP address of the egress node. Select from the drop-down list. You can start
typing in the field to narrow the selection to nodes that begin with the text you typed.

Node Z

IP address of Node Z.IP Z

Use the drop-downmenu to select RSVP or SR (segment routing).Provisioning Type

Use the drop-downmenu to select primary, secondary, or standby as the path type.Path Type

LSP name. Required and only available if the Path Type is set to secondary or standby. Identifies
the LSP for which the current LSP is secondary (or standby).

secondary (or standby)
for

Name for the path. Required and only available for primary LSPs if the provisioning type is set to
RSVP, and for all secondary and standby LSPs.

Path Name

Required. Bandwidth immediately followed by units (no space in between). Valid units are:

• B or b (bps)

• M or m (Mbps)

• K or k (Kbps)

• G or g (Gbps)

Examples: 50M, 1000b, 25g.

If you enter a value without units, bps is applied.

Planned Bandwidth

Required. RSVP setup priority for the tunnel traffic. Priority levels range from 0 (highest priority)
through 7 (lowest priority). The default is 7, which is the standard MPLS LSP definition in Junos OS.

Setup
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Table 17: Provision LSPWindow, Properties Fields (continued)

DescriptionField

Required. RSVP hold priority for the tunnel traffic. Priority levels range from 0 (highest priority)
through 7 (lowest priority). The default is 7, which is the standard MPLS LSP definition in Junos OS.

Hold

Static tunnel metric. Type a value or use the up and down arrows to increment or decrement by 10.Planned Metric

Only available if the Provisioning Method is set to NETCONF and the Provisioning Type is set to SR.
Numerical binding SID label value. See “Segment Routing” on page 154 for more information.

Binding SID

Free-form comment describing the LSP.Comment

The Path tab includes the fields shown in Figure 81 on page 107 and described in

Table 18 on page 107.

Figure 81: Provision LSPWindow, Path Tab

Table 18: Provision LSPWindow, Path Fields

DescriptionField

Use the drop-downmenu to select dynamic, required, or preferred.Selection

Only available if your initial selection is either required or preferred. Enter the first hop and specify
whether it is strict or loose. To add an additional hop, click the + button.

Hop 1

The Advanced tab includes the fields shown in Figure 82 on page 108 and described in

Table 19 on page 108.
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Figure 82: Provision LSPWindow, Advanced Tab

Table 19: Provision LSPWindow, Advanced Tab Fields

DescriptionField

If set to yes, the LSP is included in periodic re-computation of planned bandwidth based on
aggregated LSP traffic statistics.

NOTE: Bandwidth sizing is supported only for PCE-initiated and PCC-delegated LSPs. Although
nothing will prevent you from applying this attribute to a PCC-controlled LSP, it would have no
effect.

See “Bandwidth Sizing” on page 268 for more information.

Bandwidth Sizing

This setting controls the sensitivity of the automatic bandwidth adjustment. The new planned
bandwidth is only considered if it differs from the existing bandwidth by the value of this setting or
more.

Only available (and then required) if Bandwidth Sizing is set to yes. The default value is 10%.

NOTE: Bandwidth sizing is supported only for PCE-initiated and PCC-delegated LSPs. Although
nothing will prevent you from applying this attribute to a PCC-controlled LSP, it would have no
effect.

Adjustment Threshold
(%)
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Table 19: Provision LSPWindow, Advanced Tab Fields (continued)

DescriptionField

Minimum planned bandwidth immediately followed by units (no space in between). Valid units
are:

• B or b (bps)

• M or m (Mbps)

• K or k (Kbps)

• G or g (Gbps)

Examples: 50M, 1000b, 25g.

If you enter a value without units, bps is applied.

This value is only available (and then required) if Bandwidth Sizing is set to yes. The default value
is 0.

NOTE: Bandwidth sizing is supported only for PCE-initiated and PCC-delegated LSPs. Although
nothing will prevent you from applying this attribute to a PCC-controlled LSP, it would have no
effect.

See “Bandwidth Sizing” on page 268 for more information.

Minimum Bandwidth

Maximum planned bandwidth immediately followed by units (no space in between). Bandwidth
sizing can be done up to this maximum.

Valid units are:

• B or b (bps)

• M or m (Mbps)

• K or k (Kbps)

• G or g (Gbps)

Examples: 50M, 1000b, 25g.

If you enter a value without units, bps is applied.

This value is only available if Bandwidth Sizing is set to yes. There is no default value.

NOTE: Bandwidth sizing is supported only for PCE-initiated and PCC-delegated LSPs. Although
nothing will prevent you from applying this attribute to a PCC-controlled LSP, it would have no
effect.

See “Bandwidth Sizing” on page 268 for more information.

Maximum Bandwidth

Double click in this field to display the Modify Coloring Include All window. Select the appropriate
check boxes. ClickOKwhen finished.

Coloring Include All

Double click in this field to display the Modify Coloring Include Any window. Select the appropriate
check boxes. ClickOKwhen finished.

Coloring Include Any

Double click in this field to display the Modify Coloring Exclude window. Select the appropriate
check boxes. ClickOKwhen finished.

Coloring Exclude
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Table 19: Provision LSPWindow, Advanced Tab Fields (continued)

DescriptionField

When there are two tunnels with the same end nodes but in opposite directions, the path routing
uses the same set of links. For example, suppose Tunnel1 source to destination is NodeA to NodeZ,
and Tunnel2 source to destination is NodeZ to NodeA. Selecting Tunnel1-Tunnel2 as a symmetric
pair group places both tunnels along the same set of links. Tunnels in the same group are paired
based on the source and destination node.

Symmetric Pair Group

Select the check box to create a symmetric pair.Create Symmetric Pair

Name of a group of tunnels to which this tunnel belongs, and for which diverse paths is desired.Diversity Group

Use the drop-downmenu to select the level of diversity as default, site, link, or SRLG.Diversity Level

Select the check box if you want the route to use protected IP links as much a possible.Route on Protected IP
Link

The Design tab includes the fields shown in Figure 83 on page 110 and described in

Table 20 on page 111.

Figure 83: Provision LSPWindow, Design Tab
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Table 20: Provision LSPWindow, Design Fields

DescriptionField

Use the drop-downmenu to select a routing method. Available options include default
(NorthStar computes the path), adminWeight, delay, constant, distance, ISIS, OSPF, and
routeByDevice (router computes part of the path).

Routing Method

Type a value or use the up and down arrows to increment or decrement by 100.Max Delay

Type a value or use the up and down arrows to increment or decrement by 1.Max Hop

Type a value or use the up and down arrows to increment or decrement by 100.Max Cost

Type a value or use the up and down arrows to increment or decrement by 100.High Delay Threshold

Type a value or use the up and down arrows to increment or decrement by 100.Low Delay Threshold

Type a value or use the up and down arrows to increment or decrement by 100.High Delay Metric

Type a value or use the up and down arrows to increment or decrement by 100.Low Delay Metric

When provisioning via PCEP, the NorthStar Controller’s default behavior is to compute

the path to be used when provisioning the LSP. Alternatively, you can select the

routeByDevice routing method in the Design tab, in which the router controls part of the

routing. This alternate routing method is only meaningful for three types of LSP:

• RSVP TE PCC-controlled LSP

NOTE: For provisioning viaNETCONF, routeByDevice is thedefault routing
method.

• Segment routing PCE-based LSP

• Segment routing NETCONF-based LSP

To select routeByDevice as the routing method:

1. On the Design tab, select routeByDevice from the RoutingMethod drop-downmenu.

2. On the Path tab, select dynamic from the Selection drop-downmenu.

The LSP is then set up to be provisioned with the specified attributes, and no explicit

path.

The Scheduling tab relates to bandwidth calendaring. By default, tunnel creation is not

scheduled, which means that tunnels are provisioned immediately upon submission.

Click the Scheduling tab in the Provision LSP window to access the fields for setting up

the date/time interval. Figure 84 on page 112 shows the Scheduling tab of the Provision

LSP window.
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Figure 84: Provision LSPWindow, Scheduling Tab

SelectOnce to select start and end parameters for a single event. Select Daily to select
start and end parameters for a recurring daily event. Click the calendar icon beside the

fields to select the start and end dates, and beginning and ending times.

NOTE: The time zone is the server time zone.

In the User Properties tab shown in Figure 85 on page 113, you can add provisioning

properties not directly supported by the NorthStar UI. For example, you cannot specify

a hop-limit in the Properties tab when you provision an LSP. However, you can add

hop-limit as a user property in the User Properties tab.
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Figure 85: Provision LSPWindow, User Properties Tab

The following steps describe how to utilize User Properties for LSP provisioning:

1. Access the NETCONF template file that is used for adding new LSPs

(lsp-add-junos.hjson), located in the /opt/northstar/netconfd/templates/ directory.

2. At the edit > protocols >mpls > label-switched-path hierarchy level, add the

statements needed to provision with the property you are adding. For example, to

provision with a hop-limit of 7, you would add the lines below in bold:

protocols {
    mpls {
      label-switched-path {{ request.name }} {
        to {{ request.to }};
        {{ macros.ifexists('from', request.from) -}}
        {% if request['user-properties'] %} 
        {% if request['user-properties']['hop-limit'] %}
        hop-limit {{ request['user-properties']['hop-limit'] }};
        {% endif %}
        {% endif %}
        {{ macros.ifexistandnotzero('metric', request.metric) -}}
        {{ macros.ifexists('p2mp', request['p2mp-name']) -}}
        {% if request['lsp-path-name'] %}
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         .
         .
         .

The result of adding these statements is that if hop-limit, with the value defined in

the user properties, is present, then the provisioning statement is executed. You could

also edit the template used for modifying LSPs (lsp-modify-junos.hjson).

3. Restart netconfd so the changes can take effect:

[root@system1 templates]# supervisorctl restart netconf:netconfd 
netconf:netconfd: stopped
netconf:netconfd: started

4. Add the user property and corresponding value in the User Properties tab of the

Provision LSP window (see Figure 85 on page 113).

5. Verify the router configuration:

label-switched-path test-user {
    from 10.0.0.101;
    to 10.0.0.104;

 hop-limit 7;
    primary test-user.p0 {
        bandwidth 0;
        priority 7 7;
    }
}

Click Submitwhen you have finished populating fields in all of the tabs of the Provision
LSP window. The LSP is entered into the work order management process.

TomodifyanexistingLSP, select the tunnel on theTunnels tab in thenetwork information

table and clickModify at the bottom of the table. The Modify LSP window is displayed,

which is very similar to the Provision LSP window.

If youmodify an existing LSP via NETCONF, NorthStar Controller only generates the

configuration statements necessary to make the change, as opposed to re-generating

all the statements in the full LSP configuration as is required for PCEP.

NOTE: After provisioningLSPs, if there is aPCEP flap, theUI display forRSVP
utilization and RSVP live utilizationmight be out of sync. You can display
those utilizationmetrics by navigating toPerformance in the left pane of the
UI. This is a UI display issue only. The next live update from the network or
the next manual sync using Sync NetworkModel (Administration > System
Settings>AdvancedSettings)corrects theUIdisplay. In theSystemSettings
window,you togglebetweenGeneralandAdvancedSettingsusing thebutton
in the upper right corner of the window.
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ConsiderationsWhen Using Logical Nodes

NorthStar fully supports creating and provisioning LSPs that incorporate logical nodes.

In the Junos OS, PCEP is not supported for logical nodes, but NorthStar can still import

logical node information using NETCONF-based device collection. When a device

collection task is run, NorthStar uses the Junos OS show configuration command on
each router to obtain both physical and logical node information. The logical device

information must then be correlated with the physical before LSPs using logical devices

can be provisioned.

Use the following procedure:

1. Navigate to Adminstration > Device Profile.

2. Click the Syncwith Live Network button to create (or update) the physical and logical

devices list. The NorthStar BGP-LS session toward the Junos VM automatically

discovers both the physical and logical devices in the topology. However, there is no

automatic correlation between the two.

In the Topology view, navigate to the Node tab of the network information table to

confirm that the PCEP Status is UP for all the physical nodes as shown in

Figure 86 on page 115. Logical nodes are blank in the PCEP Status column because

there is no PCEP for logical nodes.

Figure 86: PCEP Status Column Showing Physical and Logical Nodes

3. In the Device Profile window, enable NETCONF for the physical devices (if not already

done).

Select one ormore devices and clickModify to display theModify Device window. On
the Access tab, click the check box for Enable Netconf. ClickModify in the lower right
corner of the window to complete the modification.

4. Test the NETCONF connectivity of the devices.

Select one ormore devices in the device list and click Test Connectivity. In the Profile
Connectivity window, click Start. The test is complete when the green (pass) or red
(fail) status icons are displayed. Figure 87 on page 116 shows an example.
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Figure 87: Connectivity Test Results

5. In Topology view, check the Node tab of the network information table to ensure that

the NETCONF status column now reports UP for physical devices.

6. Create and run a device collection task to obtain updated information.

Navigate to Administration > Task Scheduler and click Add to display the Create
New Task window. If you use the Selective Devices option, select only the physical

devices. For complete information about the Create new Task windows, see

“Scheduling Device Collection for Analytics” on page 250.

When this device collection task is run, NorthStar uses the Junos OS show
configuration command on each physical router to obtain both physical and logical
node information, and reports it to NorthStar. This step allows NorthStar to correlate

each logical node to its corresponding physical node, which you can confirm by

examining the network information table, Node tab.

NOTE: When you first install NorthStar, the device profile page is empty.
Use the Sync with Live Network button to update and synchronize with
the live network devices, and update the Node tab in the network
information table. Thedevice collection task correlates the logical system
with its physical system and also updates LSP information for the logical
system since the logical system does not have a PCEP session to report
its LSP status.

It is helpful to add two optionally-displayed columns to the Node tab as shown in

Figure 88 on page 117:

• Physical Hostname
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• Physical Host IP

Figure 88: Adding Optionally-Displayed Columns

For a logical node, the hostname and IP address in those columns tell you which

physical node correlates to the logical node.

7. Provision LSPs.
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Now that the logical nodes are in the NorthStar device list and they are correlated to

the correct physical nodes, you can create LSPs that incorporate logical nodes. You

do this using the same procedure as for LSPs using only physical nodes except that

the provisioning method MUST be specified as Netconf as shown in

Figure 89 on page 118.

Figure 89: Provisioning an LSP That Uses Logical Nodes

8. Run your device collection task periodically to keep the logical node information

updated. There are no real time updates for logical devices.

Related
Documentation

Work Order Management on page 30•

• Provision Diverse LSP on page 119

• Provision Multiple LSPs on page 121

• Bandwidth Sizing on page 268

• Provision and Manage P2MP Groups on page 134

• Netconf Persistence on page 266
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• Left Pane Options on page 62

• Templates for Netconf Provisioning on page 127

Provision Diverse LSP

When creating a route between two sites, youmight not want to rely on a single LSP to

send traffic from one site to another. By creating a second LSP routing path between the

two sites, you can protect against failures and balance the network load.

To provision a diverse pair of tunnels in the network topology, navigate to

Applications>Provision Diverse LSP. The Provision Diverse LSP window Properties tab

is displayed as shown in Figure 90 on page 119.

Figure 90: Provision Diverse LSPWindow, Properties Tab

Figure 91 on page 120 shows the Advanced tab.
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Figure 91: Provision Diverse LSPWindow, Advanced Tab

On the Properties and Advanced tabs, the data entry fields specific to setting up diverse

LSPs are described in Table 21 on page 120. The remaining fields are the same as for

provisioning individual LSPs.

Table 21: ProvisioningWindow Fields Specific to Diverse LSPs

DescriptionField

Use the drop-downmenu to select the level of diversity as default, site, link, or
SRLG.

Diversity Level

Name of a group of tunnels to which this tunnel belongs, and for which diverse
paths is desired.

Diversity Group

When there are two tunnelswith the sameendnodes but in opposite directions,
thepath routinguses thesamesetof links. For example, supposeTunnel1 source
to destination is NodeA to NodeZ, and Tunnel2 source to destination is NodeZ
to NodeA. Selecting Tunnel1-Tunnel2 as a symmetric pair group places both
tunnels along the same set of links. Tunnels in the same group are paired based
on the source and destination node.

Symmetric Pair Group

Select the check box to create a symmetric pair.Create Symmetric Pair

Bydefault, the tunnel creation is not scheduled,whichmeans the tunnels areprovisioned

immediately upon submission. Click the Scheduling tab to access scheduling options.

SelectOnce to enable the scheduler options for a single event. Select Daily to enable
the scheduler options for a recurring daily event. Click the calendar icon beside the fields

to select the start and end dates, and the beginning and ending times.

ClickPreviewPathsat thebottomof thewindow to see thepaths drawnon the topology

map. Click Submit to complete the diverse LSP provisioning.
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A few things to keep in mind with regard to provisioning diverse LSPs:

• The time zone is the server time zone.

• If NorthStar Controller is not able to achieve the diversity level you request, it still

creates the diverse tunnel pair, using a diversity level as close as possible to the level

you requested.

• NorthStar Controller does not, by default, reroute a diverse LSP pair when there is a

network outage. Instead, use the Path Optimization feature (Applications > Path
Optimization).Oneoption is to schedulepathoptimization tooccur at regular intervals.

• WhenprovisioningdiverseLSPs,NorthStarmight returnanerror if the value youentered

in the Modify Node window’s Site field contains special characters, depending on the

version of Node.js in use. We recommend using alphanumeric characters only. See

“Network Information Table Bottom Tool Bar” on page 83 for the location of the Site

field in the Modify Node window.

Related
Documentation

Provision LSPs on page 104•

• Provision Multiple LSPs on page 121

• Network Information Table Bottom Tool Bar on page 83

ProvisionMultiple LSPs

To provision multiple LSPs at once in the network topology, navigate to

Applications>ProvisionMultiple LSPs. The Provision Multiple LSPs window has

Properties, Advanced, Design, Scheduling, andUser Properties tabs. The Scheduling and

User Properties tab fields are essentially the same as for provisioning single LSPs.

The Provision Multiple LSPs Properties is displayed as shown in Figure 92 on page 122.
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Figure 92: Provision Multiple LSPsWindow, Properties Tab

Table 22 on page 122 describes the fields available in the Properties tab.

Table 22: Provision Multiple LSPsWindow, Properties Tab

DescriptionField

You can enter a prefix to be applied to all of the tunnel names that are created. If left blank, this field
defaults to “PCE”.

ID Prefix

Required. Use the drop-downmenu to select PCEP or NETCONF. The default is NETCONF.

See “Templates for Netconf Provisioning” on page 127 for information about using customized
provisioning templates to support non-Juniper devices.

NOTE: For IOS-XR routers, NorthStar LSP NETCONF-based provisioning has the same capabilities
as NorthStar PCEP-based provisioning.

Provisioning Method
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Table 22: Provision Multiple LSPsWindow, Properties Tab (continued)

DescriptionField

Required. Bandwidth immediately followed by units (no space in between). Valid units are:

• B or b (bps)

• M or m (Mbps)

• K or k (Kbps)

• G or g (Gbps)

Examples: 50M, 1000b, 25g.

If you enter a value without units, bps is applied.

Planned Bandwidth

Required. RSVP setup priority for the tunnel traffic. Priority levels range from 0 (highest priority)
through 7 (lowest priority). The default is 7, which is the standard MPLS LSP definition in Junos OS.

Setup

Required. Number of copies of the tunnels to create. The default is 1. For example, if you specify a
count of 2, two copies of each tunnel are created.

Count

Required. Use the drop-downmenu to select RSVP or SR (segment routing).Provisioning Type

Required. Delimiter character used in the automatic naming of the LSPs.Delimiter

Required. RSVPholdpriority for the tunnel traffic. Priority levels range from0(highest priority) through
7 (lowest priority). The default is 7, which is the standard MPLS LSP definition in Junos OS.

Hold

Select the Node A nodes. If you select the same nodes for Node A andNode Z, a full mesh of tunnels
is created. See Table 23 on page 123 for selection method options.

Node A column

Select the Node Z nodes. If you select the same nodes for Node Z and Node A, a full mesh of tunnels
is created. See Table 23 on page 123 for selection method options.

Node Z column

Select a tag from the drop downmenu. Tags are set up in the Modify Node window, Addresses tab.
In theAddresses tabof theModifyNodewindow, youhave theoption toadddestination IPaddresses
in addition to the default IPv4 router ID address, and assign a descriptive tag to each. You can then
specify a tag as the destination IP address when provisioning an LSP.

Node Z Tag

Under the Node A and Node Z columns are several buttons to aid in selecting the tunnel

endpoints. Table 23 on page 123 describes how to use these buttons.

Table 23: Node Selection Buttons

FunctionButton

Select one or more nodes on the topology map, then click the globe button to add them to the
Node column.

(world)

Click the plus button to add all of the nodes in the topology map to the Node column.(plus)

Select a node in the Node column and click theminus button to remove it from the Node column.
Ctrl-click to select multiple nodes.

(minus)
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Table 23: Node Selection Buttons (continued)

FunctionButton

Click the right-arrow button on the Node Z side to add all of the nodes in the Node A column to
the Node Z column.

(copies)

On the Advanced tab, you can specify coloring parameters as shown in

Figure 93 on page 124 and described in Table 24 on page 124.

Figure 93: Provision Multiple LSPsWindow, Advanced Tab

Table 24: Provision Multiple LSPsWindow, Advanced Tab Fields

DescriptionField

If set to yes, the LSP is included in periodic re-computation of planned bandwidth based on
aggregated LSP traffic statistics.

NOTE: Bandwidthsizing is supportedonly forPCE-initiatedandPCC-delegatedLSPs.Although
nothing will prevent you from applying this attribute to a PCC-controlled LSP, it would have
no effect.

See “Bandwidth Sizing” on page 268 for more information.

Bandwidth Sizing

Double click in this field to display the Modify Coloring Include All window. Select the
appropriate check boxes. ClickOKwhen finished.

Coloring Include All

Double click in this field to display the Modify Coloring Include Any window. Select the
appropriate check boxes. ClickOKwhen finished.

Coloring Include Any
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Table 24: Provision Multiple LSPsWindow, Advanced Tab Fields (continued)

DescriptionField

Double click in this field to display theModify Coloring Excludewindow. Select the appropriate
check boxes. ClickOKwhen finished.

Coloring Exclude

Nameofagroupof tunnels towhich this tunnel belongs, and forwhichdiversepaths is desired.Diversity Group

Use the drop-downmenu to select the level of diversity as default, site, link, or SRLG.Diversity Level

Enter free-form comment.Comment

The Design tab, shown in Figure 94 on page 125, allows you to use a drop-downmenu to

select a routing method. Available options include default (NorthStar computes the

path), adminWeight, delay, constant, distance, ISIS, OSPF, and routeByDevice (router

computes part of the path).

Figure 94: Provision Multiple LSPsWindow, Design Tab

Scheduling relates tobandwidthcalendaring. Bydefault, tunnel creation is not scheduled,

which means that tunnels are provisioned immediately upon submission. Click the

Scheduling tab in the Provision Multiple LSPs window to access the fields for setting up

the date/time interval.

SelectOnce to select start and end parameters for a single event. Select Daily to select
start and end parameters for a recurring daily event. Click the calendar icon beside the

fields to select the start and end dates, and beginning and ending times.
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NOTE: The time zone is the server time zone.

In the User Properties tab, you can add provisioning properties not directly supported by

the NorthStar UI. For example, you cannot specify a hop-limit in the Properties tabwhen

you provision an LSP. However, you can add hop-limit as a user property in the User

Properties tab. This works the same way as it does when provisioning single LSPs.

Related
Documentation

Provision LSPs on page 104•

• Bandwidth Sizing on page 268

• Templates for Netconf Provisioning on page 127

Configure LSP Delegation

Navigate to Applications > Configure LSP Delegation to reach the Configure LSP
Delegationwindowwhere you can select LSPs to either delegate to NorthStar Controller

or remove from delegation.

Figure 95 on page 126 shows the Configure LSP Delegation window.

Figure 95: Configure LSP DelegationWindow

Click the check boxes for the desired LSPs on either the Add Delegation or Remove

Delegation tab. You can alsoCheck All orUncheck All. Then click Submit at the bottom
of the window.
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Whenyouaddor removedelegation to/fromtheNorthStarController using thisoperation,

the delegation statement block is added or removed from the router configuration.

NOTE: This is not the same as the temporary removal you achievewhen you
right-click a tunnel in the network information table and select Return
Delegation to PCC. In that case, control is temporarily returned back to the
PCC for a period of time based on the router’s timer statement.

Related
Documentation

Understanding the NorthStar Controller on page 3•

Templates for Netconf Provisioning

NorthStar Controller supports NETCONF provisioning for Juniper devices and Cisco

IOS-XR devices. You can customize provisioning templates by modifying the templates

provided in the /opt/northstar/netconfd/templates/ directory on the NorthStar server,

or by creating new, customized templates.

NOTE: For IOS-XR routers, NorthStar LSP Netconf-based provisioning has
the same capabilities as NorthStar PCEP-based provisioning.

The syntax and semantics used in the template attributes are based on Jinja Templates,

a template engine for Python. Help/support for using Jinja Templates is readily available

online.

You can use customized templates for:

• LSP Provisioning: make use of provisioning properties not directly supported by the

NorthStar UI.

For example, you cannot specify a hop-limit in the Properties tab in the Provision LSP

window. However, you can add hop-limit in the User Properties tab of the Provision

LSP or Modify LSP window and thenmodify the appropriate provisioning template

accordingly.

• Service mapping: associate LSPs being provisioned with a VPN service.

When an LSP is created, it can be tagged with user properties that, when also defined

in the Jinja template, cause the corresponding service mapping statement to be

generated in the router configuration.

Example VPN services include:

• Mapping P2P LSPs to circuit cross-connect (CCC) VPNs

NOTE: The CCC servicemust already exist in the network before you
perform this type of servicemapping.
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• Mapping P2MP LSPs to multicast VPNs (MVPNs)

NOTE: AnMVPN routing instancemust alreadyexist before youperform
this type of servicemapping.

GeneralWorkflow for Modifying a Template

The following stepsdescribe thegeneralworkflow formodifyingaprovided Jinja template

and ensuring that the desired provisioning takes effect:

1. Decide on the user properties needed and their values.

2. Edit the appropriate Jinja template to include those properties.

3. Restart netconfd so the changes can take effect:

[root@system1 templates]# supervisorctl restart netconf:netconfd 
netconf:netconfd: stopped
netconf:netconfd: started

4. Provisionormodify the LSPusing thewebUI, and include theuser properties and their

values in the User Properties tab of the Provision LSP or Modify LSP window.

5. Verify the router configuration.

Overview of Netconf Provisioning Templates

There are two types of templates provided in the templates directory:

• Encoding templates are for internal use only and should never bemodified or deleted.

All of these templates have “encoding” in their names (lsp-modify-encoding.hjson,
for example).

• Configuration templates are for transforming JSON document keys into device

configuration statements. These templates are available for modification and to use

as models for creating new templates. Currently, these templates all have “junos” in

their names, (lsp-modify-junos.hjson, for example), although, as long as you use the
.hjson suffix, you can name new templates according to your preference.

Template Requirements

Keep in mind the following template requirements:

• If you create a new template, be sure the PCS user has Unix file permission to read it.

• Template files are hjson documents, so their file namesmust have the .hjson suffix.

• The Netconf daemon (NETCONFD)must be restarted for template changes to be

applied:
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[root@pcs-1 templates]# supervisorctl restart netconf:netconfd

netconf:netconfd: stopped
netconf:netconfd: started

• Text format is supported for device configuration statements. XML format is supported

for modifying Cisco IOS XR devices.

• When you upgrade a NorthStar build, the templates provided in the new build replace

the ones that were provided with the original build. You can prevent loss of your

template changes by backing up your templates to a different directory on the server

before upgrading NorthStar, or by saving your modified files with different file names.

Template Structure

Each template has two types of attributes:

• Routing-key attributes which describe the type of provisioning for which the template

should be used. The value of routing-key is not fixed in NETCONFD, but the following

keys are currently agreed upon between NETCONFD and ConfigServer for LSP

provisioning:

• rest_eventd_request_key

Use for adding a new LSP.

• rest_eventd_update_key

Use for modifying an existing LSP.

• rest_eventd_delete_key

Use for deleting an LSP

• Device profile attributes that define the device to be provisioned when using the

template.

You can use any device profile attributes (Administration > Device Profile) such as
routerType (Vendor field inDeviceProfile),model, and soon.NETCONFDtries tomatch

the attributes in the template with the attributes in the device profiles of the targeted

devices.

• User properties attributes that define such things as service mapping attributes.

User properties is a generic mechanism that allows you to “tag” LSPs with additional

properties. One use of user properties is to tag an LSP with the vpn-name, source-ip,

and group-ip that are related to the associated MVPN (for service mapping).

In the Jinja template, when those user properties are defined, a corresponding set of

statements (related to service mapping) are also generated. The support in the REST

body and the web UI is the same. In the REST body, you include the user properties

under “userParameters”, while in the web UI, you include them in the User Properties

tab of the Provision (or Modify) LSP window.
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Table 25 on page 130, Table 26 onpage 131, andTable 27 on page 131 detail the supported

JSON document keys for adding LSPs, modifying LSPs, deleting LSPs, and link

modification.

NOTE: Keys that do not “always exist” only exist conditionally. For example:

• request[“logical-system”] is used to specify the logical-system name, so
it only exists in the JSON document if the provisioning order is for
logical-system devices.

• request[“p2mp-name”] is used to specify theP2MPname, so it only exists
in the JSON document if the provisioning order is for P2MP LSPs.

Table 25: Keys for Adding or Modifying LSPs

DescriptionAlways ExistsValueKey

LSP nameyestextrequest.name

LSP source addressyesIPv4 addressrequest.from

LSP destination addressyesIPv4 addressrequest.to

LSP path nameyestextrequest['lsp-path-name']

LSP path bandwidthyes for adding

no for modifying

integerrequest.bandwidth

LSPmetricnointegerrequest.metric

LSP path typeyes[primary
|secondary
|standby]

request.type

LSP path hopnoIPv4 addressrequest['path-attributes']['ero'][’ipv4-address’]

LPS path loose flagno[true]request['path-attributes']['ero'][’loose']

LSP path setup priorityyes for adding

no for modifying

[0-7]request['path-attributes']['setup-priority']

LSP path reservation priorityyes for adding

no for modifying

[0-7]request['path-attributes']['reservation-priority']

LSP headend logical system
name

notextrequest['logical-system']

LSP P2MP group namenotextrequest['p2mp-name']
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Table 25: Keys for Adding or Modifying LSPs (continued)

DescriptionAlways ExistsValueKey

LSP path manual selectionno[true]request['select-manual']

Additionalpropertiesasdefined
by user

yestextrequest['user-properties']

Table 26: Keys for Deleting LSPs

DescriptionAlways ExistsValueKey

LSP nameyestextrequest.name

LSP source addressyesIPv4 addressrequest.from

LSP destination addressyesIPv4 addressrequest.to

LSP path namenotextrequest['lsp-path-name']

LSP path typeyes[primary |secondary
|standby]

request.type

Specifies whether the deletion order is for
deleting the LSP (value of “true”) or the LSP
path

no[true]request.delete

LSP headend logical system namenotextrequest['logical-system']

Additional properties as defined by useryestextrequest['user-properties']

Table 27: Keys for Link Modification

DescriptionAlways ExistsValueKey

Interface nameyestextrequest.new_interface.name

ISIS level 1 metricnointegerrequest.new_interface.isis1_metric

ISIS level 2 metricnointegerrequest.new_interface.isis2_metric

OSPFmetricnointegerrequest.new_interface.ospf_metric

OSPF areanointegerrequest.new_interface.ospf_area_id

Router logical system namenotextrequest.logical_system

NOTE: The pcs_provisioning_order_key order is currently used specifically
for OSPF/ISISmetric modification.
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TemplateMacros

Jinja Templates supportmacros for defining reusable functions. The NorthStar template

directory includes the macros listed in Table 28 on page 132.

Table 28: Template Macros Included in the Template Directory

FunctionMacro

Generates a Junos configuration statement if the evaluated key in the JSON document exists.ifexist

Generates a Junos configuration statement if the evaluated key in the JSON document has a
value that is not equal to zero.

Ifnotzero

Generates a Junos configuration statement if the evaluated key in the JSON document has
any value.

Ifnotnone

Decodes the user defined properties in the JSON document.decodeuserprops

Generates a configuration statement for Junos logical system.lsys

Jinja Template Examples for Service Mapping

In the following Jinja template snippet, the statements related to servicemapping of the

P2MP LSP to themulticastMVPNare provisionedwith the LSP if the LSP has associated

with it the “vpn-name” user property.

{% if request['user-properties'] and request['user-properties']['vpn-name'] 
is defined %}
routing-instances {
    {{ request['user-properties']['vpn-name'] }} {
        provider-tunnel {
            selective {
                group {{ request['user-properties']['group-ip'] }} {
                    source {{ request['user-properties']['source-ip'] }} {
                        rsvp-te {
                            static-lsp {{ request['p2mp-name'] }};
                        }
                    }
                }
            }
        }
    }
}
{% endif %}

In the following Jinja template snippet, the statement related to service mapping of the

LSP to the CCC-VPN is provisioned with the LSP if the LSP has associated with it the

“ccc-vpn-name” user property.

{% if request['user-properties'] and request['user-properties']['ccc-vpn-name']
 is defined %}
protocols {
    connections {
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        remote-interface-switch {{ request['user-properties']['ccc-vpn-name']
 }} {
            interface {{ request['user-properties']['ccc-interface'] }};
            transmit-lsp {{ request['user-properties']['transmit-lsp'] }};
            receive-lsp {{ request['user-properties']['receive-lsp'] }};
        }
    }
}
{% endif %}

Jinja Template Example for SR LSPs

The following is an example Jinja template snippet used for NETCONF-provisioned SR

LSPs. If a binding SID value is specified, a binding SID SR LSP is provisioned. Without a

binding SID specified, a regular non-binding SID SR LSP is provisioned.

{% if request['path-setup-type'] == "segment" %}
  protocols {
    source-packet-routing {
        delete: segment-list {{request.name}};
        delete: source-routing-path {{request.name}}/{{request.name}};
        segment-list {{request.name}} {
            {% for segment in request['path-attributes']['sr-ero'] %}
                {% if segment['remote-ipv4-address'] %}
                        segment{{loop.index}} label {{segment.sid}} ip-address
 {{segment['remote-ipv4-address']}};
                {% else %}
                        segment{{loop.index}} label {{segment.sid}};
                {% endif %}
            {% endfor %}
        }
        source-routing-path {{request.name}}/{{request.name}} {
          to {{request.to}};
          {{ macros.ifexistandnotzero('metric', request.metric) -}}
          {{ macros.ifexistandnotzero('binding-sid', 
request['path-attributes']['binding-sid']) -}} 
          {{ request.type }} {
            {{request.name}};
          }
        }
    }
  }

Related
Documentation

Provision LSPs•

• IGP Metric Modification from the NorthStar Controller on page 168

• Device Profile and Connectivity Testing
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Provision andManage P2MPGroups

In the NorthStar Controller, you can provision P2MP groups; view andmodify group

attributes; andview,add,ordelete sub-LSPs.This is a separateworkflowfromprovisioning

P2P LSPs, initiated from the P2MP tab in the network information table. Netconf is the

only provisioning method supported for P2MP.

NOTE: In Junos OS Release 15.1F6 and later, you can enable the router to
send P2MP LSP information to a controller (like the NorthStar Controller) in
real time, automatically. Without that configuration, youmust run device
collection for NorthStar to learn about newly provisioned P2MP LSPs.

In the JunosOS, theconfiguration isdone in the [setprotocolspcep]hierarchy
for PCEs and for PCE groups:

set protocols pcep pce pce-id p2mp-lsp-report-capability

NOTE: After provisioning P2P or P2MP LSPs, if there is a PCEP flap, the UI
display for RSVP utilization and RSVP live utilizationmight be out of sync.
You can display those utilizationmetrics by navigating toPerformance in the
left pane of the UI. This is a UI display issue only. The next live update from
the network or the next manual sync using Sync Network Model
(Administration > SystemSettings > Advance Settings) corrects the UI
display. In the System Settings window, you toggle between General and
Advanced Settings using the button in the upper right corner of the window.

The following sections describe viewing, provisioning, andmanaging P2MP groups in the

NorthStar Controller.

• Viewing P2MP Groups and Their Sub-LSPs on page 134

• Provisioning a P2MP Group on page 136

• Modifying a P2MP Group on page 140

• Deleting a P2MP Group on page 141

Viewing P2MPGroups and Their Sub-LSPs

P2MP group information is displayed in the P2MP Group tab of the network information

table, and is also reflected in the topology map.
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To display P2MP Group information, use the following steps:

1. On the tabs bar of the network information table, click the plus sign (+) and select

P2MPGroup from the drop-downmenu as shown in Figure 96 on page 135.

NOTE: When you launch thewebUI, only the Node, Link, and Tunnel tabs
aredisplayedbydefault; P2MPGroup is oneof the tabs youcanoptionally
display.

Figure 96: Adding the P2MPGroup Tab

2. TheP2MPGroup tab is added to the tab bar and the contents are displayed as shown

in Figure 97 on page 135.

Figure 97: P2MPGroup Tab in the Network Information Table

Columns for group attributes are shown across the top. You can add columns and

filter the display in the usual ways. See “Sorting and Filtering Options in the Network

Information Table” on page 81 for more information.

3. Click a row in the table to highlight the path in the topology map.

4. Right-click a row in the table to display either a graphical tree view of the group, or a

listof thesub-LSPs thatmakeupthegroup. Figure98onpage 136showstheseoptions.
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Figure 98: Right-Click a P2MPGroup

The tree diagram opens as a separate pop-up as show in Figure 99 on page 136.

Figure 99: P2MPGroup Graphical Tree Diagram

Whenyouselect to viewsub-LSPs, the sub-LSPs thatmakeup thegrouparedisplayed

in a new tab in the network information table. On the list of sub-LSPs, you have all

the display options normally available on the Tunnel tab. See “Network Information

Table Overview” on page 79 for more information.

Provisioning a P2MPGroup

On the P2MPGroup tab of the network information table, clickAdd at the bottom of the

table. The AddP2MPGroupwindow is displayed as shown in Figure 100 on page 137. Red

asterisks denote required fields.
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Figure 100: Add P2MPGroupWindow, Properties Tab

Table29onpage 137describes thedataentry fields in theProperties tabof theAddP2MP

Group window.

Table 29: Add P2MPGroupWindow, Properties Fields

DescriptionField

Required. A user-defined name for the P2MP group. Only alphanumeric characters, hyphens, and
underscores are allowed. Other special characters and spaces are not allowed.

P2MP Name

You can enter a prefix to be applied to all of the tunnel names that are created.ID Prefix

Required. Planned bandwidth immediately followed by units (no space in between). Valid units are:

• B or b (bps)

• M or m (Mbps)

• K or k (Kbps)

• G or g (Gbps)

Examples: 50M, 1000b, 25g.

If you enter a value without units, bps is applied.

Bandwidth

Use the drop-downmenu to select RSVP. This is the only provisioning type supported.Provisioning Type

137Copyright © 2019, Juniper Networks, Inc.

Chapter 4: LSPManagement



Table 29: Add P2MPGroupWindow, Properties Fields (continued)

DescriptionField

Required. RSVPsetuppriority for the tunnel traffic. Priority levels range from0(highest priority) through
7 (lowest priority). The default is 7, which is the standard MPLS LSP definition in Junos OS.

Setup

Required. RSVP hold priority for the tunnel traffic. Priority levels range from0 (highest priority) through
7 (lowest priority). The default is 7, which is the standard MPLS LSP definition in Junos OS.

Hold

Required. The name or IP address of the source node. Select from the drop-down list.Node A

At least one is required. The names or IP addresses of the destination nodes. To select nodes from the
topology map, Shift-click the nodes on themap and then click the world button at the bottom of the
Node Z field. To add all nodes in the network, click the plus (+) button. To remove a node, highlight it
in the Node Z field and click the minus (-) button.

Node Z

The Advanced tab includes the fields shown in Figure 101 on page 138 and described in

Table 30 on page 139.

Figure 101: Add P2MPGroupWindow, Advanced Tab
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Table 30: Add P2MPGroupWindow, Advanced Fields

DescriptionField

Double click in this field to display the Modify Coloring Include All window. Select the
appropriate bits. ClickOKwhen finished.

Coloring Include All

Double click in this field to display the Modify Coloring Include Any window. Select the
appropriate bits. ClickOKwhen finished.

Coloring Include Any

Double click in this field to display the Modify Coloring Exclude window. Select the
appropriate bits. ClickOKwhen finished.

Coloring Exclude

Diverse P2MP is currently not supported via the web UI, so these fields are not used. You
can use the REST APIs, however.

Diversity Group/Level

Free-form comments if needed.Comment

The Design tab includes the Routing Method options shown in Figure 102 on page 139.

Figure 102: Add P2MPGroupWindow, Design Tab

For P2MP, the default routing method is routeByDevice (since it uses NETCONF as the

provisioning method). You can select a different routing method in which the PC server

calculates the path for all the sub-LSPs. The behavior for all routing methods is similar

to P2P LSP provisioning.

The Scheduling tab is identical to the one you use to provision P2P LSPs.

For P2MP, the User Properties tab is used for P2MP tree to MVPN service mapping. See

“Templates for Netconf Provisioning” on page 127 for more information.
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Once youare finisheddefining thegroup, clickSubmit. Thegroup is added to thenetwork
information table, on the P2MP Group tab.

NOTE:

• Naming of the sub-LSPs is automatic, based on the Prefix-ID if provided,
and the A and Z node names.

• If the routingmethod is routeByDevice, thepath forall sub-LSPs isdynamic.
If you select anyother routingmethod from thedrop-downmenu, thepath
is preferred. This can be changed for individual sub-LSPs.

Modifying a P2MPGroup

Modifying a P2MPGroup

Tomodify a P2MP group, select the group in the P2MP Group tab of the network

information table, and clickModify at the bottom of the table. The Modify P2MP Group

window is displayed as shown in Figure 103 on page 140.

Figure 103: Modify P2MPGroupWindow, Properties Tab

Using the tabson theModifyP2MPGroupwindow, youcanchange thevalueofattributes

(affects all sub-LSPs in the group), add or remove destination nodes (which adds or

removes sub-LSPs), and set up or change scheduling for the group.
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NOTE: There are twoways you can remove sub-LSPs from a group:

• In the Properties tab of the Modify P2MP Group window, select the
destination node(s) in the Node Z field and click theminus sign (-).

• Display the sub-LSPs by right-clicking the group in the P2MP Group tab
and selectingViewSubLSPs. In the resulting list of sub-LSPs in theTunnel
tab, select the LSP(s) to delete and clickDeleteat the bottomof the table.

When you have finishedmaking changes, click Submit.

NOTE: The following six attributesmust be the same for all sub-LSPs in a
P2MPgroup, and can therefore only bemodified at the group level, using the
Modify P2MP Group window:

• Bandwidth

• Setup

• Hold

• ColoringIncludeALL

• ColoringIncludeANY

• ColoringExclude

Tomodify other attributes on the individual sub-LSP level (such as path or Max Hop, for

example), select the tunnel in the Tunnel tab of the network information table and click

Modifyat thebottomof the table. If youattempt tomodifyoneof thesixgroup-level-only

attributes at the sub-LSP level, an error message is displayed when you click Submit
and the change is not made.

Deleting a P2MPGroup

When you delete a P2MPgroup, all sub-LSPs that are part of that group are also deleted.

To delete a P2MP group, select the group on the P2MP Group tab of the network

information tableandclickDeleteat thebottomof the table.Respond to theconfirmation

message to complete the deletion.

Alternatively, you can use the Tunnel tab of the network information table to delete all

the sub-LSPs in the P2MP group, which also deletes the group itself.

Related
Documentation

Sorting and Filtering Options in the Network Information Table on page 81•

• Network Information Table Overview on page 79

• Provision LSPs

• Templates for Netconf Provisioning on page 127
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Bandwidth Calendar

The Bandwidth Calendar opens in a new browser window or tab when you navigate to

Applications>Bandwidth Calendar. The calendar displays all scheduled LSPs on a
timeline, along with their properties, so you can see the total bandwidth requirements

for any given time. Figure 104 on page 142 shows an example bandwidth calendar.

Figure 104: Bandwidth Calendar

NOTE: The bandwidth calendar timeline is empty until you schedule LSPs.

On the timeline, a red vertical line represents the current date and time, so you can easily

distinguish between past and future events. Zoom functions at the top of the window

allow you to select from the following:

Current—LSPs scheduled from the current date and time forward

1d—LSPs scheduled from the current date and time, plus 24 hours

7d—LSPs scheduled from the current date and time, plus 7 days

1m—LSPs scheduled from the current date and time, plus 1 month

3m—LSPs scheduled from the current date and time, plus 3 months

6m—LSPs scheduled from the current date and time, plus 6months

1y—LSPs scheduled from the current date and time, plus 1 year

All—all scheduled LSPs, past and future

You can also:

• Use the scroll wheel on your mouse to zoom in and out.

• Left-click and drag to move the display forward or backward in time.

Click a specific event to display all the tunnel properties.

Related
Documentation

Provision LSPs•

• Provision Diverse LSP
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Creating Templates to Apply Attributes to PCE-Initiated Label-Switched Paths

From a PCC router’s CLI, you can create LSP templates to define a set of LSP attributes

to apply to PCE-initiated LSPs. Any PCE-initiated LSPs that provide a namematch with

the regular expression (regex) name specified in the template automatically inherit the

LSPattributes that aredefined in the template. ByassociatingLSPs (through regexname

matching) with a specific user-defined LSP template, you can automatically turn on (or

turn off) LSP attributes across all LSPs that provide a namematch with the regex name

specified in the template.

When auto-bandwidth is enabled, LSP auto-bandwidth parametersmust be configured

from the router, even when the LSP has been delegated. Under no circumstances can

the NorthStar Controller modify the bandwidth of an externally-controlled LSP when

auto-bandwidth is enabled. The PCC enforces this behavior by returning an error if it

receives an LSP update for an LSP that has auto-bandwidth enabled. Currently, there is

no way to signal through PCEP when auto-bandwidth is enabled, so the NorthStar

Controller cannot know in advance that an LSP has auto-bandwidth enabled. However,

when auto-bandwidth is enabled by way of a template, then the NorthStar Controller

knows that the LSP has auto-bandwidth enabled and disallowsmodification of

bandwidth.

The following configuration example shows how to define the regex-based LSP name

for a set of LSP “container” templates that you can deploy to apply specific attributes

to any LSPs on the network that provide amatching LSP name.
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Create the templates under the lsp-external-controller-pccd hierarchy to specify the

regex-based character string to be used to identify the LSPs whose attributes you want

to update.

1. Create a namematching scheme to identify the NorthStar Controller provisioned

(PCE-initiated) LSPs to which you want to apply specific link protection attributes.

a. To specify that any PCE-initiated LSP that provides a namematch with the prefix

PCE-LP-*will inherit the LSP link-protection attributes defined in the
LINK-PROTECT-TEMPLATE template, configure the following statement from the

PCC router CLI:

[edit protocols mpls lsp-external-controller pccd]
user@PE1# set pce-controlled-lsp PCE-LP-* label-switched-path-template
LINK-PROTECT-TEMPLATE

b. To specify that any PCE-initiated LSP that provides a namematch with the prefix

PCE-AUTOBW-*will inherit the LSP auto-bandwidth attributes defined in the
AUTO-BW-TEMPLATE template, configure the following statement from the PCC

router CLI:

[edit protocols mpls lsp-external-controller pccd]
user@PE1#setpce-controlled-lspPCE-AUTOBW-* label-switched-path-template
AUTO-BW-TEMPLATE

2. Create the templates that define the attributes you want to apply to all PCE-initiated

LSPs that provide a namematch.

a. Define link-protection attributes for the LINK-PROTECT-TEMPLATE template.

[edit protocols mpls ]
user@PE1#set label-switched-path-templateLINK-PROTECT-TEMPLATE template
user@PE1#set label-switched-path-templateLINK-PROTECT-TEMPLATEhop-limit
3

user@PE1# set label-switched-path-template LINK-PROTECT-TEMPLATE
link-protection

b. Define auto-bandwidth attributes for the AUTO-BW-TEMPLATE template.

[edit protocols mpls ]
user@PE1# set label-switched-path-template AUTO-BW-TEMPLATE template
user@PE1# set label-switched-path-template AUTO-BW-TEMPLATE
auto-bandwidth adjust-interval 300

user@PE1# set label-switched-path-template AUTO-BW-TEMPLATE
auto-bandwidth adjust-threshold 20

user@PE1# set label-switched-path-template AUTO-BW-TEMPLATE
auto-bandwidthminimum-bandwidth 10m

user@PE1# set label-switched-path-template AUTO-BW-TEMPLATE
auto-bandwidthmaximum-bandwidth 100m

user@PE1# set label-switched-path-template AUTO-BW-TEMPLATE
auto-bandwidth adjust-threshold-overflow-limit 5

user@PE1# set label-switched-path-template AUTO-BW-TEMPLATE
auto-bandwidth adjust-threshold-underflow-limit 5
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3. Apply the auto-bandwidth and link-protection templates to configure the

auto-bandwidth and link-protection attributes to any LSPs that match the

corresponding regex-based character string.

[edit protocols mpls lsp-external-controller pccd]
user@PE1# set pce-controlled-lsp PCE-AUTOBW-* label-switched-path-template
AUTO-BW-TEMPLATE

user@PE1# set pce-controlled-lsp PCE-LP-* label-switched-path-template
LINK-PROTECT-TEMPLATE

4. Create LSPs in NorthStar by specifying LSP names based on the regex-based name

defined in Step 1 above.

5. Verify the LSP configuration on the PCC router.

user@PE1> showmpls lsp detail

Related
Documentation

Creating Templates with Junos OS Groups to Apply Attributes to PCE-Initiated

Label-Switched Paths on page 145

•

• Provision LSPs

Creating Templates with Junos OSGroups to Apply Attributes to PCE-Initiated
Label-Switched Paths

From the Path Computation Client (PCC) router’s command line interface, you can use

the Junos OS groups statement with label-switched path (LSP) templates to define a

set of LSP attributes to apply to PCE-initiated LSPs. Any PCE-initiated LSP that provides

a namematchwith the regular expression (regex) name that is specified in the template

automatically inherits the LSP attributes that are specified in the template. Thus, by

associating PCE-initiated LSPswith a user-defined LSP template, you can automatically

turn on (or turn off) LSP attributes across all LSPs that provide a namematch with the

regex name that is specified in the template.

The following example show how you can use templates to apply auto-bandwidth and

link-protection attributes to LSPs. For example, when auto-bandwidth is enabled, LSP

auto-bandwidth parametersmust be configured from the router, evenwhen the LSPhas

been delegated. Under no circumstances can the NorthStar Controller modify the

bandwidth of an externally controlled LSP when auto-bandwidth is enabled. A PCC

enforces this behavior by returning an error if it receives an LSP update for an LSP that

has auto-bandwidth enabled. Currently, there is no way to signal through PCEP when

auto-bandwidth is enabled, so the NorthStar Controller cannot know in advance that

the LSP has auto-bandwidth enabled. However, if auto-bandwidth is enabled by way of

a template, the NorthStar Controller knows that the LSP has auto-bandwidth enabled

and disallowsmodification of bandwidth.
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To configure and apply groups to assign auto-bandwidth and link protection attributes

to label-switched paths:

1. From the PCC router CLI, configure groups to specify that any PCE-initiated LSP that

provides a namematchwith the specified prefixwill inherit the LSPattributes defined

in the template:

a. Configure a group to specify that an LSP that provides a namematch with the

prefix AUTO-BW-*will inherit the LSP auto-bandwidth attributes defined in the
AUTO-BW-TEMPLATE template.

[edit groups AUTO-BW-GROUP]
user@PE1# set protocolsmpls label-switched-path AUTO-BW-* autobandwidth
adjust-interval 300

user@PE1# set protocolsmpls label-switched-path AUTO-BW-* autobandwidth
adjust-threshold 20

user@PE1# set protocolsmpls label-switched-path AUTO-BW-* autobandwidth
minimum-bandwidth 10m

user@PE1# set protocolsmpls label-switched-path AUTO-BW-* autobandwidth
maximum-bandwidth 100m

user@PE1# set protocolsmpls label-switched-path AUTO-BW-* autobandwidth
adjust-threshold-overflow-limit 5

user@PE1# set protocolsmpls label-switched-path AUTO-BW-* autobandwidth
adjust-threshold-underflow-limit 5

b. Configure a group to specify that any LSP that provides a namematch with the

prefix LINK-PROTECT-*will inherit the LSP link-protection attributes defined in
the LINK-PROTECT-TEMPLATE template.

[edit groups LINK-PROTECT-GROUP]
user@PE1# set protocolsmpls label-switched-path LINK-PROTECT-* hop-limit 5
user@PE1#setprotocolsmpls label-switched-pathLINK-PROTECT-* link-protection
user@PE1# set protocolsmpls label-switched-path LINK-PROTECT-* adaptive

2. Configure the templates to apply the attributes defined for the two groups in the

previous step.

[edit protocols mpls]
user@PE1# set label-switched-path AUTO-BW-TEMPLATE apply-groups
AUTO-BW-GROUP

user@PE1# set label-switched-path AUTO-BW-TEMPLATE template
user@PE1# set label-switched-path LINK-PROTECT-TEMPLATE apply-groups
LINK-PROTECT-GROUP

user@PE1# set label-switched-path LINK-PROTECT-TEMPLATE template

3. Apply theauto-bandwidthand link-protection templates toassign theauto-bandwidth

and link-protection attributes to any LSPs thatmatch the corresponding regex-based

character-string.

[edit protocols mpls lsp-external-controller pccd]
user@PE1# set pce-controlled-lsp AUTO-BW-* label-switched-path-template
AUTO-BW-TEMPLATE
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user@PE1# set pce-controlled-lsp LINK-PROTECT-* label-switched-path-template
LINK-PROTECT-TEMPLATE

4. Create LSPs from the NorthStar Controller by specifying LSP names based on the

regex-based name defined in Step 1.

5. Verify the LSP configuration on the PCC router.

user@PE1> showmpls lsp detail

Related
Documentation

• Creating Templates to Apply Attributes to PCE-Initiated Label-Switched Paths on

page 143

• Provision LSPs
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CHAPTER 5

Path Computation and Optimization

• Path Optimization on page 149

• Topology Map Color Legend on page 152

• Segment Routing on page 154

• IGP Metric Modification from the NorthStar Controller on page 168

• LSP Path Manual Switch on page 169

• Maintenance Events on page 170

Path Optimization

For many large networks, when a tunnel is rerouted due to a network failure, the new

path remains in use even when the network failure is resolved. Over time, a suboptimal

set of paths might evolve in the network. The path analysis and optimization feature

re-establishes an optimal set of paths for a network by finding the optimal placement

of tunnels using the current set of nodes and links in the network. You can request path

analysis on demand, and path optimization either on demand or according to a schedule

that you define.

Navigate toApplications>PathOptimization toaccess thepathoptimization sub-menu.
Figure 105 on page 150 shows the navigation path and the sub-menu options.
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Figure 105: Navigating to Path Optimization

Table 31 on page 150 describes the purpose of each sub-menu option.

Table 31: Path Optimization Sub-Menu Options.

PurposeSub-Menu Option

Analyzes the network for optimization opportunities, and generates a results report. Reviewing the
report gives you the opportunity to consider the effects of optimization before you actually execute
it.

Navigate to Applications>Reports to view the latest analysis report.

NOTE: The path analysis and optimization reports do not contain any information about
PCC-controlled LSPs because NorthStar does not attempt to optimize them.

Analyze Now

Optimizes the network immediately.

NOTE: The optimization is based on the current network, not on themost recent Analyze Now
report.

Optimize Now

Enables or disables an optimization schedule. For example, in Figure 106 on page 151, path
optimization would occur every 60minutes.

Settings
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Figure 106: Path Optimization Settings Example

Related
Documentation

Applications Menu Overview•

• Bandwidth Calendar on page 142

• Event View on page 220
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TopologyMap Color Legend

In the lower left corner of the topology map pane, there is a color legend for the links

displayed in the map. The title of the legend and the units it represents (percent,

milliseconds,megabytes) correspond to thedisplayoption youselect in thePerformance

window in the left pane, shown in Figure 107 on page 152.

Figure 107: Left Pane, Performance Options

Click the legend toenlarge it andenable configurationas shown inFigure 108onpage 152.

Figure 108: Color Legend
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Click the triangle icon in the upper right corner to open the color palette where you can

choose a color scheme. The color scheme options are designed to support any network

visualization goals, including a create-your-own-palette option (Custom).

Figure 109 on page 153 shows the color palette options.

Figure 109: Color Palette Options

Double click in one segment on the Custom palette to open the custom color window

where you can select a color for that segment. Figure 110 on page 153 shows the custom

color window.

Figure 110: Custom ColorWindow
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ClickOK to add the color to the palette. Double click another segment, and so on until
you have selected all five colors for the Custom palette. If you save a layout, the active

palette is saved with the layout, even if it is a custom palette.

The ranges represented in the color legend are configurable. Click and drag the slider

buttons between colors on the legend to change the ranges. The links in the topology

map change color accordingly. Themax value option (gear icon) appears in the upper

right corner of the legend when your Performance selection (left pane) calls for units

other than a percentage. Click the gear icon to set the maximum value for the legend.

Sometimes links display as half one color and half another color. The presence of two

different colors indicates that the utilization in one direction (A to Z) is different from the

utilization in the other direction (Z to A). The half of the link originating from a certain

node is colored according to the link utilization in the direction from that node to the

other node. Figure 111 onpage 154 shows twocolors in oneof the linksbetweenvmx104-11

and vmx105-11-p107.

Figure 111: Two Utilization Color Codes in One Link

Related
Documentation

Left Pane Options on page 62•

Segment Routing

NorthStar Controller supports Source Packet Routing in Networking (SPRING), also

known as segment routing. Starting with Junos OS Release 17.2R1, segment routing for

IS-ISandOSPFv2 is supportedonQFX5100andQFX10000switches.Startingwith Junos

OS Release 17.3R1, segment routing for IS-IS and OSPFv2 is supported on QFX5110 and

QFX5200 switches. See the Junos OS documentation for information about segment

routing concepts and support on Juniper devices running Junos OS.

JunosOSRelease 17.2R1or later is required toutilizeNorthStarControllerSPRING features.

However, NorthStar Controller does not report the correct record route object (RRO) in
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the web UI and via the REST API when routers are configured with Junos OS Release

17.2R1. Instead of showing a list of link adjacency SIDs, the web UI and REST API report

a list of “zero” labels. This issue has been fixed in JunosOSReleases 17.2.R1-S1 and 17.2R2,

and later releases.

Some additional notes about segment routing (SR) LSP support:

• NorthStar does not support OSPF for SPRING.

• NorthStar diverse LSP andmultiple LSP provisioning support segment routing. Select

SR from the Provisioning Type drop-downmenu on the Provision Diverse LSP or

Provision Multiple LSPs window.

• Maintenance events involving SR LSPs are supported for PCEP-based SR LSPs.

• SR LSPs can be configured via NorthStar using either PCEP (real-time pushmodel)

or NETCONF (non-real-time pull model–LSP information is collected via periodic

NETCONF device collection).

SeeProvisionLSPs for full documentationof theProvisionLSPwindowtabs.The following

sections describe provisioning SR LSPs using NorthStar and viewing the SR LSP

information in the NorthStar web UI.

• Segment ID Labels on page 155

• SR LSPs on page 158

• Viewing the Path on page 159

• Binding SID on page 160

• Maximum SID Depth (MSD) on page 164

• PCEP RoutebyDevice Example on page 165

• The Role of NETCONF Device Collection on page 167

• Rerouting and Reprovisioning (PCEP-Provisioned SR LSPs) on page 167

Segment ID Labels

Adjacency segment ID (SID) labels (associated with links) and node SID labels

(associated with nodes) can be displayed on the topological map.

NOTE: YoucanuseeitherBGP-LSpeeringor IGPadjacency fromtheJunosVM
to thenetwork toacquirenetwork topology.However, forSPRING information
to be properly learned by NorthStar when using BGP-LS, the network should
have RSVP enabled on the links and the TED database available in the
network.

YoucandisplayadjacencySID labelson themap.On the right sideof the topologywindow

is a menu bar offering various topology settings. Click the Tools (gear-shaped) icon and

select the Elements tab. Under Links, click the check box for Show Label and select SID
A::Z from the corresponding drop-downmenu. An example topology map showing

adjacency SID labels is shown in Figure 112 on page 156
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Figure 112: Topology Map Showing Adjacency SID Labels

To view adjacency SID labels in the network information table, click the down arrow

beside any column heading under the Link tab, and click Columns to display the full list
of available columns. Click the check boxes beside SID A and SID Z.

When you display the detailed information for a specific link (by double clicking the link

in themap or in the network information table), you see an attribute folder for both endA

and endZ called SR. You can drill down to display attributes for each SID as shown in

Figure 113onpage 156.Atpresent, only IPv4SIDsare supported, andonlyoneper interface.

Figure 113: New SR Attribute Folder in Link Details
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Node SID labels are displayed a little differently because the value of the label depends

on the perspective of the node assigning it. A nodemight be given different node SID

labels based on the perspective of the assigning node. To display node SID labels on the

topology map, specify the perspective by right-clicking on a node and selectingNode
SIDs from selected node. The node SID labels are then assigned from the perspective

of that selected node.

For example, Figure 114 onpage 157 showsa topologydisplaying theSIDnode labels from

the perspective of node vmx101. Note that the node SID label for node vmx106 is 1106.

Figure 114: Node SID Labels fromNode vmx101’s Perspective

If you right-click on node vmx104 and selectNode SIDs from selected node, the node
SID labels on the topology change to reflect the perspective of node vmx104 as shown

in Figure 115 on page 158. Note that the node SID label for node vmx106 is now 4106.
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Figure 115: Node SID Labels fromNode vmx104’s Perspective

The selected node does not display a node SID label for itself. Any other nodes in the

topology map that do not display a node SID label do not have the segment routing

protocol configured.

NOTE: NodeSID information isnotavailable in thenetwork information table.

SR LSPs

SR LSPs can be created using both adjacency SID and node SID labels. An SR LSP is a

label stack that consists of a list of adjacency SID labels, node SID labels, or a mix of

both. To create an SR LSP:

1. Navigate to the Tunnel tab in the network information table and click Add at the
bottom of the table to display the Provision LSP window, Properties tab.

2. From the Provisioning Method drop-downmenu, select either PCEP or NETCONF.

• PCEP SR LSPs are PCE-initiated and the associated configuration statements do

not appear in the router configuration file. The advantage of PCEP is that LSP

information is provided to NorthStar in real time, so changes in path or state are

reflected in the NorthStar UI immediately.

• NETCONF SR LSPs are statically provisioned and the associated configuration

statements do appear in the router configuration file. While SR LSPs can be
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provisioned via NETCONF, they can be learned via either PCEP or NETCONF. In

JunosOSRelease 18.2 R1, PCEP reporting is limited. The alternative is to learn about

the details of the NETCONF-provisioned SR LSPs by way of Device Collection

configuration parsing in NorthStar.If you opt to use this method for SR LSP

provisioning, be aware that because the primary path details come from device

collection configuration parsing, updates are not provided to NorthStar in real time,

and NorthStar reports the operation status for these LSPs as Unknown.

• In order for the configuration statements to be included in the router configuration

file, SR LSPsmust be configured in NorthStar via NETCONF.

3. Complete the Name, Node A, and Node Z fields.

4. From the Provisioning Type drop-downmenu, select SR.

5. For NETCONF SR LSP provisioning (not applicable to PCEP), you can also specify a

binding SID label value in the Binding SID field. See the Binding SID section for more

information.

6. On the Design tab, select the routing method from the drop-downmenu, typically

either routeByDevice (router computes some of the path) or default (NorthStar

computes the path).

7. On the Path tab, you can specify any specific hops you want in the path, including

private forwarding adjacency links generated by the provisioning of binding SID SR

LSP pairs. See the Binding SID section for more information.

8. Click Submit. The provisioning request then enters theWork Order Management
process.

• ForbothPCEPandNETCONFprovisionedSRLSPs,once theworkorder isactivated,

the new path is highlighted in the topology map.

• For NETCONF provisioned SR LSPs, once the work order is activated, the

corresponding configuration statements appear in the router configuration file.

Viewing the Path

There are multiple ways to view the details of the path:

• The IP address and the SID are the two parts of the explicit route. The IP address part

is displayed in the ERO column in the network information table, Tunnel tab. The SID

part is displayed in the Record Route column.

• Double-click on the tunnel row in the network information table and drill down into

the liveProperties to see the details of the ERO.

• Use Junos OS show commands on the router. Some examples are:

• show spring-traffic-engineering lsp name lsp-name detail to display the LSP status

and SID labels.

• show route table inet.3 to display the mapping of traffic destinations with SPRING

LSPs.
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If a link in a path is used in both directions, it is highlighted in a different color in the

topology, and does not have arrowheads to indicate direction. Figure 116 on page 160

shows an example in which the link between vmx105 and vmx106 is used in both

directions.

Figure 116: Example of Link Used in Both Directions

Binding SID

When you provision a pair of binding SID SR LSPs (one going fromA to Z and one for the

return path from Z to A), a private forwarding adjacency is automatically generated.

These adjacencies are named with a specific format, with three sections, separated by

colons. For example, binding:0110.0000.0105:privatefa57.

• The names all start with “binding” followed by a colon.

• The center section is the name of the originating node, followed by a colon

(0110.0000.0105: in this example).

• The last section is the name you specified for the binding SID SR LSP in theName field

on the Properties tab of the Provision LSP window (privatefa57 in this example). This

namemust be the same for the binding SID SR LSPs in both directions, to ensure they

can be properly matched, creating the corresponding private forwarding adjacency

link.

In the topology map, you can opt to display private forwarding adjacency links or not. In

the left pane drop-downmenu, select Types and then select or deselect the check box
for privateForwardingAdjacency under Link Types as shown in Figure 117 on page 161.
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When selected, the adjacencies display as dotted lines on the topology map as shown

in Figure 118 on page 162.

Figure 117: Types Drop-DownMenu Showing Forwarding Adjacencies
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Figure 118: Forwarding Adjacencies Shown on the Topology Map

You can tunnel a non-binding SID SR LSP over a binding SID SR LSP, thereby reducing

thenumberof labels in the label stack (private forwardingadjacency labels can represent

multiple hops in the path). An example is shown in Figure 119 on page 163.

NOTE: Tunneling a binding SID SR LSP over another binding SID SR LSP is
not supported.
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Figure 119: Reduced Label Stack Example

In this display, you can see the logical path (traced in amber) of the SR LSP as it goes

from vmx101 to vmx105, to vmx107 by way of a private forwarding adjacency link, and

finally to vmx103. You can also see (traced in pink) the path of the private forwarding

adjacency link of the binding SID SR LSP. The Record Route column in the network

information tunnel shows a label stack with three labels. The second label of the three

is theprivate forwardingadjacency link.Without that adjacency link, the label stackwould

have required six labels to define the same path.

NOTE: Path highlighting for an SR LSP in a network that has two adjacency
SIDs per interface is not supported.

To provision a pair of binding SID SR LSPs, use the procedure for NETCONF SR LSP

provisioning, plus:
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1. On the Provision LSP window Properties tab, populate the Binding SID field with a

numericalbindingSID label valueof your choice fromthestatic label rangeof 1000000

to 1048575. This value then becomes the label that represents the path defined by

the hops you specify on the Path tab (the hops that make up the private forwarding

adjacency link).

NOTE: Atthis time,NorthStardoesnotsupportbindingSID labelallocation
nor collisiondetection.Note that JunosOShasbuilt-in collisiondetection,
so that if the binding SID label specified is outside the allowed range of
1000000 to 1048575, the router does not allow the configuration to
commit. Correspondingly, the Controller Status in the Tunnel tab of the
network information table shows the usual indication of
FAILED(NS_ERR_INVALID_CONFIG).

2. On the Design tab, select the routing method, default for example.

3. On the Path tab, select the hops in the path.

4. Provision a second binding SID SR LSP in the opposite direction, using the same LSP

name as the first LSP in the pair. The binding SID label value can also be the same as

in the first LSP in the pair, but it is not required that it be the same.

When the binding SID SR LSP pair is provisioned, the private forwarding adjacency link

is automatically created, and can then be selected as a destination when you designate

hops for a non-binding SID SR LSP. Use show commands on the router to confirm that

the LSP pair has been pushed to the router configuration.

MaximumSID Depth (MSD)

To avoid encountering an equipment limitation on themaximum SID depth (MSD), you

can use the RoutingMethod drop-downmenu in the Provision LSPwindow (Design tab)

to select routeByDeviceas shown in Figure 120onpage 165. This option allows the router
to control part of the routing, so fewer labels need to be explicitly specified.

NOTE: routeByDevice is to be usedwhen youwant to create an SR LSPwith
Node SID.
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Figure 120: routeByDevice Selection

NOTE: When provisioning via PCEP, a symptom of encountering the MSD
limitation when you are not using routeByDevice is that although a row for
thenewLSP isaddedto thenetwork information table, theOpStatus is listed
asUnknown and the Controller Status is listed as Reschedule in xminutes.

Provisioning of an SR LSP can include hop information that somewhat influences the

routing. In the Provision LSP window, select the Path tab. There, you can select hops up
to the MSD hop limitation that is imposed on the ingress router, and specify Strict or
Loose adherence.

PCEP RoutebyDevice Example

In Figure 121 on page 166, the routing paths highlighted are the equal cost paths for the t2

LSP.

For t2 in this example:

165Copyright © 2019, Juniper Networks, Inc.

Chapter 5: Path Computation and Optimization



• Node A is vmx101 and Node Z is vmx104.

• The provisioning type is SR, designated in the Properties tab of the Provision LSP
window.

• The routing method is routeByDevice, designated in the Design tab of the Provision
LSPwindow.Thehighlightingof theequal costpathscanonlybeviewed in the topology

if the routing is being done by the PCC.

Figure 121: View of Equal Cost Paths for SR LSP

Themandatory transit router can be part of the generated ERO using the adjacency SID

passing through that transit router. However, specifyingamandatory transit router usually

increases the label stack depth, violating the MSD. In that case, you can try using the

routeByDevice method. To specify a mandatory transit router using Node SID, select the

routingmethodas routeByDevice (Design tab), andspecify the loopbackof themandatory

transit router as loose hop (Path tab).

A possible downside to using routeByDevice is that other constraints you impose on the

LSP links (bandwidth, coloring, andsoon)cannotbeguaranteed.TheNorthStarController

does not provision the LSP if it sees that the constraints cannot bemet. But if the

information available indicates that the constraints can bemet, the NorthStar Controller

provisions the LSP even though those constraints are not guaranteed. Turning on the

path optimization timer enables NorthStar to periodically check the constraints.

If the NorthStar Controller later learns (during the execution of an optimization request,

for example) that the constraints are no longer beingmet, it will try to reroute the tunnel
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by changing the first hop outgoing interface if a specific one was not configured. If that

is not possible, the LSP remains in the network, even though constraints have been

violated.

The Role of NETCONF Device Collection

SRLSPsprovisionedusingNETCONFcanbe learnedeitherbyPCEPorbydevicecollection.

When learned by device collection, the information is pulled in a non-real-time fashion

only when collection tasks are run.

NOTE: When you create your NETCONF device collection tasks, be sure you
select the check box to collect configuration data. This is necessary for
NorthStar to collect andparse the statements in the router configuration file,
including those related to SR LSPs. See Figure 122 on page 167.

Figure 122: Select the Check Box to Collect Configuration

Automatic NETCONF collection is also performed every time an SR LSP is provisioned

using NETCONF in the NorthStar UI.

Rerouting and Reprovisioning (PCEP-Provisioned SR LSPs)

For PCEP-provisioned SR LSPs, the router is only able to report on the operational status

(Op Status in the network information table) of the first hop. After the first hop, the

NorthStar Controller takes responsibility for monitoring the SID labels, and reporting on
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the operational status. If the labels change or disappear from the network, theNorthStar

Controller tries to reroute and re-provision the LSPs that are in a non-operational state.

If NorthStar is not able to find an alternative routing path that complies with the

constraints, the LSP is deleted from the network. These LSPs are not, however, deleted

from the datamodel (they are deleted from the network, and persist in the data storage

mechanism). The goal is to minimize traffic loss from non-viable SR LSPs (black holes)

by deleting them from the network. Op Status is listed asUnknownwhen an SR LSP is
deleted, and the Controller Status is listed asNopath found orReschedule in xminutes.

You canmitigate the risk of traffic loss by creating a secondary path for the LSP with

fewer or more relaxed constraints. If the NorthStar Controller learns that the original

constraints are not being met, it first tries to reroute using the secondary path.

NOTE: Although NorthStar permits adding a secondary path to an SR LSP,
it is not provisioned as a secondary path to the PCC because the SR LSP
protocol itself does not support secondary paths.

Related
Documentation

Provision LSPs•

• Path Optimization on page 149

• Scheduling Device Collection for Analytics via Netconf

• Work Order Management on page 30

IGPMetric Modification from the NorthStar Controller

You can change the IGPmetric fromwithin the NorthStar Controller web UI, without

having to configure anything on the router. Modifying metrics is one way to cause the

path selection process to favor one path over the other available paths.

NOTE: Interface datamust have been collected using a Netconf device
collection task as described in Scheduling Device Collection for Analytics via
Netconf before you canmodify IGPmetrics.

Tomodify IGPmetrics fromwithin the web UI, perform the following steps:

1. In the Link tab of the network information table, highlight the link to bemodified. Click

Modify at the bottom of the table to display the Modify Link window.

2. Click the new Configuration tab where you can change the ISIS Level1, ISIS Level2, or

OSPFmetric for either side of the link, or for both sides.

NOTE: If the Configuration tab is not available, device collection has not
been run.
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3. Click the Properties tab and add a description of the change you are making in the

Comment field. This is optional, butwe recommend it because it serves as a reference

if you want to revert to the original metric.

4. Click Submit. A confirmation window is displayed. Click Yes to continue.

If your system uses BGP-LS for topology acquisition, only the TEmetric can be

immediately updated in the web UI. To retrieve and display other updatedmetrics

(ISIS1, ISIS2, OSPF), right-click the link in the network information table and select

Run Device Collection.

If your system is configured to use IGP adjacency for topology acquisition, this step is

not necessary because all metrics are immediately updated.

Related
Documentation

Device Profile and Connectivity Testing•

• Scheduling Device Collection for Analytics via Netconf

LSP PathManual Switch

Manual switching allows you to select which LSP path is to be active for PCC-controlled

LSPs where the path name is not empty. One use case for this feature is to proactively

switch the active path in preparation for a maintenance event that would make the

currently active path unavailable.

Tomanually switch the active path, perform the following steps:

1. In the Tunnel tab of the network information table, right-click the LSP.

2. Select Set Preferred Path to display the Select Preferred Path window.

NOTE: This menu option is grayed out if the LSP is not a PCC-controlled
LSP for which the path name is not empty.

3. In the list of available paths, click the radio button for the path you want to make

active.When you click a radio button, you can see the corresponding path highlighted

in the topology map.

NOTE: The list of paths comes from the router’s configuration under the
path statement blocks. If the network does not run PCEP, youmust first
run a Netconf device collection task to populate the list of paths.

4. ClickSubmit. TheOpStatus of the paths is updated in the network information table.
In the Configured Preferred Path column, the manually-selected path is designated

as Manual Preferred.
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To remove themanual path designation, perform the following steps:

1. In the Tunnel tab of the network information table, right-click the LSP.

2. Select Set Preferred Path to display the Select Preferred Path window.

3. In the list of available paths, click the radio button next to None.

4. Click Submit. This returns the primary path to active state.

Related
Documentation

Maintenance Events on page 170•

• Scheduling Device Collection for Analytics via Netconf

Maintenance Events

Use the Maintenance option to schedule maintenance events for network elements, so

you can perform updates or other configuration tasks. Maintenance events are planned

failures at specific future dates and times. During a scheduledmaintenance event, the

selected elements are considered logically down, and the system reroutes the LSPs

around those elements during the maintenance period. After the maintenance event is

completed, the default behavior is that all LSPs that were affected by the event are

reoptimized. There is an option that allows you to disable that reoptimization if youwant

to complete the maintenance event, but keep the paths in their rerouted condition.

NOTE: NorthStar only attempts to reoptimize PCE-initiated and
PCC-delegated LSPs (not PCC-controlled LSPs).

NOTE: Maintenance events can also be created by NorthStar when the link
packet loss threshold has been exceeded, triggering LSP rerouting. See “LSP
Routing Behavior” on page 312 for more information about LSP rerouting.

Viewing ScheduledMaintenance Events

You can view scheduledmaintenance events for network elements in the Maintenance

tab of the network information table. In the network information table, the Node, Link,

and Tunnel tabs are always displayed. Maintenance is one of the tabs you can optionally

display. Click the plus sign (+) in the tabs heading bar and selectMaintenance from the

drop-downmenu.

Table 32 on page 170 describes the columns displayed in the Maintenance tab.

Table 32: Network Information Table Maintenance Tab Columns

DescriptionField

Copyright © 2019, Juniper Networks, Inc.170

NorthStar Controller User Guide



Table 32: Network Information Table Maintenance Tab Columns (continued)

Name assigned to the scheduledmaintenance event. The name specified for themaintenance
event is also used to name the subfolder for reports in the Report Manager.

NOTE: The names of triggeredmaintenance events (created by NorthStar) indicate they were
triggered by packet loss.

Name

Number of nodes scheduled for maintenance.Nodes

Number of links scheduled for maintenance.Links

Number of SRLGs scheduled for maintenance.SRLGs

Start time for the maintenance event.Start Time

End time for the maintenance event.End Time

Estimated duration for the maintenance event, which is calculated as the duration between
the Start Time and End Time in the Maintenance Scheduler window.

Estimated Duration

Owner (creator) of the maintenance event.Owner

Possible status conditions are:

• Planned—Event scheduled some time in the future.

• Completed—Event finished in the past.

• In Progress—Event is in progress.

• Canceled—The scheduled event has been canceled. A canceled event is different from a
deleted event. Canceled events remain in themaintenance table for tracking purposes or for
reactivating later.

• Deleted—Event has been deleted from the Maintenance table.

Operation Status

Comments entered when the event was added or modified.Comment

When selected, NorthStar automatically sets the event’s Operation Status to Completed at
the specified End Time.

NOTE: ForNorthStar-createdmaintenanceevents, thisoption isnotavailable.NorthStar-created
events require manual completion via the Modify Maintenance Event window.

Auto Complete

Whenselected,NorthStardoesnotautomatically reoptimizeLSPswhen theevent is completed.No LSP Reoptimization

Nodes included in the event.Node Names

Links included in the event.Link Names

SRLGs included in the event.SRLG Names
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Adding aMaintenance Event

Addanewmaintenanceeventbyclicking theMaintenance tab in thenetwork information

table, and clicking Add at the bottom of the table. The Add Maintenance Event window

is displayed as shown in Figure 123 on page 172.

Figure 123: AddMaintenance EventWindow, Properties Tab

Table 33 on page 172 describes the data entry fields available in the Properties tab. A red

asterisk denotes a required field.

Table 33: AddMaintenance EventWindow, Properties Fields

DescriptionField

Required. Enter a name for the maintenance event.Name

This field auto-populates with the user that is scheduling the maintenance event.Owner

Enter a comment for the maintenance event.Comment

Required. Click the calendar icon to display a monthly calender fromwhich you can select the year,
month, day, and time.

Starts
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Table 33: AddMaintenance EventWindow, Properties Fields (continued)

DescriptionField

Required. Click the calendar icon to display a monthly calender fromwhich you can select the year,
month, day, and time.

Ends

Select the Auto Complete at End Time check box to automatically complete the maintenance event
(bring the elements back up) at the specified end time. If the check box is not selected, youmust
manually complete the maintenance event after it finishes.

NOTE: Tomanually complete an event, select it in the network information table, clickModify, and
use the drop-downmenu in the Status field to select Completed.

When amaintenance event is completed, it triggers NorthStar to bring the maintenance elements
back to an Up state, ready for path reoptimization. The affected LSPs are then rerouted to optimal
paths unless you selectedNo LSP Reoptimization Upon Completion.

Auto Complete at End
Time

Thedefault behavior is for the systemto reoptimize thoseLSPs thatwereaffectedby themaintenance
event when themaintenance event is completed. When you check the No LSP Reoptimization Upon
Completionoption, thatbehavior is disabled.This allowsyou touseamaintenanceevent to temporarily
disable a link in NorthStar.

You can reoptimize all LSPs by navigating to Applications > Path Optimization. You can reoptimize
specific LSPs by selecting them in the Tunnel tab of the network information table, right-clicking, and
selecting Trigger LSPOptimization from the drop-downmenu. You can also right-click on links in the
Link tab to reoptimize LSPs on those links.

NoLSPReoptimization
Upon Completion

Use the Nodes, Links, and SRLG tabs to select the elements that are to be included in

the maintenance event. All three of these tabs are structured in the same way.

Figure 124 on page 174 shows an example.
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Figure 124: Select Elements for Maintenance Event

Select elements in the Available column and click the right arrow tomove them to the

Selected column. Click the left arrow to deselect elements. Click Submitwhen finished.
The newmaintenance event appears in the network information table at the bottom of

the Topology view.

When an element (node, link, or SRLG) is undergoing amaintenance event, it appears

on the topology map with an M (for maintenance) through the element.

Figure 125 on page 175 shows an example.
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Figure 125: Node Undergoing Maintenance

NorthStar-CreatedMaintenance Events

In theMaintenance tabof thenetwork information table, youmightalso seemaintenance

events created by NorthStar in response to packet loss on a link. These events include

just one link per event, and they are named to indicate that theywere created in response

to packet loss. The corresponding link in the topology map displays with the M through

it that indicates the link is logically down due to amaintenance event.

These events start immediately when the link packet loss threshold is exceeded, and the

end time is set for onehour later. Because this typeofmaintenanceevent requiresmanual

completion, the end time is not significant.

These events do not automatically complete because there is no way for NorthStar to

knowwhen troubleshooting efforts have been successful and the link has been restored

to stability. Therefore, youmust manually complete these events using the Modify

Maintenance Event window.

ModifyingMaintenance Events

Tomodify a plannedmaintenance event, select the maintenance event row in the

Maintenance tab of the network information table and clickModify at the bottom of the

table. The Modify Maintenance Event window is displayed where you can change the

parameters, schedule, or status. Figure 126 on page 176shows the Properties tab in the

Modify window.
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Figure 126: Modify Maintenance EventWindow, Properties Tab

See Table 33 on page 172 and Table 32 on page 170 for descriptions of these fields and

possible values.

When you are finished updating the fields, clickOK. The updates youmade are reflected

in the network information table.

Canceling and DeletingMaintenance Events

When you cancel amaintenance event, it remains in theMaintenance tab of the network

information table, with an operation status of Cancelled. When you delete an event, it

is completely removed from the network information table. Youmight want to cancel

an event rather than delete it if you think you will reactivate it later, possibly with

modifications, or if you need it for tracking purposes.

NOTE: You cannot delete amaintenance event that is in progress. You can,
however, cancel one.

To cancel a maintenance event, select the event row in the Maintenance tab of the

network information tableandclickModifyat thebottomof the table.Use thedrop-down

menu in the Status field to select Cancelled.
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To delete amaintenance event, you can select the event row and click Delete at the
bottom of the table. Alternatively, you can select the event row and clickModify at the

bottom of the table. Use the drop-downmenu in the Status field to selectDeleted. With

either method, the row is removed from the table.

SimulatingMaintenance Events

You can run scheduledmaintenance event simulations to test the resilience of your

network. Network simulation is based on the current network state for the selected

maintenance events at the time the simulation is initiated. Simulation does not simulate

the maintenance event for a future network state or simulate elements from other

concurrent maintenance events. You can run network simulations based on elements

selected for a maintenance event, with the option to include exhaustive failure testing.

To access this function, right-click in the maintenance event row in the network

information table and select Simulate.

The Maintenance Event Simulation window, as shown in Figure 127 on page 177, displays

the nodes, links, and SRLGs you selected to include in the event.

Figure 127: Maintenance Event SimulationWindow
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The Exhaustive Failure Simulation section at the bottom of the window is optional. It

providescheckboxes for selecting theelement typesyouwant to include inanexhaustive

failure simulation. If you do not performan exhaustive failure simulation (all check boxes

underExhaustiveFailureSimulationare cleared), all thenodes, links, andSRLGsselected

for the maintenance event fail concurrently. In Figure 127 on page 177, for example, node

0110.0000.0199, link L11.106.107.1_11.106.107.2, and SRLG 100 would all fail at the same

time.

Using this same example, but with Nodes selected under Exhaustive Failure Simulation,

the simulation still fails all the maintenance event elements concurrently, but

simultaneously fails each of the other nodes in the topology, one at a time. If you select

multiple element types for exhaustive failure simulation, all possible combinations

involving those elements are tested. The subsequent report reflects peak values based

on the worst performing combination.

Whether or not you select exhaustive failure, click Simulate to perform the simulation

and generate reports.

Viewing Failure Simulation Reports

When a simulation completes, the Reportsmenu is displayed, showing a list of the newly

generated reports for the simulation, grouped into a folder with the same name as the

maintenance event. You can also view the reports any time by navigating to

Applications>Reports.

The following reports are available for eachmaintenance event simulation:

• RSVP Link Utilization Changes: Shows changes to the tunnel paths, number of hops,

path cost, and delay.

• Peak Simulation Stat Summary: Shows the summary view of the count, bandwidth,

and hops of the impacted and failed tunnels.

• Peak Simulation Tunnel Failure Info: Lists the tunnels that were unable to reroute and

the causing events during exhaustive failure simulation.

• LSP Path Changes: Shows changes to the tunnel paths, number of hops, path cost,

and delay.

• Link Peak Utilization: For each link, this report shows the peak utilization encountered

from one or more elements that failed.

• LinkOversubscriptionStat Summary: Lists the links that reachedover 100%utilization

during exhaustive failure simulation.

• Physical Interface Peak Utilization Report: Physical interfaces report with normal

utilization, the worst utilization, and the causing events during exhaustive failure

simulation.

• Maintenance Event Simulation Report: Link utilization and LSP routing changes during

failure simulation caused bymaintenance events.

• Path Delay Information Report: Shows the worst path delay and distance experience

by each tunnel and the associated failure event that caused the worst-case scenario.
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Related
Documentation

• LSP Routing Behavior on page 312
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CHAPTER 6

Working with Transport Domain Data

• Multilayer Feature Overview on page 181

• Configuring the Multilayer Feature on page 184

• Linking IP and Transport Layers on page 192

• Managing Transport Domain Data Display Options on page 194

Multilayer Feature Overview

Themultilayer feature enables NorthStar Controller to receive an abstracted view of an

underlying transport network and utilize the information to expand its packet-centric

applications. NorthStar Controller does not use the information to compute paths for

the transport domain. The transport layer topology information comes in the form of a

YANG-based data model over southbound RESTCONF and REST APIs.

The following sections describe howmultilayer support is integrated into the NorthStar

Controller:

• Supported Interface Standards on page 181

• Key Features of NorthStar Controller Multilayer Support on page 182

• SRLGs on page 182

• Maintenance Events on page 183

• Latency on page 183

• SRLG Diverse LSP Pairs on page 183

• Protected Transport Links on page 183

Supported Interface Standards

NorthStar currently supports the following interface standards:

• Open ROADM, used by Juniper proNX Optical Director

See https://www.juniper.net/documentation/product/en_US/pronx-optical-director for

Juniper Networks proNX Optical Director documentation.

• TE, used by ADVA Optical Networking and Coriant

TheNorthStar user interface for configuring andworkingwith transport domain data and

the work flow are the same, whether the interface is Open ROADM or TE. There are,
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however, a few differences in terms of supported features, and those are noted in the

documentation.

Key Features of NorthStar Controller Multilayer Support

The following features apply to NorthStar Controller multilayer support:

• A single instance of NorthStar Controller (or multiple NorthStar Controller instances

deployed as a high availability cluster) can receive abstract topology information from

multiple transport controllers simultaneously.

• You can configure multiple devices associated with a single transport controller, and

at least one device is required. If multiple devices are configured, NorthStar Controller

attempts connection to them in round-robin fashion.

• The transport controller should provide the NorthStar Controller with the local and

remote identifier information for each interlayer link. If the transport controller is not

able toprovide the interlayer link identifiers on thepacket domain side, it providesopen

ended interlayer links that you can complete using the NorthStar Controller Web UI.

• Juniper Networks provides an open source script to be used optionally for configuring

interlayer links.

• Transport link failures can be reported by transport controllers and are displayed in

the NorthStar Controller UI as failed transport links. Only failures reported in the traffic

engineering database (TED) are taken into account for rerouting. IP links associated

with transport link failures reported by a transport controller are not considered down

by NorthStar Controller unless reported down in the TED.

• Transport controller profile configuration can be done in the NorthStar ControllerWeb

UI or directly via the NorthStar Controller’s northbound REST API. You can view and

manage transport layer elements in both the web UI and the NorthStar Planner.

• The web UI and the northbound REST API offer premium delay-related path design

options for transport links. In thewebUI, navigate toApplications>Provision LSP, and
click the Design tab. These options are also available in the NorthStar Planner.

When the transport domain is known, the delay information does not need to be

populatedmanually or imported from a static file because the information is learned

dynamically by NorthStar Controller.

• Once the interlayer links mapping is completed, the data used by the path design

options (delay,SRLGs,Protected) ispopulatedautomatically andupdateddynamically

through communication between the transport and NorthStar controllers.

SRLGs

NorthStar Controller considers transport shared risk link group (SRLG) information

whenever a path optimization occurs or whenever some event triggers rerouting.

By default, NorthStar Controller associates transport SRLGs to IP links based on

information received from the transport controller. Connecting NorthStar Controller to

more than one transport controller introduces the possibility of overlap of SRLG ranges,

which might not be desirable. The configuration of transport controller profiles in the
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NorthStar Controller Web UI allows for the specification of an additional TSRLG prefix

(a prefix extension) for each transport controller to prevent unintentional overlap.

Preventing unintentional SRLG range overlap requires particular vigilancewhen you have

transport controller ranges and you also manually assign SRLGs to IP links in NorthStar

Controller.

Maintenance Events

Maintenance events that include transport layer elements can be scheduled in the

NorthStar Controller UI because transport SRLGs are automatically discovered by

NorthStar Controller. You can select any transport layer elements or combination of

transport and packet layer elements to be included in a maintenance event. Of the

transport layer elements only the transport SRLGs can trigger the rerouting of packet

layer LSPs.

Both the NorthStar Controller and NorthStar Planner support creation of maintenance

events that include transport layer elements. The transport controller is notmade aware

of these maintenance events as they exist only in the scope of NorthStar.

Latency

NOTE: Latency information is not available from proNXOptical Director.

NorthStar Controller can dynamically learn latency information for transport links and

interlayer links, to support latency-based routing constraints for packet LSPs. There are

three possible sources for latency values. All of the values are collected and saved, but

whenmultiple values are present for the same object, the NorthStar Controller can only

accept one. The NorthStar Controller resolves conflicts by accepting latency values

according to their source in the following order of preference:

• Manual configuration by the user

• Probes on the routers that support analytics

• Transport controller

SRLG Diverse LSP Pairs

In the web UI, you can create LSP pairs that are SRLG-diverse to each other. Use the

same processes and UI windows you use to create other diverse LSP pairs, and specify

SRLG for diversity. This functionality is also available in the NorthStar Planner.

Protected Transport Links

NorthStar supports preferred protected links routing constraint for packet LSPs. When

this constraint is selected, NorthStar computes the path that maximizes the number of

protected links, and therefore offers the best overall protection. Protected links can be

implemented by way of REST APIs or using the web UI. In the web UI, navigate to

Applications > Provision LSP, and click the Advanced tab. By default, the Route on
Protected IP Link option is not selected.
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NOTE: You can also access the Provision LSPwindow from the network
information table. From the Tunnel tab, clickAdd at the bottom of the table.

Related
Documentation

Configuring the Multilayer Feature on page 184•

• Linking IP and Transport Layers on page 192

• Managing Transport Domain Data Display Options on page 194

Configuring theMultilayer Feature

This section describes transport controller configuration tasks in the web UI.

NOTE: Transport layer elements can be viewed in both the web UI and
NorthStar Planner.

NorthStar Controller can attempt connection to multiple IP addresses (configured as

multiple devices) for the same transport controller profile in a round-robin fashion, until

a connection is established. Once a connection is established, the transport topology

elements are added and can be displayed on the topology map. This configuration is

done by way of a profile group.

Navigate to Administration>Transport Controller to open the Transport Controller
window shown in Figure 128 on page 184.

Figure 128: Transport Controller Window

The Transport Controller window consists of the following panes (numbers correspond

to the numbers in Figure 128 on page 184):

1. Transport Controllers (upper left pane)—Lists configured transport controllers, and

used to save, add, modify, and delete transport controllers.

2. Configuration (upper right pane)—Displays the properties of the transport controller

selected in the Transport Controllers pane, and used to enter andmodify transport

controller properties.
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3. Profile Groups (lower left pane)—Lists configured profile groups, and used to reload,

add, modify, and delete profile groups.

4. Device List (lower right pane)—Lists the devices that are part of the profile group

selected in theProfileGroupspane, andused toadd,modify, delete, and copydevices.

The general configuration workflow is:

1. Create a profile group in the Profile Groups pane.

2. Select the group in the Profile Groups pane. In the Device List pane, create at least

one device for the group. A group can havemultiple devices.

3. Select (or create and select) the transport controller in the Transport Controllers

pane.

4. In the Configuration pane for the selected transport controller, enter the requested

information, including selecting the Group Name from the drop-downmenu. The

devices in the group are then associated with the transport controller.

5. Save the transport controller.

Adding or Deleting a Profile Group

The buttons across the top of the Profile Groups pane perform the functions described

in Table 34 on page 185.

Table 34: Profile Groups Pane Button Functions

FunctionButton

Reloads the selected profile group. Used to update the device list in theUIwhen devices
have been added using the REST API.

Adds a new profile group.

Deletes the selected profile group.

To create a profile group, perform the following steps:

1. In the Profile Groups pane (lower left pane), click the Add (+) button to display the

CreateNewGroupwindow.Figure 129onpage186showstheCreateNewGroupwindow

that is displayed.
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Figure 129: Create NewGroupWindow

2. Enter a name for the new group and clickOK.

To delete a selected group, click the Delete button, and respond to the request for

confirmation.

Adding Devices

The buttons across the top of the Device List pane perform the functions described in

Table 35 on page 186.

Table 35: Device List Button Functions

FunctionButton

Adds a new device.

Modifies the selected device.

Deletes the selected device.
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To create the devices that are part of the new profile group, perform the following steps:

1. In the Device List pane (lower right pane), click the Add (+) button to display the Add

New Device window as shown in Figure 130 on page 187.

Figure 130: Add NewDeviceWindow

2. Enter the requested information. Some fields are populated with default values, but

youcanchange them.Table 36onpage 187describes the fields in theAddNewDevice

window.

Table 36: Add NewDeviceWindow Field Descriptions

DescriptionField

Name of the device for display and reporting purposes.Device Name

The IP address used to connect to theHTTPserver on thedevice. This address
is typically provided by the vendor.

Device IP (required)

Username for authentication. The usernamemust match the username
configured on the server running the device being configured.

Login (required unless the authentication
method is NOAUTH)
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Table 36: Add NewDeviceWindow Field Descriptions (continued)

DescriptionField

Password for authentication. The passwordmust match the password
configured on the server running the device being configured.

Password (required unless the authentication
method is NOAUTH)

Use thedrop-downmenu toselect eitherHTTPorHTTPS.Thedefault isHTTP.Access Method

The HTTP port on the device. The default is 5000.HTTP Port

Number of seconds before a connection request to the device times out. The
default is 300. Use the up and down arrows to increment or decrement this
value or type a different value in the field.

Connection Timeout

Numberof connection retriesbefore thedevice is considereddown.Thedefault
is 3.

Heartbeat Failure Limit

Use the drop-downmenu to select BASIC, NOAUTH, or BEARER. The default
is BASIC.

Authentication Method

Used when the Authentication Method is BEARER. The server URL used to
generate the bearer token based on the user name and password.

Authorization URL

Used when the Authentication Method is BEARER. Number of seconds the
bearer token is valid.

The default is 3600.

Token Expiration Time

Table37onpage 188showsthe fields that require specific values forparticular transport

controller vendors. Fieldsnot listedarenot typically vendor-specific. Confirmall values

with the vendor before using them.

Table 37: Vendor-Specific Device Field Values

CoriantADVAProNXOptical DirectorField

HTTPHTTPSHTTPAccess Method

808180808082HTTP Port

BASICBASICBEARERAuthentication Method

NANAhttp://ip-addr:8084/auth/authenticateAuthorization URL

NANA3600s (the default)Token Expiration Time

3. Click Submit.

4. Repeat the procedure to add all the devices for the profile group.

Copyright © 2019, Juniper Networks, Inc.188

NorthStar Controller User Guide



You can drag and drop device rows to change the order in the Device list. Changing the

order in the list changes the order in which connection to the devices is attempted.

Configuring the Transport Controller Profile

The buttons across the top of the Transport Controllers pane perform the functions

described in Table 38 on page 189.

Table 38: Transport Controllers Pane Button Functions

FunctionButton

Saves the transport controller profile.

Adds a new transport controller profile.

Deletes the selected transport controller profile.

To configure a transport controller profile, perform the following steps:

1. In the Transport Controllers pane (upper left pane), click the Add (+) button. The

default name newController is added to the Transport Controllers pane in red text

(because it hasnot yetbeensaved), and is selected soyoucanpopulate theproperties

in the Configuration pane (upper right pane).

2. In the Configuration pane, enter the requested information. Table 39 on page 189

describes the transport controller profile configuration fields and identifies the ones

that are required.

Table 39: Transport Controller Configuration Fields

DescriptionField

Name of the transport controller profile. The default name for a new profile
is newController. We recommend you use the name of the vendor (ADVA, for
example) as the name of the transport controller profile, so NorthStar
Controller can use corresponding icons in the UI. Otherwise, it uses generic
icons.

Name (required)

Use the drop-downmenu to select a group name from those configured in
the Profile Groups pane.

Group Name (required)

Use the drop-downmenu to select either ietf-te-topology-01 or
OpenROADM-2.0.

Model

Use the drop-downmenu to select REST or RESTCONF. The default is REST.Interface Type (required)

REST or RESTCONF URL on the transport controller that publishes topology
change notifications.

Notify URL (required)
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Table 39: Transport Controller Configuration Fields (continued)

DescriptionField

The server URL used to poll server liveness. If the interface type is RESTCONF
and no value is entered, NorthStar Controller uses /.well-known/host-meta
by default. If the interface type is REST, youmust enter a value which you
obtain from the vendor.

Poll URL

Default root URL for RESTCONF datastores.Root URL

Enables separation of shared risk link group (SRLG) spaces whenmultiple
controllers are configured.

• If a prefix is entered, the SRLG takes the form TSRLG_<prefix>_<SRLG>.

• If no prefix is entered, the SRLG takes the form TSRLG_<SRLG>.

SRLG Prefix

Specifies the topology to use in the event that a controller returns multiple
topologies. This is your choice from the topologies provided, but there are
typical topologies for each vendor. The field can be left empty, in which case
all topologies are imported. If the value does not match a topology exported
by the transport controller, no topology is shown.

Topology to use

URL on the transport controller that provides the abstract topology.Topology URL (required)

Used when the Model is OpenROADM-2.0. IP layer link that fetches services
information.

Service URL

Number of seconds between reconnection attempts to the devices included
in the profile group. The default is 300.

Reconnect Interval

Table 40 on page 190, Table 41 on page 191, and Table 42 on page 191 show the fields

that require specific values for particular vendors. Confirm all values with the vendor

before using them.

Table 40: proNXOptical Director: Typical Transport Controller Field Values

ProNXOptical Director

JuniperPODName

OpenROADM-2.0Model

RESTCONFInterface Type

/websockets/NETCONF-JSONNotify URL

(None)Poll URL

opticalTopology to Use

/restconf/data/ietf-network:networkTopology URL

/restconf/data/org-openroadm-service:service-listService URL
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Table 41: ADVA: Typical Transport Controller Field Values

ADVA

ADVAName

ietf-te-topology-01Model

RESTInterface Type

/rest/NETCONFNotify URL

/rest/data/ietf-te-topology:te-topologies-statePoll URL

ADVA_TOPOLOGY_1Topology to Use

/rest/data/ietf-te-topology:te-topologies-stateTopology URL

NAService URL

Table 42: Coriant: Typical Transport Controller Field Values

Coriant

CoriantName

ietf-te-topology-01Model

RESTCONFInterface Type

/streams/NETCONF-JSONNotify URL

(None)Poll URL

Customized_Topology_for_NorthStar_1_DemandsTopology to Use

/rest/data/ietf-te-topology:te-topologies-stateTopology URL

NAService URL

3. Click theSavebutton in theTransportControllerspane tosave the transport controller

profile. The profile name turns from red to black if saved successfully. If it does not

becomeblackwhenyouattempt to save it, double check thedata in theConfiguration

pane.

Related
Documentation

Multilayer Feature Overview on page 181•

• Linking IP and Transport Layers on page 192

• Managing Transport Domain Data Display Options on page 194
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Linking IP and Transport Layers

Sometimes, when interlayer links are initially loaded into the model, only the source is

known. To complete the linking of the transport layer to the IP layer, youmust supply the

missing remote node (node Z) information in one of the ways described in the following

sections:

• Linking the Layers Manually on page 192

• Linking the Layers Using an Open Source Script on page 193

Linking the Layers Manually

To provide the missing Node Z IP address for an interlayer link, perform the following

steps:

1. Select the Link tab in the network information table of theWeb UI topology window.

Highlight the link to be updated.

2. ClickModify in the bottom tool bar to display the Modify Link window shown in

Figure 131 on page 192.

Figure 131: Modify LinkWindow
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3. In the Node Z field, use the drop-downmenu to select the remote node.

4. In the IP Z field, enter the IP address for the corresponding IP link on the remote node.

5. Click Submit.

Linking the Layers Using an Open Source Script

Juniper Networks provides an open source script for use in completing the configuration

of interlayer links. The script is particularly useful when there are a large number of

interlayer links to configure at once.

Input File Requirements

The script requires an input file that identifies at least one side of each IP link. It is not

necessary to includeboth sidesof the IP linksbecause themissing sidecanbedetermined

from the transport circuits provided by the transport controller.

The text file must include just onemapping per interlayer link andmust be formatted

with just onemapping per line. If you are providing both sides of an IP link, use two lines,

one per side.

The format of a mapping is:

transport-node-name|transport-link-ID IP-address

For example:

Transport:0.1.0.5|1008001 11.112.122.2

Run the Script

The script is installed at the following location on the NorthStar Controller server:

/opt/northstar/mlAdapter/tools/configureAccessLinks.py

Run the script from the CLI using your username (full-access user group required),

password, and input file:

./configureAccessLinks.py --user=username --password=password input_file_name

Related
Documentation

Multilayer Feature Overview on page 181•

• Configuring the Multilayer Feature on page 184

• Managing Transport Domain Data Display Options on page 194
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Managing Transport Domain Data Display Options

Layers, types, transport circuits, transport SRLGs, and latency values can all be displayed

in thewebUI and theNorthStar Planner. TheRESTAPI offers the option to use protected

links. This topic focuses on navigating to the display options you have in each case.

NOTE: Latency information is not available from proNXOptical Director.

• Displaying Layers on page 194

• Displaying Node and Link Types on page 195

• Displaying Transport Circuits and Associated IP Links on page 197

• Displaying Latency on page 197

• Displaying Transport SRLGs on page 199

• Displaying Link Protection Status on page 199

Displaying Layers

Displaying Layers in theWeb UI

In the left pane of the topology window, select Layers from the drop-downmenu to

display the Layers list. The Layers list gives you the option to exclude or include individual

layer information in the topology map.

The colors indicated in the Layers list are reflected in the topology map so you can

distinguish the nodes belonging to the different layers. Figure 132 on page 195 shows an

example of a topology map that includes both IP Layer and Transport Layer elements.

The dotted link lines are interlayer links.
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Figure 132: Topology with IP and Transport Layers

Displaying Layers in the NorthStar Planner

In the left pane of the topology map window, access advanced filters by selecting

Filters>Advanced.

From the Advanced filters window you have the option to hide various elements on the

topology map including IP layer, transport layer, and interlayer links. To hide an element,

select thecorrespondingcheckbox.Todisplayanelement, clear thecorrespondingcheck

box.

Displaying Node and Link Types

Displaying Types in theWeb UI

In the left pane of the Topology window, select Types from the drop-downmenu to

display theTypes list. The list includes categories of nodesand links found in thenetwork.

Different types are associated with different icons, which are reflected in the topology

map.
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You can select or deselect a type by checking or clearing the corresponding check box.

Only selected options are displayed in the topologymap. Figure 133 on page 196 shows a

Types list and topology map for a network that includes a Coriant transport layer.

Figure 133: Left Pane Types List with Transport Layer

The network information table below the topology map includes a Layer column that is

available on the Node tab. If you do not see the column, hover over any column heading

and click the down arrow that appears. A column selection window is displayed. Select

the Layer check box to include that column in the table.

Displaying Types in the NorthStar Planner

In the Left pane of the Topology Mapwindow, select Filters>Types to display categories
of nodes and links that you can opt to display or hide on the topology map.

You can select or deselect a type (Transport, for example) by checking or clearing the

corresponding check box. Only selected options are displayed in the topology map. You

can also change the line color and style for a link type by clicking the line indicator next

to the check box.

The Network Info table below the topologymap includes tabs for L1 Links, L1 Nodes, and

Interlayer Links.

If youdonot seeacolumn, click theplus sign (+)at theendof the rowofcolumnheadings

to display available columns. Click the column you want to display.
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Displaying Transport Circuits and Associated IP Links

Once the interlayer links are mapped, the transport paths for the corresponding IP links

are known and are displayed in the UI.

Displaying Transport Circuits in theWeb UI

In the web UI, the paths are added to the network information table in the Tunnel tab. In

the Layer column, they are identified as Transport. The names are the same as the

corresponding IP link names.

If a selected IP link in the Link tab of the network information table has an associated

transport circuit, it is automatically highlighted.

Displaying Transport Circuits in the NorthStar Planner

In the NorthStar Planner, the paths are added to the network information table in the

Tunnels tab together with normal packet tunnels. The names are the same as the

corresponding IP link names. In the Type column, they are identified as L1Circuit.

Right-click an IP link in the Network Info table Tunnels tab or on the topology map to

access the option to display the L1 circuit path if there is an associated transport circuit.

Displaying Latency

Displaying Latency in theWeb UI

NOTE: Latency information is not available from proNXOptical Director.

Using the topology settingswindow, you can opt to display latency on the topologymap.

Perform the following steps:

1. Access the Topology Settings window by clicking on the settings icon (gear) in the

upper right corner of the topology window. Figure 134 on page 197 shows the settings

icon.

Figure 134: Settings Icon to Access Topology Settings

2. In the Elements tab, shown in Figure 135 on page 198, click the check box for Show

Label in the Links section (the middle section) and select Delay A::Z from the

corresponding drop-downmenu.
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Figure 135: Link Label Settings

The topology map displays the latency values for each link in the form delayA::delayZ

(252::252, for example), inmilliseconds. In the Link tab of the network information table,

the Delay A and Delay Z columns also display these latency values.
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Displaying Latency in the NorthStar Planner

Through the Link Labels window, you can opt to display latency on the topology map.

Perform the following steps:

1. Right-click in the topologymapwindowandnavigate toLabels>LinkLabels. The Link
Labels window is displayed as shown in Figure 136 on page 199.

Figure 136: Link LabelsWindow

2. In the “What Text?” column, select Delay and clickOK.

The topology map displays the latency values for each link in the form delayA-delayZ

(252-252, for example).

Displaying Transport SRLGs

Displaying SRLG information is the same in both the web UI and the Nework Planner.

Click the SRLG tab in the network information table to display all SRLGs, including

transport SRLGs. Transport SRLGs have names beginning with TSRLG by default. For

example, TSRLG_4. If you configured an optional prefix extension in the transport

controller profile (to help prevent range overlap), that is also displayed in the Name

column. For example, TSRLG_Coriant_4.

When you select anSRLG, all links in all layers in the group are highlighted in the topology

map.

In the web UI, you can also use the Link Label settings window shown in

Figure 135 on page 198 to specify that SRLGs are to be displayed on the topologymap as

link labels.

Displaying Link Protection Status

Displaying Link Protection Status in the web UI

In the network information table, you can display a column that shows the protection

status of transport and IP layer links. Perform the following steps:
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1. Select the Link tab in the network information table.

2. Click the down arrow in any column heading, and select Columns.

3. Click the checkbox beside Protected.

4. You can thenmanually change the protection status of any link by selecting the link

and clickingModify at the bottom of the table. Click in the Protected check box

(Properties tab) to select or deselect protected status. Protected links are highlighted

in the topology map.

Displaying Link Protection Status in the NorthStar Planner

In the NorthStar Planner network information table, you can view the protection status

of transport as well as IP layer links. Perform the following steps:

1. In the network information table, select the Links or L1Links tab.

2. Right-click in any column heading and select Table Options to display the Table
Options window shown in Figure 137 on page 200.

Figure 137: Table OptionsWindow
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3. On the left side, select CanFail and click Add to add the column to the display.

4. By default, links are set to CanFail=yes, and the corresponding check boxes are

selected. If the transport controller indicates that a link is protected, NorthStar clears

the check box for that link, making it protected.

NOTE: The NorthStar REST API offers the ability to use a protected link,
which suspends the link’s protected status.

Related
Documentation

• Multilayer Feature Overview on page 181

• Configuring the Multilayer Feature on page 184

• Linking IP and Transport Layers on page 192
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CHAPTER 7

High Availability

• High Availability Overview on page 203

High Availability Overview

High Availability (HA) on NorthStar Controller is an active/standby solution. Thatmeans

that there is only one active node at a time, with all other nodes in the cluster serving as

standbynodes.All of thenodes inaclustermustbeon the samesubnet forHA tosupport

virtual IP (VIP). On the active node, all processes are running. On the standby nodes,

those processes required to maintain connectivity are running, but NorthStar processes

are in a stopped state. If the active node experiences a hardware- or software-related

connectivity failure, the NorthStar HA_agent process elects a new active node from

amongst the standby nodes. Complete failover is achieved within five minutes. One of

the factors in the selection of the new active node is the user-configured priorities of the

candidate nodes.

All processes are started on the new active node, and the node configures the virtual IP

address based on the user configuration (via net_setup.py). The virtual IP can be used

for client-facing interfaces as well as for PCEP sessions.

• Failure Scenarios on page 203

• Failover and the NorthStar Controller User Interfaces on page 204

• Support for Multiple Network-Facing Interfaces on page 204

• LSP Discrepancy Report on page 204

• Cluster Configuration on page 205

• Cassandra Support for a Multiple Data Center Environment on page 205

• Ports that Must be Allowed by External Firewalls on page 206

Failure Scenarios

NorthStar Controller HA protects the network from the following failure scenarios:

• Hardware failures (server power outage, server network-facing interfaces, or

network-facing Ethernet cable failure)

• Operating system failures (server operating system reboot, server operating system

not responding)
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• Software failures (failure of any process running on the active server when it is unable

to recover locally)

Failover and the NorthStar Controller User Interfaces

If failover occurs while you are working in the NorthStar Controller Java Planner client,

the client is disconnected and youmust re-launch NorthStar Controller using the

client-facing interface virtual IP address.

NOTE: If the server has only one interface or if you only want to use one
interface, thenetwork-facing interface is thenalso theclient-facing interface.

TheWeb UI also loses connectivity upon failover, requiring you to log in again.

Support for Multiple Network-Facing Interfaces

Upto fivenetwork-facing interfacesare supported forHighAvailability (HA)deployments,

one of which you designate as the cluster communication (Zookeeper) interface. The

net_setup.py utility allows configuration of the monitored interfaces in both the host

configuration (Host interfaces 1 through 5), and JunosVM configuration (JunosVM

interfaces 1 through 5). In HA Setup, net_setup.py enables configuration of all the

interfaces on each of the nodes in the HA cluster.

The ha_agent sends probes using ICMP packets (ping) to remote cluster endpoints

(including the Zookeeper interface) to monitor the connectivity of the interfaces. If the

packet is not received within the timeout period, the neighbor is declared unreachable.

The ha_agent updates Zookeeper on any interface status changes and propagates that

information across the cluster. You can configure the interval and timeout values for the

cluster in theHAsetup script. Default valuesare 10 secondsand30seconds, respectively.

Also in the HA setup utility is an option to configure whether switchover is to be allowed

for each interface.

For nested VM configurations, youmay need to modify supervisord-junos.sh to support

the additional interfaces for junosVM.

LSP Discrepancy Report

During an HA switchover, the PCS server performs LSP reconciliation. The reconciliation

produces the LSP discrepancy report which identifies LSPs that the PCS server has

discoveredmight require re-provisioning.

NOTE: OnlyPCC-initiatedandPCC-delegatedLSPsare included in the report.

Access the report bynavigating toApplications>Reports. Figure 138onpage205shows
a list of available reports, including the LSP Discrepancy report.
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Figure 138: Reports List Available from Applications > Reports

Cluster Configuration

TheNorthStar implementationofHA requires that the cluster haveaquorum, ormajority,

of voters. This is to prevent “split brain” when the nodes are partitioned due to failure. In

a five-node cluster, HA can tolerate twonode failures because the remaining three nodes

can still form a simple majority. Theminimum number of nodes in a cluster is three.

There is an option within the NorthStar Controller setup utility for configuring an HA

cluster. First, configure the standalone servers; then configure the cluster. SeeConfiguring

a NorthStar Cluster for High Availability in the NorthStar Controller Getting Started Guide

for step-by-step cluster configuration instructions.

Cassandra Support for a Multiple Data Center Environment

NorthStar Controller uses the Cassandra database to manage database replicas in a

NorthStar cluster. The default setup of Cassandra assumes a single data center. In other

words, Cassandra knows only the total number of nodes; it knows nothing about the

distribution of nodes within data centers.

But in a production environment, as opposed to a lab environment, it is typical to have

multiple data centerswith one ormoreNorthStar nodes in eachdata center. In amultiple

data center environment like that, it is preferable for Cassandra to have awareness of
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the data center topology and to take that into consideration when placing database

replicas.

For configuration steps, seeConfiguring the Cassandra Database in aMultiple Data Center

Environment.

Ports that Must be Allowed by External Firewalls

Among theports usedbyNorthStar, there are a number thatmust beallowedby external

firewalls inorder forNorthStarController servers tocommunicate.SeeNorthStarController

System Requirements in the NorthStar Controller Getting Started Guide for a list of ports

used by NorthStar Controller that must be allowed by external firewalls. The ports with

the word cluster in their purpose descriptions pertain specifically to HA configuration.

Related
Documentation

• Configuring a NorthStar Cluster for High Availability

• Configuring the Cassandra Database in a Multiple Data Center Environment
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CHAPTER 8

SystemMonitoring

• Dashboard Overview on page 207

• Logs on page 209

• Subscribers and System Settings on page 211

Dashboard Overview

TheDashboardview is shown inFigure 139onpage208.TheDashboardpresentsavariety

of status and statistics information related to the network, in a collection of widgets that

you can arrange according to your preference. The information displayed is read-only.
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Figure 139: DashboardWidgets, Not All Showing the Same Network

Table 43 on page 208 describes the available dashboard widgets.

Table 43:Widgets Available in the Dashboard

DescriptionWidget

Summation of the elements (nodes, links, LSPs, SRLGs) in themodel, computed
from the client. If the values differ from the information reported in the Network
Status (left pane) or in the network information table, it is because they have
different sources of data for the calculations and different rates of synchronizing
to the client.

Network Elements

Periodically poles for status. This is a troubleshooting tool.Network Model Audit

Pie chart showing the percentage of the total LSP bandwidth that is accounted
for by each LSP type (PCE-initiated, PCC-delegated, PCC-controlled).

LSP Bandwidth

Aggregates the number of LSPs by hop count, per LSP type (PCE-initiated,
PCC-delegated, PCC-controlled). In other words, it shows the number of LSPs
of each type with three hops, with two hops, and so on. The LSP types are color
coded according to the key at the bottom. Click an LSP type in the key to toggle
between hiding and unhiding the LSP type. Mouse over the color bar to see the
count.

Hop Count Statistics
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Table 43:Widgets Available in the Dashboard (continued)

DescriptionWidget

Top 10 routers that have LSPs originating there, and the number of originating
LSPs. Click the button in the lower right corner to toggle between table, bar chart,
and pie chart representation.

Top 10 LSP Source

Top 10 routers that have LSPs terminating there, and the number of terminating
LSPs. Click the button in the lower right corner to toggle between table, bar chart,
and pie chart representation.

To 10 LSP Destination

Number of active, standby, and secondary LSPs that are Up and Down.LSP Summary

The dashboard offers the following options for customizing the arrangement of widgets:

• The Settings drop-downmenu in the upper right corner of the Dashboard view allows

you to change the number of widget columns.

As shown in Figure 140 on page 209, you can select either Two columns or Three
columns.

Figure 140: Dashboard Settings Menu

• Minimize a widget by clicking on the up arrow in the upper right corner of the widget.

• Close a widget by clicking on the X in the upper right corner of the widget.

• Drag and drop widgets to relocate them on the dashboard.

• From the Settings drop-downmenu in the upper right corner of the dashboard, select

Restore defaults to return all the widgets to the original display arrangement.

Logs

Navigate toAdministration>Logs to view a list of the available NorthStar logs. Click any

log name to display the contents of the log itself.

Figure 141 on page 210 shows a sample list of logs.
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Figure 141: List of Logs

Hover over any column heading and click the down arrow that appears to view sorting

and column selection options. Figure 142 on page 210 shows an example of sorting and

column selection options.

Figure 142: Sorting and Column Selection Options
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Figure 143 on page 211 shows a sample log.

Figure 143: Sample Log

Click View Raw Log in the upper left corner to view the log in a new browser window or

tab.Thisenablesyou tokeep the logviewablewhile youperformotheractions inNorthStar

Controller.

Logs are typically used by system administrators and for troubleshooting purposes.

Subscribers and SystemSettings

You can access Subscribers and System Settings by selecting Administration from the

MoreOptionsmenu in theupper right cornerof theNorthStarControllerUI. Theseoptions

are visible to and accessible by the Admin user only.

Subscribers

TheAdmin can assign users to receive systemmessages by navigating toAdministration
>Subscribers. ClickAdd in theupper right cornerof theSubscriberManagementwindow
to display the Add Subscriber window as shown in Figure 144 on page 212.
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Figure 144: Add SubscriberWindow

Enter the email address of the user to be subscribed (under Profile) and select the type

of systemmessages to be received (under Subscriptions). Only disk space notifications

areavailableat this time.ClickSubmit to complete the subscription. See “GeneralSystem
Settings” on page 214 for information about customizing disk space notifications.

Once subscribed, the user receives systemmessages and can then take the appropriate

action.

NOTE: In addition to adding subscribers, the Adminmust also navigate to
Administration > SystemSettings and ensure that the SMTPMail Server is
enabled in theOutgoingMail section. If themail server isdisabled, subscribers
cannot receive systemmessages.

You canmodify or delete existing subscribers by clickingModify or Delete in the upper
right corner of the Subscriber Management window.

SystemSettings

Navigate to Administration>SystemSettings from the More Options menu to access

the general system settings shown in Figure 145 on page 213:
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Figure 145: General System Settings

In the upper right corner of the General Settingswindow is an Advanced Settings button.

This button allows you to toggle back and forth between general and advanced system

settings. The advanced system settings are shown in Figure 146 on page 213.

Figure 146: Advanced System Settings
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General SystemSettings

The general settings are described in Table 44 on page 214.

Table 44: General System Setting Descriptions

DescriptionSetting

When enabled, users are automatically logged out of the NorthStar Controller after
the specified period of inactivity. The timer is disabled by default. To enable it, select
Enable and enter the time in minutes.

User Inactivity Timer

Link flap can be enabled or disabled, and is enabled by default. Adjust the seconds
and count settings as appropriate for your network.

Link Flap Behavior

Provisioning canbeglobally enabledor disabled for all users, and is enabledbydefault.
Disablingprovisioningdoesnotpreventusers fromaccessingandusing theprovisioning
functions in the UI, but it does prevent those actions from taking effect in the network.
This allows you to respond toperiodsof network instability bypreventing theadditional
strain on the system that might result from provisioning going on at the same time.

Provisioning

When set toOn, NorthStar can optimize resource utilizationmore effectively andmore
aggressively. When set to Off, some LSPsmay not be routed due to bandwidth
overbooking when a Make Before Break (MBB) operation is performed.

Zero Bandwidth Signaling

The SMTPmail server must be enabled for subscribers to receive systemmessages.SMTPMail Server

For eachpartition, you can set the disk usage threshold that triggers a systemmessage
to be sent out to subscribers as configured in Administration > Subscribers. Click on
the slider and drag to adjust the threshold.

Disk Space Notification Thresholds

Advanced SystemSettings

In the Advanced System Settings window, there are two operations available to the

administrator that help keep NorthStar’s view of the network (the network model)

synchronized with the live network:

• Sync Network Model

TheSyncNetworkModel operation refreshes the synchronizationof thenetworkmodel

and is appropriate to use if, for example, the network model audit has unresolved

discrepancies.

When you sync the network model, this is what happens behind the scenes:

1. Information associated with the network model (nodes, links, LSPs, interfaces,

SRLGs, and user-defined parameters) remains intact. Nothing is purged from the

database.

NOTE: Device profiles are not affected.

2. NorthStar processes, including the topology server and path computation server

processes, are restarted.
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3. The networkmodel is repopulatedwith live data learned from topology acquisition.

• Reset Network Model

WARNING: This operation is typically more appropriate for a lab rather
than a production environment.

The Reset Network Model operation should not be undertaken lightly, but there are

two circumstances under which youmust reset the network model in order to keep

themodel in sync with the actual network:

• The node ISO network entity title (NET) address changes. This can happen when

configuration changes are made to support IS-IS.

• The routing device’s IP address (router ID) changes. The router ID is used by BGP

and OSPF to identify the routing device fromwhich a packet originated. The router

ID is usually the IP address of the local routing device. If a router ID has not been

configured, the IP address of the first interface to come online is used, usually the

loopback interface.Otherwise, the first hardware interfacewithan IPaddress is used.

If either of these addresses changes, and youdo not perform theResetNetworkModel

operation, the network model in the NorthStar Controller database becomes out of

sync with the live network.

When you reset the network model, this is what happens behind the scenes:

1. Information associated with the network model (nodes, links, LSPs, interfaces,

SRLGs, and user-defined parameters) is purged from the database (so you would

not want to do this unless you have to).

NOTE: Device profiles are not affected.

2. NorthStar processes, including the topology server and path computation server

processes, are restarted.

3. The networkmodel is repopulatedwith live data learned from topology acquisition.

Table 45 on page 216 describes the effects on various elements in the networkwhen you

reset or synchronize the model.
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Table 45: Effects of Resetting or Synchronizing the Network Model

Could data be lost?
Is the item sent back to the
controller by the live network?

Is the element removed from
the database?

SyncResetSyncResetSyncReset

NoYes for some
design
attributes,
such as
user-defined
node name

YesYesNoYesIP nodes

NoYes for design
attributessuch
as Comment

YesYesNoYesIP links

NoNoYesYesNoYesPCC-controlled
LSPs

NoYes for
non-PCEP
attributessuch
asdesign flags

YesYes for PCEP
attributes

NoYesPCC-delegated
LSPs

NoYes for
non-PCEP
attributessuch
asdesign flags

YesYes for PCEP
attributes

NoYesPCE-initiated LSPs

NoYes for some
designed
attributessuch
as
user-defined
names

NoYesNoYesMultilayer nodes

NoYes for design
attributessuch
as Comment

NoYesNoYesMultilayer links

Yes, access
links to
unknown
nodes are lost
and need to be
recreated

YesYes, links
mapped to
known nodes
are re-sent.

NoNoYesInterlayer links

NoNoNoYesNoYesMultilayer-derived
facilities

YesYesYesYesYesYesLink-derived
facilities
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Table 45: Effects of Resetting or Synchronizing the Network Model (continued)

Could data be lost?
Is the item sent back to the
controller by the live network?

Is the element removed from
the database?

SyncResetSyncResetSyncReset

NoNoN/AN/ANoNoOngoing
maintenance
events

NoYesN/AN/ANoYesFuture
maintenance
events

NoYes
(scheduled
LSP is never
terminated)

N/AN/ANoNoOngoingscheduled
LSPs

NoYesN/AN/ANoYesFuture scheduled
LSPs

NoNoN/AN/ANoNoDevice profiles

NoNoN/AN/ANoNoRouter latitude and
longitude

NoNoN/AN/ANoNoRouter grouping

NoNoN/AN/ANoNoUsers table

NoNoN/AN/ANoNoSavedmap layout

NoNoN/AN/ANoNoEvents

NoNoN/AN/ANoNoScheduled path
optimization

Another setting youmight associate with synchronization is available by navigating to

Administration > Device Profile. The Sync with Live Network button in the Device List
window allows you to initialize device profiles with the live network. See Device Profile

and Connectivity Testing for more information about this function.

Related
Documentation

• Device Profile and Connectivity Testing
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CHAPTER 9

Network Monitoring

• System Health on page 219

• Event View on page 220

• Viewing Link Event Changes on page 222

• NorthStar REST API Notifications on page 225

• Reports Overview on page 227

• Navigating in Nodes View on page 228

SystemHealth

NorthStarSystemHealthenhanceshealthmonitoring functionality in theareasofprocess,

server, connectivity (topology and PCEP), license monitoring, and themonitoring of

distributed analytics collectors in an HA environment.

• NorthStar Controller licenses are inspected to determine validity. When a login is

attempted on a license that is not valid, a license upload page is presented to the user.

• Youcandisplaycluster, datacollector, andconnectivity status informationbynavigating

to Administration > SystemHealth. For HA cluster environments, you can view the

process status of all processes in all cluster members. Both BGP-LS and ISIS/OSPF

peering statuses are also available.

NOTE: Hover over any column heading and click the down arrow that
appears to view sorting and column selection options.

• Critical healthmonitoring information ispushed toawebUIbanner thatappearsabove

the Juniper Networks logo. Conditions that are considered critical include expiring

license, disk utilization exceeds threshold, and a server time difference of more than

60 seconds between application servers in an HA cluster.

NOTE: The healthmonitor does not enable NorthStar Controller to take
anycorrectiveaction regarding thesenotices. Its responsibility is tomonitor
and report so the user can respond as appropriate.
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Event View

The Event View opens in a new browser window or tab when you navigate to

Applications>Event View. Figure 147 on page 220 shows the Event View.

Figure 147: Event View

The event data displayed in the Event View is stored in the database. The number of

eventsdependson theNorthStar configuration.Bydefault,NorthStar keepseventhistory

for 35 days. To customize the number of days event data is retained:

1. Modify the dbCapacity parameter in /opt/northstar/data/web_config.json

2. Restart the pruneDB process using the supervisorctl restart infra:prunedb command.

NOTE: Oneevent typically requiresabout300bytesofmemory.SeeNorthStar
Controller System Requirements for server sizing guidance.

In theupper right paneof the view is a tableof events, listed in chronologically descending

order by default. You can change the order by using the sort options available when you

hover over any column heading and click in the down arrow that is displayed. You can

sort by any column, in ascending or descending order. You can also select the columns

youwant to display. Figure 148 on page 221 shows the options displayedwhen you hover

over a column heading and click the down arrow.
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Figure 148: Event View Sorting and Column Display Options

In the upper left pane is a grouping bar chart. By clicking on the Settings menu in the

lower right corner of the pane, you can select the groupings you want to include. Click

and drag groupings to reorder them as shown in Figure 149 on page 221.

Figure 149: Event View Bar Chart Settings

On the bar chart, any blue bar can be broken down further until you drill down to the

lowest level, which is portrayed by a gray bar. Click a blue bar to drill down to the next

level. To go back to a previous level, click empty space below the bar chart.

For example, if the Settings menu has Source, Type, and Name selected, in that order,

the first bar chart display has events grouped by Source. If you click the bar representing

the events for one source, the display refreshes to show all the events for that source

grouped by Type, which is the next grouping in the menu. If you then click the bar

representing the events for one type, the display refreshes again, showing all the events

for that source and type, grouped by name, and those bars are gray.

Each time the bar chart refreshes, the table of events refreshes accordingly.

In the pane at the bottom of the view is a timeline that shows the number of events on

the vertical axis and time on the horizontal axis. You can select the time span displayed

by opening the drop-downmenu in the upper right corner of the pane as shown in

Figure 150 on page 222.

221Copyright © 2019, Juniper Networks, Inc.

Chapter 9: Network Monitoring



Figure 150: Event View Time Span Options

You can also left-click and drag in the timeline to highlight a discrete period of time. The

event table and bar chart panes refresh to display only the events included in the time

frameyouselected. Figure 151onpage222showsaselectedperiodof time in the timeline.

Figure 151: Event View Timeline Partial Selection

Related
Documentation

Dashboard Overview on page 207•

Viewing Link Event Changes

To identify the root cause of frequent LSP changes or flaps, you can view changes to the

link that the LSP traverses that occurred during the time period of the LSP changes. The

NorthStar Controller records all the link events and allows you to query on those link

changes (such as operational status and bandwidth) over any specified time period.

All link events are stored in the database. However, to display all raw events would result

in an excess of unnecessary information for NorthStar Controller users. To avoid this

situation, the Path Computation Server (PCS) processes the link events and displays

only the events that trigger actual link changes. You can view these link change entries

in the Event View that opens as a separate browser window or tab.

The Event View opens in a new browser window or tab when you navigate to

Applications>Event View. Figure 152 on page 223 shows the Event View.
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Figure 152: Event View

The event data displayed in the Event View is stored in the database. The number of

events depends on the NorthStar configuration.

In theupper right paneof the view is a tableof events, listed in chronologically descending

order by default. You can change the order by using the sort options available when you

hover over any column heading and click in the down arrow that is displayed. You can

sort by any column, in ascending or descending order. You can also select the columns

youwant to display. Figure 153 on page 223 shows the options displayedwhen you hover

over a column heading and click the down arrow.

Figure 153: Event View Sorting and Column Display Options

In the upper left pane is a grouping bar chart. By clicking on the Settings menu in the

lower right corner of the pane, you can select the groupings you want to include. Click

and drag groupings to reorder them as shown in Figure 154 on page 224.
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Figure 154: Event View Bar Chart Settings

On the bar chart, any blue bar can be broken down further until you drill down to the

lowest level, which is portrayed by a gray bar. Click a blue bar to drill down to the next

level. To go back to a previous level, click empty space below the bar chart.

For example, if the Settings menu has Source, Type, and Name selected, in that order,

the first bar chart display has events grouped by Source. If you click the bar representing

the events for one source, the display refreshes to show all the events for that source

grouped by Type, which is the next grouping in the menu. If you then click the bar

representing the events for one type, the display refreshes again, showing all the events

for that source and type, grouped by name, and those bars are gray.

Each time the bar chart refreshes, the table of events refreshes accordingly.

In the pane at the bottom of the view is a timeline that shows the number of events on

the vertical axis and time on the horizontal axis. You can select the time span displayed

by opening the drop-downmenu in the upper right corner of the pane as shown in

Figure 155 on page 224.

Figure 155: Event View Time Span Options

You can also left-click and drag in the timeline to highlight a discrete period of time. The

event table and bar chart panes refresh to display only the events included in the time

frameyouselected. Figure 156onpage224showsaselectedperiodof time in the timeline.

Figure 156: Event View Timeline Partial Selection
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NorthStar REST API Notifications

This feature allows third-party applications to receive NorthStar Controller event

notifications by subscribing to the NorthStar REST API push notification service. The

notifications are pushed by way of the socket.io interface. The following event types are

included:

• Node (nodeEvent)

• Link (linkEvent)

• LSP (lspEvent)

• P2MP (p2mpEvent)

• Facility (facilityEvent)

• HA (haEvent)

Table 46 on page 225 lists the schema for each of these event notification types.

Table 46: NorthStar Event Notification Types

DescriptionSchemaEvent Type

Node event notification.topology_v2.json#/definitions/nodeNotificationnodeEvent

Link event notification.topology_v2.json#/definitions/linkNotificationlinkEvent

LSP event notification.topology_v2.json#/definitions/lspNotificationlspEvent

P2MP group event notification. The LSPs in the
update are reduced to their lspIndex values to
reduce the size of the event.

topology_v2.json#/definitions/p2mpGroupNotificationp2mpEvent

Facility/SRLG event notification.topology_v2.json#/definitions/facilityNotificationfacilityEvent

Node state event notification. Only update (no
add or remove) events are supported. The
notification does not include the list of processes
and only contains operational information.

topology_v2.json#/definitions/haHostNotificationhaEvent

Node health event notification. Only update (no
add or remove) events are supported. The
notifications include utilization of CPU, disk,
memory that exceed certain threshold, and
processes status.

topology_v2.json#/definitions/
healthThresholdNotification

healthEvent

Examples

NOTE: The following examples are written in Python. Lines preceded by #
are comments.
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To ensure secure access, a third party application must be authenticated before it can

receive NorthStar event notifications. Use the NorthStar OAuth2 authentication API to

obtaina token for authenticationpurposes. The tokenallows subscription to the socket.io

channel. The following example shows connecting to NorthStar and requesting a token.

#!/usr/bin/env python
import requests,json,sys
serverURL = 'https://northstar.example.net'
username = 'user'
password = 'password'
# use NorhtStar OAuth2 authentication API to get a token
payload = {'grant_type': 'password','username': username,'password': password}
r = requests.post(serverURL + 
':8443/oauth2/token',data=payload,verify=False,auth=(username, password)) data
 =r.json()
if "token_type" not in data or "access_token" not in data:
     print "Error: Invalid credentials"
     sys.exit(1)
# The following header needs to be passed on all subsequent request to REST 
or Notifications
auth_headers= {'Authorization': "{token_type} {access_token}".format(**data)}

The following example retrieves the NorthStar topology nodes and links.

#!/usr/bin/env python
import requests,json,sys
serverURL = 'https://northstar.example.net' 
# auth_headers : see Authentication Token retrieval  
data = requests.get(serverURL + 
':8443/NorthStar/API/v2/tenant/1/topology/1/',verify=False,headers=auth_headers)

topology=data.json()

The following example subscribes to the NorthStar REST API push notification service.

#!/usr/bin/env python 
from socketIO_client import SocketIO, BaseNamespace 
serverURL = 'https://northstar.example.net' 
class NSNotificationNamespace(BaseNamespace):
     def on_connect(self):
         print('Connected to %s:8443/restNotifications-v2'%serverURL)
     def on_event(key,name,data):
         print "NorthStar Event: %r,data:%r"%(name,json.dumps(data)) 
# auth_headers : see Authentication Token retrieval
socketIO = SocketIO(serverURL, 8443,verify=False,headers= auth_headers) 
ns = socketIO.define(NSNotificationNamespace, '/restNotifications-v2')
socketIO.wait()
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Reports Overview

Navigate toApplications>Reports toaccess the reportsdescribed inTable47onpage227.

NOTE: Click the Help icon (questionmark) in the upper right corner of the
NorthStar window to displaymore information about the selected report.

Table 47: Available Reports

SourceReport

Generated when you run a Demand Reports Collection task. You select the specific reports you
want to generate when you schedule the collection task.

Demand Reports

Generated when you run the Device Collection task and select configuration data as a collection
option.

NOTE: Youmust run a collection to generate a network archive for this report to be available.

Integrity Checks

Generated when you run the Device Collection task and select equipment CLI data as a collection
option.

NOTE: Youmust run a collection to generate a network archive for this report to be available.

Inventory

During an HA switchover, the PCS server performs LSP reconciliation and produces the LSP
discrepancy report. This report identifies LSPs that the PCS server has discoveredmight require
re-provisioning.

LSP Discrepancy

Generated when you use the Simulate Maintenance Event function.Maintenance

Updated summary of network elements. One report is currently available in this category, called
Nodes. It displays counts of LSPs that start, end, or transit through each node in the topology.

Network Summary

Generated when you use the Analyze Now function for path optimization.

NOTE: PCC-controlled LSPs are not included in the reports because NorthStar does not attempt
to optimize PCC-Controlled LSPs.

Path Analysis and
Optimization

• PathAnalysisOptimizationReport: lists LSPs that are currently not in anoptimizedpath, suggests
what the optimized paths should be, and provides data about what could be gained (in terms of
delay, metric, distance, and so on) if the LSP were to be optimized.

• LSPPathChanges: lists changes toPCE-initiated andPCC-delegated LSPsas a result of analysis.

• RSVP Link Utilization Changes: lists the changes in Link RSVP bandwidth reservation if all LSPs
were to be routed over their optimized paths instead of their current paths.

Figure 157 on page 228 shows the Reports menu.
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Figure 157: Reports Menu

Report details aredisplayed inapane to the right of themenuwhenyouclick an individual

report in the menu. Click the Help icon (question mark) in the upper right corner of the

report details pane to display a description of the report.

In the IntegrityCheck report, youcan right-click a line in the report andselectShowConfig
to bring up the Configuration Viewer.

At the bottom of the Reports window, click the export icon to export the report to a CSV

file.

Navigating in Nodes View

The Nodes view displays detailed information about the nodes in the network. With this

view, you can see node details, tunnel and interface summaries, and groupings, all in one

place.

Figure 158 on page 229 shows the Nodes view.

Copyright © 2019, Juniper Networks, Inc.228

NorthStar Controller User Guide



Figure 158:Web User Interface Nodes View

The Nodes view is divided into three panes:

• Nodes list on the far left—Lists all nodes in the topology, including any node groups.

Click a node to select it. Click the plus (+) or minus (-) sign next to a group to expand

or collapse the list of nodes within the group.

• Detailed node information to the right of the Nodes list—Shows detailed information

for the node selected in the Nodes list.

• Tunnels and Interfaces tables on the bottom of the display—Lists all the tunnels and

interfaces that start at the selected node, along with their properties. Mouse over any

column heading and click the down arrow to select or deselect columns. Sorting and

filtering options are also available.

Related
Documentation

• Topology View Overview on page 39
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CHAPTER 10

Data Collection and Analytics

• NorthStar Analytics Raw and Aggregated Data Retention on page 231

• Device Profile and Connectivity Testing on page 234

• Introduction to the Task Scheduler on page 248

• Scheduling Device Collection for Analytics on page 250

• Viewing Analytics Data in theWeb UI on page 258

• Netconf Persistence on page 266

• Bandwidth Sizing on page 268

• Data Collection via SNMP on page 275

• Link Latency Collection on page 282

• LDP Traffic Collection on page 287

• Collection Tasks to Create Network Archives on page 295

• Netflow Collector on page 300

• LSP Routing Behavior on page 312

NorthStar Analytics Raw and Aggregated Data Retention

Rawdata logs are retained in Elasticsearch for a user-configurable number of days. Data

is also rolled up (aggregated) every hour and retained for a user-configurable number

of days. The purpose of aggregation is to make longer retention of data more feasible

given limited disk space.When youmodify these retention parameters, keep inmind that

there is an impact on your storage resources.

Stored hourly aggregated data filenames use the following format:

rollups-northstar-yyyy-mm-dd.

Theparametersdescribed inTable48onpage232work together tocontrol data retention

and aggregation behaviors. The parameters are located in

/opt/northstar/data/northstar.cfg, and you canmodify their values there.
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Table 48: Data Retention and Aggregation Parameters

DescriptionParameter

Controls how often the CollectionCleanup system task is run.
This task executes the collector-utils.py script to clean up old
logs. The default is one day (1d). The collector-utils.py script
runs at approximately 1:00 AM, NorthStar server time.

Units can be hours (h), days (d), or weeks (w).

Thecollector-utils.py script uses theelaticsearchAPIs to clean
up “old” data as follows:

• Logs of raw data older than the value of the
es_log_retention_days parameter are purged.

• Logs of hourly aggregated data older than the value of the
es_log_rollups_retention_days parameter are purged.

TheCollectionCleanup task is called fromtheNorthStar server.
You can view (but not modify) the cleanup task by navigating
to Administration > Task Scheduler.

collection_cleanup_task_interval

Defineswhat is consideredan “old” logof rawdata. Thedefault
is 90 days, meaning that raw data logs are retained in
Elasticsearch for 90 days. This can be expressed only in days,
so no unit designation is required. To disable the retention of
raw data logs, set the value to 0.

es_log_retention_days

Defineswhat is considered “old” aggregated data. The default
is 1000 days, meaning that hourly aggregated data is retained
in Elasticsearch for 1000 days. This can be expressed only in
days, so no unit designation is required. To disable retention
of aggregated data, set the value to 0.

es_log_rollups_retention_days

Controls how often the ESRollup system task is run. This task
executes the esrollup.py script to aggregate the previous
interval’s data. The default is 1 hour (1h).

NOTE: We recommend that you do not change this default
value except to disable aggregation. If you want to disable
data aggregation, set the value to -1.

The esrollup.py script uses the elaticsearch APIs to perform
the data aggregation.

The ESRollup task is called from theNorthStar server. You can
view (but not modify) the rollup task by navigating to
Administration > Task Scheduler.

es_data_rollup_interval

NOTE: There is an additional parameter, dbCapacity, that controls how long
event data is stored. This parameter is not related to analytics. See “Event
View”onpage220for informationaboutchanging thevalueof thisparameter
from the default of 35 days.
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The NorthStar REST API supports telemetry data aggregation with the additional

parametersdescribed inTable49onpage233.SeetheNorthStarRESTAPIdocumentation

for more information.

Table 49: Additional Aggregation Parameters Used for API Queries

DescriptionParameter

A value of 1 indicates that rollup query functionality is enabled. A value of 0 indicates it
is disabled.

rollup_query_enabled

If rollup_query_enabled is set to 1 (enabled) and the requested time range in stats REST
API is greater than es_rollup_cutoff_days from now, the query uses the roll-up index to
search data.

es_rollup_cutoff_days

Tomodify retention or aggregation parameters, use a text editing tool such as vi and

modify the value of the parameters in the northstar.cfg file. For example:

vi /opt/northstar/data/northstar.cfg
.
.
.
collection_cleanup_task_interval=7d
es_log_retention_days=30
es_log_rollups_retention_days=800

In this example, raw data logs older than 30 days and hourly aggregated data logs older

than 800 days are set to be purged every seven days.

The data included in the rollup tasks (aggregation types, fields, and counters) is defined

in the view-only esrollup_config.json file located in the /opt/northstar/utils directory.

Toviewthesystemtasks that launch theesrollup.pyandcollector-utils.py scripts, navigate

to Administration > Task Scheduler in the NorthStar web UI. In the Task list, the Name
column indicates CollectionCleanup or ESRollup Task. In the Type column, they are

designated as ExecuteScript. An example is shown in Figure 159 on page 233.

Figure 159: Task List Showing System Tasks

There is an optional column in the task list that indicates whether each task is a system

task. Hover over any column heading, click the down arrow that appears, and highlight
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Columns to display a list of available columns. Click the check box for System Task to

select the System Task column (true/false) for inclusion in the display.

When you select a system task, Summary, Status, and History tabs are available at the

bottom of the window.

Device Profile and Connectivity Testing

Completing device profiles is a prerequisite to running collection tasks. Navigate to

Administration>Device Profile to open the Device Profile windowwhere you can:

• Set up or modify the device list. Initially, the device list contains all the devices

discovered from the traffic engineering database (TED). The device IP address (if not

already discovered) and the PCEP IP address for each device are required. The PCEP

IP address is the local address of the PCC located in the PCE statement stanza block.

• Supply a hostname for each router for OSPF networks. This is necessary because the

TED does not contain hostnames for OSPF networks.

• Specify anMD5 key to secure PCEP communication between theNorthStar Controller

and the PCC.

• Specify device SNMP parameters for SNMP connectivity.

• Test connectivity of devices using ping, SSH, SNMP, and Netconf.

NOTE: When the Device Profile window is first opened, no automatic
comparison between the live network and the configured device list is
performed. This means youmight not see discrepancies immediately. You
canmanuallyperformthecomparisonbyclicking theSyncwithLiveNetwork
button at the top of the window.When the device list is opened for the very
first time, it is blank until you perform a Sync with Live Network.

Figure 160 on page 235 shows the Device Profile window, including the device list in the

upper pane and details about the highlighted device in the lower pane.
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Figure 160: Device ProfileWindow

Device List Pane

The Device List pane shows all the devices in the profile along with many of their

properties. You can change the order of the devices in the list by clicking and dragging

rows. Sorting, column selection, and filtering options are available when you hover over

a column heading and click the down arrow that appears. Figure 161 on page 236 shows

an example.

235Copyright © 2019, Juniper Networks, Inc.

Chapter 10: Data Collection and Analytics



Figure 161: Sorting, Column Selection, and Filter Options

You can filter the devices that are included in the display by activating a filter on any

column. See “Sorting and Filtering Options in the Network Information Table” on page 81

for a description of the column filtering functionality, along with an example.

The buttons across the top and bottom of the Device List pane perform the functions

described in Table 50 on page 236. Button labels are displayedwhen you hover over icon

buttons.

Table 50: Device List Button Functions

FunctionButton

Saves the device profile changes. The button becomes active whenmodifications or edits have
beenmade to entries or fields in the device list. When the button is active, youmust click it to
finalize your changes.

Save Changes
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Table 50: Device List Button Functions (continued)

FunctionButton

Synchronizes devices with the live network. This function does not delete devices from the
selected profile that do not exist in the live network, but it does add devices that are missing
from the live network, and it synchronizes all devices with a corresponding live network device.

When you click Sync with Live Network, this is what happens behind the scenes:

• The latest network topology is retrieved using NorthStar REST API calls.

• The Device Profile is updated with changes and additions, though deletions are ignored –
entries in the Device Profile that correspond to nodes deleted from the live network are not
removed.

Sync with Live Network

Tests connectivity on the selected devices.Test Connectivity

Adds a device.Add

Modifies the selected device.Modify

Deletes the selected device.Delete

Filters the list of devices according to the text you enter.Filter

Reloads the device profiles. This is useful when you aremodifying a device entry and then realize
that you don’t want to save it. Reload will reload the device list back to the last saved state.

(Reload Device Profiles)

Offers device groupmanagement and group display options.

(Device Grouping)

Exports device profiles to a comma separated values (CSV) file named DeviceProfiles.csv.Export Device Profiles

Imports devices from a CSV file. This is particularly useful when there are a large number of
devices toadd.Clicking thebuttonopens the ImportDevices fromCSVwindowwhere youbrowse
to the CSV file and specify the appropriate delimiter. A preview of the data appears in the Data
Preview box.

Import Device Profiles

You can performmany of these functions onmultiple devices simultaneously. To select

multiple devices, Ctrl-click or Shift-click the device rows and then click the button for

the function you wish to perform.

Test Connectivity

The Test Connectivity button opens the Profile Connectivity window shown in

Figure 162 on page 238.
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Figure 162: Profile ConnectivityWindow

Click the Use Management IP check box if the devices to be tested havemanagement

IP addresses specified for out-of-band use. ClickOptions to open the Test Connectivity
Options window shown in Figure 163 on page 238.

Figure 163: Test Connectivity OptionsWindow
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In the General tab, you can:

• Specify which test methods you want to use (Ping, SSH, SNMP, NETCONF). Multiple

methods are allowed (by default, all methods are tested). To select or deselect

methods, click the corresponding check boxes.

• Allow for concurrentaccessofanumberofdevicesby specifyingasimultaneousaccess

limit from 1 to 16. The default is 7.

In the SNMP tab, you can add optional SNMP get community string(s), one per line. If an

SNMP connectivity check fails with the community string specified in the device profile

(SNMPParameters tab), theseadditional community stringsare trieduntil one succeeds.

In the Login/Password tab, you can enter alternate login credentials to be used in case

of login/password failure.

ClickOK to submit your selections and close the Test Connectivity Options window.

In theProfile Connectivitywindow, clickStart to begin the connectivity test. You can click
Stop if the test fails to complete quickly. The test is complete when the green (pass) or
red (fail) status icons are displayed. Figure 164 on page 239 shows an example.

Figure 164: Connectivity Test Results

In SNMP connectivity testing, the host name and device type (vendor) are polled and

areauto-populated in the test results if the informationwaspreviouslymissingor incorrect

in the device profile. A red triangle in the upper left corner of a field in the test results

indicates that a change was automatically made. You can see an example in the Device

column in Figure 164 on page 239. To propagate those changes to the device profile, click

Profile Fix at the bottom of the Connectivity Test Results window.
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Todisplay thedetailed test results for an individual device in the lowerpart of thewindow,

click thedevice row in theupperportionof thewindow, even if youonly testedconnectivity

for a single device.

NOTE: The Start button remains unavailable after test completion until you
close the window and reopen it to begin a new connectivity test.

Add Device

The Add button opens the Add New Device window shown in Figure 165 on page 240.

Figure 165: Add NewDeviceWindow

Table 51 on page 240 describes the data entry fields under the General tab.

Table 51: Add NewDevice General Field Descriptions

DescriptionField

Name of the network device, which should be identical to the hostname. During configuration
collection, the software uses this name as part of the name of the collected configuration file.
The configuration filename uses the format ip.name.cfg. If the device name is left blank, the
configuration filename uses the format ip.cfg.

Device Name

Required field: IP address of the network device.Device IP
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Table 51: Add NewDevice General Field Descriptions (continued)

Management IP address for the device. NorthStar Controller first attempts connection using the
management IP address if it is specified, and then the IP address.

NOTE: Themanagement IP address is required for out-of-bandmanagement access.

Management IP

The local address of the PCC located in the PCE statement stanza block.

NOTE: We highly recommend that this field be populated.

PCEP IP

Select the device vendor from the drop-downmenu. The default is JUNIPER. The vendor is
displayed in the Device List under the column heading Type.

Vendor (Type)

Model number of the device.Model

Type of operating system installed on the device.OS

Version number of the operating system build installed on the network device. The default value
is > 14.2x.

NOTE: For routers configured with PCEP using Junos OS Release 14.2x and earlier, select <=
14.2x for this parameter.

OS Version

Device group name you assign to the device, such as a regional group.

NOTE: A device can only have one group designation.

Device Group

Login ID for the network device.Login

Password for the network device.Password

Login ID for situations that require a higher-security login.Privilege Login

Password for situations that require a higher-security login.Privilege Password

NOTE: Werecommendyoudonot use the credentials of JunosOS root users
when running device collection. NorthStar Controller will not raise awarning
when such credentials are used, even if the task fails.

Table 52 on page 241 describes the data entry fields under the Access tab.

Table 52: Add NewDevice Access Field Descriptions

DescriptionField

Number of milliseconds after which a connection attempt times out. The default is 300. To enter
a different value, type the number of milliseconds in the field or use the up and down arrows to
increment or decrement the displayed value.

SSH Timeout

Number of times a connection to the device is attempted. The default is 3. To enter a different
value, type the number of retries in the field.

SSH Retry
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Table 52: Add NewDevice Access Field Descriptions (continued)

DescriptionField

Command to use for SSH connection. The default is ssh. To enter a different value, type the
command in the field. Include the full path of the command and options used for ssh, such as
/usr/bin/ssh -1 -p 8888.

SSH Command

Select this checkbox to enable Netconf communication to the device.Enable Netconf

Select this checkbox to allow NorthStar to do a single commit instead of multiple commits when
you provision multiple LSPs on the same router.

NOTE: This is mandatory for P2MP-TE.

Enable Bulk Commit

Enter the number of times a Netconf connection is to be attempted. The default is three.

NOTE: A value of 0means an unlimited number of retries - connection attempts never stop.

Netconf Retry

Message Digest 5 Algorithm (MD5) key string, also configured on the router. “Configuring MD5” on
page 247 provides information on configuring MD5 authentication.

NOTE: All the routers in the network must have their PCEP IP addresses in the profile. This is
especially important if any router in the network is configured with an MD5 authentication key.

PCEPMD5 String

The fields on the SNMP Parameters tab are required to set up for SNMP collection. The

SNMP parameters are described in Table 53 on page 242.

Table 53: SNMP Parameters

DescriptionSNMP Parameter

Use the drop-downmenu to select SNMPv1, SNMPv2c, or SNMPv3. The
default is SNMPv2c.

Version

SNMPport. Thedefault is 161.Mustmatch theport configuredon the router.Port

SNMP get community string as configured on the router. The default is
“public” if you leave it blank.

Get Community

Number of times connection will be attempted. The default is 3.Retry

Number of seconds after which connection attempts will stop. The default
is 3.

Timeout

NOTE: Additional fieldsbecomeavailable if youselectSNMPv3astheversion.

In the User Defined Properties tab, you can add properties not directly supported by the

NorthStar UI.

Click Submit to complete the device addition. The new device appears in the device list.
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Modify Device

The Modify button opens the Modify Device(s) window, which has the same fields as

the Add New Device window. Edit the fields you want to change and click Submit. Click
Save Changes to complete the modification. You can wait until you have completed all
your device modifications to click Save Changes, which will have become active to flag
that there are unsaved changes.

Tomodify one ormore fields in the sameway formultiple devices, Ctrl-click or Shift-click

to select the devices in the device list and clickModify. On the resultingModify Device(s)
window, you canmake changes that affect all the selected devices.

NOTE: As an alternative to opening the Modify Device(s) window, you can
change some of the device properties directly in the Device List pane by
double-clicking the fields.

Delete Device

Todeleteadevice, select thedevice row in theDevice List andclickDelete. A confirmation
window is displayed as shown in Figure 166 on page 243.

Click Yes to complete the deletion.

Figure 166: Delete Device ConfirmationWindow

NOTE: If youdeleteadevice fromthe liveNetworkprofile, youarenotdeleting
it from the live network itself. You can restore the device to the profile using
the Sync with Live Network button.

Device Grouping Options

With device grouping, you can group devices inways that are independent of topological

groups. Since Netconf task collection supports collection by device profile group, one

way to use this functionality is to manage Netconf sub-collection tasks by group.

Whenyouclick thedownarrowbeside theDeviceGrouping icon, the twooptionsdisplayed

are:

243Copyright © 2019, Juniper Networks, Inc.

Chapter 10: Data Collection and Analytics



• Toggle Device Grouping

• Manage Device Grouping

Select Toggle Device Grouping to either display the devices in the Device List according
to their assigned groups, or not. Figure 167 on page 244 shows an example of a device list

in which device grouping is toggled on.

Figure 167: Device List Displayed by Group

To return to the ungrouped device list, selectDisable Grouping. To display just the group
names without displaying the groupmembers, select Collapse All. To return to the
grouped display in which the groupmembers are also shown, select Expand All.

SelectManage Device Grouping to open the Manage Device Groups window as shown

in Figure 168 on page 244.

Figure 168: Manage Device GroupsWindow
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Existing groups are listed on the left side. Click the name of an existing group to display

its members in the “Devices in the group” list on the right. All other devices are listed in

the “Select device(s) from” list where you can select devices to add.

Todeleteagroup, click thenameofanexistinggroupon the left andclickDeleteGroup(s)
at the bottom. This action removes the group assignment from themember devices.

Groups with nomembers are automatically deleted.

To create a new group and add devices to it, type the group name at the top and click

the New Group check box. All devices are then listed in the “Select device(s) from” list

so you can choose the groupmembers. Figure 169 on page 245 shows an example. If you

add devices that are already assigned to a group, the new assignment removes the

previous assignment.

Figure 169: Manage Device GroupsWindow

Click Apply to save your work.

You can also assign a group to a device profile in theAddNewDevice orModify Device(s)

window (General tab). The Manage Device Groups window is particularly useful for

making changes to multiple devices at once.

Device Detail Pane

The Device Detail pane displays the properties of the device that is highlighted in the

Device List pane. There are two ways to minimize this pane:

• Click the down arrow at the top center of the pane. Click the up arrow tomaximize the

pane.

• Click the downarrow in the top right corner of the pane. Click the up arrow tomaximize

the pane.

Click and drag the topmargin of the pane to resize the pane.
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Logical Systems

Some networks include both a physical topology and a logical topology. An example of

how that could look in theNorthStar UI topology view is shown in Figure 170 onpage 246.

In this example, the physical and logical layers are not connected, but they could be,

depending on your network.

Figure 170: Logical and Physical Topologies Example

Logicalnodes (andLSPs that incorporate logical nodes)are fully supportedbyNorthStar,

but somewhat differently from physical nodes:

• Logical topology is discovered automatically via BGP-LS. See theConfiguring Topology

AcquisitionandConnectivityBetween theNorthStarController and thePathComputation

Clients section in the NorthStar Controller Getting Started Guide for more information.

• LSPs originating from a logical system cannot be discovered directly by PCEP. Instead,

you run device collection for physical devices and any corresponding LSPs originating

from logical devices are imported into the network information table, under the tunnel

tab. The correlation between the physical and logical systems are established via

device collection.

• In the network information table in NorthStar, display the optional columns Physical

Hostname and Physical Host IP so you can confirm that NorthStar successfully

correlated the physical and logical nodes when it performed device colleciton.
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• Because PCEP is not supported for logical devices, it is not possible for NorthStar to

obtain real time topology updates for logical devices. We recommend periodic device

collection to compensate for this limitation.

• Device collection must be run before you attempt to create LSPs that incorporate

logical nodes because otherwise, the logical nodes are not available as selections for

Nodes A and Z in the Create LSPwindow. In the Create LSPwindow, youmust specify

Netconf as the Provisioning Method (not PCEP) when the LSP incorporates logical

nodes.

For more information about logical nodes and provisioning LSPs that incorporate them,

see “Provision LSPs” on page 104.

ConfiguringMD5

MD5 can be used to secure PCEP sessions as described in RFC 5440, Path Computation

Element (PCE)CommunicationProtocol (PCEP).MD5authenticationmustbeconfigured

on both the NorthStar Controller (in the Device Profile window) and on the router (using

the Junos OS CLI). The authentication keymust be the same in both configurations. The

device profile acts as a “white list” when MD5 is configured. The NorthStar Controller

does not report LSPs or provision LSPs for the routers not included in the device profile.

NOTE: The first timeMD5 is enabled on the router, all PCEP sessions to
routersare reset toapplyMD5at thesystemlevel.Whenever theMD5enabled
status on a router or the MD5 key changes, that router resets the PCEP
connection to the NorthStar Controller.

The first four stepsaredone in theNorthStarControllerDeviceProfilewindow, toconfigure

MD5 for the PCEP session to a router.

1. Select a router in the Device List pane.

2. ClickModify to open the Modify Device(s) window.

3. In the MD5 String field (Access tab), enter the MD5 key string. ClickModify.

4. Click Save Changes to save your changes. The PCEPMD5 Configured field for the
router changes from no to yes.

NOTE: All the routers in the networkmust have their PCEP IP addresses
in the profile. When you save your changes, youmight receive a warning,
reminding you of this.

5. The final step is done in the JunosOSCLI on the router, to configureMD5 for the PCEP

session to the NorthStar Controller.
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Use the set authentication-key commandat the [edit protocols pceppce] hierarchy
level to configure the MD5 authentication key.

user@pcc# set protocols pcep pce pce-id authentication-keymd5-key

Related
Documentation

Scheduling Device Collection for Analytics via Netconf•

• Data Collection via SNMP

• Link Latency Collection

Introduction to the Task Scheduler

In the NorthStar Controller UI, navigate to Administration > Task Scheduler to manage
the NorthStar task types described in Table 54 on page 248.

The first fiveof the task types listedarecollection tasks. TheNorthStarControllerAnalytics

features require that the Controller periodically connect to the network in order to obtain

the configuration of network devices. It uses this information to correlate IP addresses,

interfaces, and devices, as well as collecting various types of statistics. Completion of

deviceprofiles (Administration>DeviceProfile) is aprerequisite for successfully running
collection tasks.

Table 54: Task Types Managed from the Task Scheduler

DescriptionTask Type

Connection to thenetwork inorder toobtain theconfigurationofnetworkdevices.Device Collection

“Scheduling Device Collection for Analytics”
on page 250

Collection of tunnel and interface traffic via SNMP.SNMP Traffic Collection

“Data Collection via SNMP” on page 275

Collection of round trip time (RTT) statistics using a ping operation.Link Latency Collection

“Link Latency Collection” on page 282

Collection task that creates a network model in a database, for use in the
NorthStar Planner. You also have the option to archive the network model.

Network Archive

“Collection Tasks to Create Network
Archives” on page 295

Collectionof LDP traffic statistics that track thevolumeof traffic passing through
forwardingequivalenceclasses.Thedatacanalsobe imported into theNorthStar
Planner for capacity planning and failure simulation studies.

LDP Traffic Collection

“LDP Traffic Collection” on page 287

Generation of reports on detailed network traffic information.Demand Reports

“Netflow Collector” on page 300
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Table 54: Task Types Managed from the Task Scheduler (continued)

DescriptionTask Type

Periodically sendsanewplannedbandwidth forbandwidth sizing-enabledLSPs
to the NorthStar PCS. The PCS determines whether it needs to provision the
new planned bandwidth with a path that satisfies the new bandwidth
requirement.

Bandwidth Sizing

“Bandwidth Sizing” on page 268

This task type is for system tasks that are launched by NorthStar to run scripts.
These tasks are included in the task list for information only–you cannot add or
modify them.

Examples of system tasks include:

• CollectionCleanup: purges old raw and aggregated analytics data.

• ESRollup: Aggregates the collected data from the previous hour.

There is an optional column in the task list that indicates whether each task is
a system task. Hover over any column heading, click the down arrow that
appears, and highlight Columns to display a list of available columns. Click the
check box for System Task to select the System Task column for inclusion in
the display.

ExecuteScript

“NorthStar Analytics Raw and Aggregated
Data Retention” on page 231

In the task list, sorting and column selection options become available when you hover

over a column heading and click the down arrow that appears. You can also rearrange

the columns that are displayed in the task list by clicking and dragging a columnheading.

Related
Documentation

Scheduling Device Collection for Analytics on page 250•

• Data Collection via SNMP on page 275

• Link Latency Collection on page 282

• Collection Tasks to Create Network Archives on page 295

• LDP Traffic Collection on page 287

• Netflow Collector on page 300

• Bandwidth Sizing on page 268

• NorthStar Analytics Raw and Aggregated Data Retention on page 231
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Scheduling Device Collection for Analytics

TheNorthStarControllerAnalytics features require that theControllerperiodically connect

to the network in order to obtain the configuration of network devices. It uses this

information to correlate IP addresses, interfaces, and devices.

Completion of device profiles (Administration > Device Profile) is a prerequisite for
successfully running device collection tasks.

NOTE: For topologies that include logical nodes, periodic device collection
is necessary because there are no real time PCEP-based updates for logical
devices.

To schedule a new device collection task, navigate to Administration > Task Scheduler.

1. ClickAdd in theupper right corner. TheCreateNewTaskwindow isdisplayedasshown
in Figure 171 on page 250.

Figure 171: Create New TaskWindow

2. Enter a name for the task and use the drop-downmenu to select the task type Device

Collection. ClickNext to display the first Create NewTask –Device Collectionwindow

as shown in Figure 172 on page 251.
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Figure 172: Device Collection Task, All Devices

On the Task Options tab, you can choose All devices, Selective devices, or Groups as

amethod for specifying the devices to be included in the collection task. For all three

of those choices, the following fields are available:

• Usemanagement IP (the default is yes).

• Parse collection (the default is yes).

Parsing reads the content of the files and updates the network model accordingly.

If parsing is not selected, the configuration files are collected on the server, but not

used in the model.

• Archive raw data (the default is yes). Raw data is archived in Elasticsearch.

If you select “Selectivedevices”, youarepresentedwitha list of all thedevicesavailable

to be included in the collection task. Figure 173 on page 252 shows an example.
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Figure 173: Device Collection Task, Selective Devices

Click the check boxes corresponding to the devices you want to include.

If you opt for Groups, you are presentedwith a list of the device groups that have been

configured in Administration > Device Profile, as shown in Figure 174 on page 253.
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Figure 174: Device Collection Task, Groups

Click the check boxes corresponding to the groups you want to include.

ClickNext to continue.

On the Collection Options tab, you can select the types of data to be collected or

processed as shown in Figure 175 on page 254.
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Figure 175: Device Collection Task, Collection Options

Click the appropriate check boxes to select or deselect options. You can also Select

All or Deselect All. By default, the first four options listed are collected.

NOTE: We recommend that you collect router configuration, tunnel path
and tunnel transit show commands when running the device collection
task so that NorthStar can update the tunnel status and details based on
the latest collection.

Equipment CLI data is collected in device collection tasks that include the Equipment

CLI option. The Process Equipment CLI option in Network Archive collection parses

the Equipment CLI data collected in device collection and generates the Inventory

Report available in both the NorthStar Controller and the NorthStar Planner.

To view Hardware Inventory in the NorthStar Planner, youmust run device collection

with the Equipment CLI collection option (collects the inventory data) and youmust

run Network Archive collection with the Process Equipment CLI option (processes

the inventory data).

Each of the options results in the collection task capturing the results of various show

commands. Table 55 on page 255 lists the show command output captured for each

option.
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Table 55: Show Command Output Captured by Device Collection Options

For IOS-XR DevicesFor Juniper DevicesData Type

show runningshow configuration | display inheritance brief | no-moreConfiguration

show running | include hostname

show interfaces

show ipv4 interface

show configuration system host-name | display inheritance
brief

show interfaces | no-more

Interface

show running | include hostname

showmpls traffic-eng tunnels detail role
head

show configuration system host-name | display inheritance
brief

showmpls lsp statistics ingress extensive logical-router all |
no-more

Tunnel Path

show running | include hostname

showmpls traffic-eng tunnels backup

show configuration system host-name | display inheritance
brief

show rsvp session ingress detail logical-router all | no-more

show rsvp session transit detail logical-router all | no-more

Transit Tunnel

show running | include hostname

show cdp neighbor detail

show configuration system host-name | display inheritance
brief

show l ldp neighbor | no-more

show virtual-chassis status | no-more

Switch CLI

show version

show diag

show env all admin

show inventory

show inventory raw

show configuration system host-name | display inheritance
brief

show version | no-more

show chassis hardware | no-more

show chassis fpc | no-more

show chassis hardware models | no-more

Equipment CLI

3. ClickNext to proceed to the scheduling parameters. The Create NewTask - Schedule

windowisdisplayedasshown inFigure 176onpage256.Youcanopt to runthecollection

only once, or to repeat it at configurable intervals. The default interval is 15 minutes.

255Copyright © 2019, Juniper Networks, Inc.

Chapter 10: Data Collection and Analytics



Figure 176: Device Collection Task, Scheduling

Instead of scheduling recurrence, you can select to chain the task after an

already-scheduled recurring task, so it launches as soon as the other task completes.

When you select the “Chain after another task” radio button, a drop-down list of

recurring tasks is displayed fromwhich to select.

4. Click Submit to complete the addition of the new collection task and add it to the

Task List. Click a completed task in the list to display the results in the lower portion

of the window. There are three tabs in the results window: Summary, Status, and

History. Figure 177 on page 257 shows an example of the Summary tab.

Figure 178 on page 257shows an example of the Status tab.
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Figure 177: Device Collection Results, Summary Tab

Figure 178: Device Collection Results, Status Tab

The device collection data is sent to the PCS server for routing and is reflected in the

Topology view. See “Viewing Analytics Data in theWeb UI” on page 258 for more

information.

Related
Documentation

Netconf Persistence on page 266•

• Viewing Analytics Data in theWeb UI on page 258
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Viewing Analytics Data in theWeb UI

There are views andwork flows in thewebUI that support visualization of collected data

so it can be interpreted and acted upon.

Data collectors must be installed and devices must be configured to push the data to

the data collectors. The health monitoring feature also uses information from the data

collectors.

Toview informationabout installeddatacollectors, navigate toAdministration>System
Health.

AnalyticsWidgets View

There are a number of widgets related to collected analytics data available when you

click the Analytics option in the top navigation bar. The network information table is

displayed alongwith the analyticswidgets. Some of thewidgets can display information

specific tooneormore tunnels youselect in the table. Figure 179onpage258showsa few

examples of the widgets that are available.

Figure 179: AnalyticsWidget Examples

Interface Utilization in Topology View

Interface Utilization is available as an option in the left pane of the topology view under

Options. When selected, the amount of traffic (RSVP and other traffic) that is going

though the network at the time is displayed in the topology, and is updated once every

minute.Thisallowsyou toseehowmuch traffic is going through thenetworkasa function

of time, as opposed to only being able to see reserved bandwidth.

NOTE: Interface Utilization, RSVP Live Utilization, and RSVP Utilization are
mutually exclusive. You can display only one of those three in the topology
at a time.
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In the Topology Settings menu bar on the right side of the window, click the Tools icon

and select the Link Label tab. You will see link label settings that pertain to interface

utilization, as shown inFigure 180onpage259.The topology thendisplays thepercentage

utilization of the links in the format percentage AZ::percentage ZA. Additional labels are

also available to display information that is collected through a Netconf collection task,

and is used by the analytics feature. Interface names, interface bandwidth values, and

shape bandwidth values are some examples.

Figure 180: Link Label Settings: Interface Util A::Z

Reaching the Traffic Chart from the Topology or the Network Information Table

You can right-click a link in the topology and select View Interface Traffic to see traffic
statistics over time for the link. In this chart, you can select to display one or both

interfaces, adjust the time range, and select theunits asbpsor%(of the linkbandwidth).
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You can also view LSP events on the right side of the chart. Double click an event to see

event details. A bell icon in the chart indicates that one or more events took place. Click

a bell to filter the list of events on the right to include only those that occurred at that

timestamp. Figure 181 on page 260 shows the traffic view chart.

Figure 181: Traffic View

NOTE: The events displayed are only those pertaining to the LSPs currently
routed through the link being viewed, as opposed to all events for all LSPs in
the network.

You can also reach this traffic-over-time view by right-clicking a link in the network

information table (Link tab) and selecting View Interface Traffic. To see LSP traffic over
time, click the Tunnel tab in the network information table. Right-click on an LSP and

selectViewLSPTraffic. Youcanchoosemultipleobjectsata time if youwant tocompare
them. The top portion of the chart shows traffic over time. The bottom portion shows

packets over time.

Also available by right-clicking a link in either the topology or the network information

table are the options to View Link Events and View Interface Delay.

Interface Delay in Topology View

In the Topology Settings menu bar on the right side of the window, click the Tools icon

and select the Link Label tab. You can opt to display live interface delay measurements

on the topology map byMeasured Delay A::Z. Select Performance in the left pane
drop-downmenu in Topology View, and select Interface Delay to display planned delay
data in the topology map.

NOTE: Interface delay information is only available if the devices have been
prepared:

• RPM probes have been configured.

• The rpm-log.slax script has been loaded, to send the results of the probes
to the data collectors.

NOTE: The NorthStar Controller does not automate the
installationof this scripton the router. Youmust install the script
manually.
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Graphical LSP Delay View

To view graphical LSP delay information for tunnels in the web UI, youmust enable the

functionality. The functionality is not enabled by default due to the possible impact on

performance. Enabling the functionality allows PCViewer to calculate LSP delay and

display the data in the web UI.

At anygiven time, theNorthStarController is awareof thepathsof all LSPs in thenetwork.

Periodically, the controller uses the reported link delays to compute the end-to-end LSP

delay as the simple sum of all link delays in the LSP path.

To enable the functionality:

1. Add the following statement to the /opt/northstar/data/northstar.cfg file:

pcs_lsp_latency_interval_sec=seconds

The seconds variable is the interval at which you want PCViewer to update the LSP

delay metric.

2. Restart PCViewer:

supervisorctl restart northstar_pcs:PCViewer

Once the functionality is enabled, you can right-click a tunnel in the network information

table in Topology view and select View Delay. The data is also available in the Tunnels

view. Figure 182 on page 261 shows the LSP delay view, using data for the Silver-102-104

LSP as an example.

Figure 182: Graphical LSP Delay View

Performance View

The Performance View shows you howutilization has changed over time. In the left pane

of the topology view, select Performance from the drop-downmenu. If you click the

Interface Utilization check box, for example, and thenmove the slide bar in the upper left

corner of the topologymap, you see the link colors change to reflect the utilization at the

time. Interface utilization is calculated using Layer 3 bandwidth (interface utilization =

Layer 3 traffic divided by Layer 3 bandwidth). This is different from RSVP bandwidth

which is initialized via BGP-LS and automatically adjusted. The two bandwidth values

(RSVP and Layer 3) can be the same, but in some networks, they are not.

Figure 183 on page 262 shows the location of the slide bar.
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Figure 183: Performance-Over-Time Slide Bar

Node IngressTraffic,NodeEgressTraffic, and InterfaceDelayarealsoavailable, in addition

to Interface Utilization. In the case of Node Ingress and Node Egress Traffic, the size of

the node on themap is proportional to the amount of traffic being handled by the node.

Ingress andegress traffic for a nodeare not always equal. Generally,most traffic is simply

forwarded by a router (as opposed to being generated or consumed), so it might seem

reasonable to expect that the sum of all ingress traffic would be roughly equal to the

sum of all egress traffic. But in practice, nodes can replicate traffic, as is commonly the

case for multicast traffic or unknown unicast traffic when doing L2 Ethernet forwarding.

In such cases, the total egress traffic can (and should) exceed the total ingress traffic.

For all four options (Node Ingress Traffic, Node Egress Traffic, Interface Delay, Interface

Utilization), the Settings button at the bottom of the left pane allows you to select how

farbackyouwant thedata toshow,withoptionsupto30daysback.Figure 184onpage262

shows these options.

Figure 184: Performance Settings
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Nodes View

Two columns of data in the Nodes View reflect a snapshot of traffic in bps and pps over

the last hour. This is for quick reference in case there are conditions that require attention.

You can see this snapshot for both Interfaces andTunnels. Figure 185 onpage 263 shows

these two columns.

Figure 185: Analytics in Nodes View

Interface Protocols Display

Datacollectionallows theNorthStarController togather informationabout theprotocols

that are configured on each interface. The Protocols column in the network information

table under the Interface tab displays OSPF, LDP, RSVP, and MPLS when configured. Be

sure you have selected this column to be included in the display.

Displaying Top Traffic

You can display the recent top traffic by navigating to Applications > Top Traffic as
shown in Figure 186 on page 264.
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Figure 186: Accessing Top Traffic

Top traffic is the computed top N traffic over X period of time by Node, Interface Traffic,

or Interface Delay. You can select N and X by clicking on the currently selected values in

the lower right corner of the display as shown in figx. In the resulting Top Traffic Settings

window, you can select the number of top elements you want to see, and the period of

time they cover. Figure 187 on page 265 shows Top Interface Traffic with the top 10

elements over the past hour displayed. Tomodify the settings in this example, youwould

click on Top 10, Past Hour at the bottom of the display, which would bring up the Top

Traffic Settings windowwhere you could make different setting selections.
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Figure 187: Top Traffic Example

You can select any or all of the top traffic options (Node, Interface Traffic, Interface

Delay) to be included in the display. Multiple selections appear as tabs that you can

toggle between. There is interactivity between the topology map and the top traffic

charts: youcanselect a line itemon thechart and itwill highlight the correspondingobject

on the topologymap. You can alsomouse over a line item on the chart to display details

about the object as shown in Figure 188 on page 266.
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Figure 188: Top TrafficWith Mouseover Information

Related
Documentation

Netconf Persistence on page 266•

• Left Pane Options on page 62

Netconf Persistence

Netconf Persistence allows you to create collection tasks to discover information from

device configurations (such as hostname and interface name), and from operational

commands (such as LSP on non-PCEP enabled devices). The Analytics features rely on

the results ofNetconf collection toassociate statisticswith thecorrect network elements.

As an alternative to provisioning LSPs (P2P or P2MP) using PCEP (the default), you can

also provision LSPs using Netconf.

Enabling Netconf Connections

BeforeusingNetconf features, youmust enable your systemtoallowNorthStarController

to modify the router configuration files via Netconf. Perform the following steps:

1. Ensure that port 830 is allowed by any external firewall being used. Port 830 enables

Netconf communication between the NorthStar Controller and other devices.

2. Populate the Device Profile (only the Admin user can perform this step). From the

More Options menu in the upper right corner of the NorthStar Controller web UI,

navigate to Administration > Device Profile. Figure 189 on page 267 shows the More
Options menu.
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Figure 189: More Options Menu

3. Highlight a device in the Device List and clickModify. The Modify Device(s) window
is displayed.

4. On the General tab, the following fields are required:

NOTE: If these fields are not populated, the Netconf connection will fail.

• Management IP: The IP address NorthStar Controller can use to establish Netconf

sessions.

• Vendor:Use thedrop-downmenu to select the vendor for thedevice (Juniper, Cisco,

and so on).

• Login and Password: Enter the credentials that allow the NorthStar Controller to

authenticate with the router.

5. Enable NorthStar Controller to use Netconf by clicking the check box beside Enable
Netconf in the Netconf section of the Access tab.

6. ClickModify at the bottom of the Modify Device(s) window.

7. ClickSaveChanges (which should be red to signal there are unsaved changes)which
should turn black once the save operation is complete.

8. In the Topology view, verify that the NorthStar Controller can establish a Netconf

session. On the Node tab in the network information table, look for the NETCONF

Status column. You can select that column for display if it is not already selected by

clicking the down arrow next to any column heading, and selecting Columns. The

Netconf status should be reported as Up.
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NOTE: In Junos OS Release 15.1F6 and later, you can enable the router to
sendP2MPLSP information to a controller (like theNorthStar Controller)
in real time, automatically. Without that configuration, youmust run live
network collection tasks for NorthStar to learn about newly provisioned
P2MP LSPs.

In the Junos OS, the configuration is done in the [set protocols pcep]
hierarchy for PCEs and for PCE groups:

set protocols pcep pce pce-id p2mp-lsp-report-capability
set protocols pcep pce pce-group p2mp-lsp-report-capability

Bandwidth Sizing

NorthStarController canbeconfigured toperiodically computeanewplannedbandwidth

for each bandwidth sizing-enabled LSP based on aggregated LSP traffic statistics.

NorthStar sendsnewplannedbandwidth information to theNorthStarPathComputation

Server (PCS) where the actual computation is done. The PCS determines, based on the

newbandwidth requirementsand theLSPbandwidthsizingparameters,whether it needs

to provision the new planned bandwidth or not.

NOTE: Only the bandwidth of PCE-initiated and PCC-delegated LSPs can
be sized this way. Although nothing will prevent you from applying sizing
attributes to PCC-controlled LSPs, no sizing will actually occur.

For bandwidth sizing to occur, youmust:

• Enable NorthStar analytics

NorthStar supports bandwidth sizing for all PCE-initiated and PCC-delegated LSPs

for which it can obtain LSP statistics, either via Juniper Telemetry Interface (JTI), or

SNMP collection (scheduled via the Task Scheduler). This means that youmust

enable/use NorthStar analytics, and confirm that NorthStar is receiving traffic from

the LSPs.

• Configure PCE-initiated and PCC-delegated LSPs so their bandwidth sizing attribute

is set to yes (bandwidth sizing enabled). LSPs without this setting are not sized.

• Create and schedule a bandwidth sizing task in the Task Scheduler, as described in

this section.

Bandwidth Sizing on the PCS Versus Auto-Bandwidth on the PCC

Bandwidthsizingcanbeconfusedwithauto-bandwidth.Table56onpage269summarizes

the differences.
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Table 56: Bandwidth Sizing Compared to Auto-Bandwidth

Bandwidth SizingAuto-Bandwidth

NorthStar (PCS) via web UI or REST APIRouter (PCC) via a templateWhere configured

PCE-initiated

PCC-delegated

PCE-initiated

PCC-delegated

PCC-controlled

Supported LSP types

Vendor-agnosticJuniper devicesSupported vendor types

One centralized schedule applies to all
bandwidth sizing-enabled LSPs

Per-LSPAdjustment period

Done by NorthStar (PCS)Done by the router (PCC)Bandwidth computations and
bandwidth change decisions

Average

Max

X Percentile (80, 90, 95, 99)

AverageAggregation statistics options

Auto-bandwidth overwrites bandwidth sizing and vice versa.

For this reason, you should not have auto-bandwidth enabled for bandwidth sizing-enabled
LSPs.

NOTE: For PCE-initiated LSPs, this means youmust ensure that the name of the LSP does
not match any configured label-switched path template that includes the auto-bandwidth
parameter.

For PCC-delegated LSPs, this means youmust ensure that the auto-bandwidth parameter
is not configured on the router.

Behavior if both are configured

Yes (to acquire LSP traffic statistics)NoRequires NorthStar Analytics?

Bandwidth Sizing-Enabled LSPs

Only bandwidth sizing-enabled LSPs are included in the re-computation of newplanned

bandwidths.WhenyouaddormodifyanLSP, youmust set theBandwidthSizing (yes/no)

setting to yes to enable sizing. At the same time, you also set values for the following
parameters:

• Adjustment threshold (%)

This setting controls the sensitivity of the automatic bandwidth adjustment. The new

planned bandwidth is only considered if it differs from the existing bandwidth by the

value of this setting or more.

• Minimum planned bandwidth

• Maximum planned bandwidth
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Theminimum andmaximum planned bandwidth values act as boundaries:

• If thenewplannedbandwidth is greater than themaximumsetting,NorthStar signals

the LSP with the maximum bandwidth.

• If the new planned bandwidth is less than theminimum setting, NorthStar signals

the LSP with the minimum bandwidth.

• If thenewplannedbandwidth falls in between themaximumandminimumsettings,

NorthStar signals the LSP with the new planned bandwidth.

NOTE: These parameters are also described in the context of the Provision
LSPwindow.

Adding a Bandwidth Sizing Task

The bandwidth sizing task periodically sends a new planned bandwidth for bandwidth

sizing-enabled LSPs to the NorthStar PCS. The PCS determines whether it needs to

provision the new planned bandwidth with a path that satisfies the new bandwidth

requirement.
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To schedule a bandwidth sizing task, navigate toAdministration > Task Scheduler from
the More Options menu.

1. ClickAdd in theupper right corner. TheCreateNewTaskwindow isdisplayedasshown
in Figure 190 on page 271.

Figure 190: Create New TaskWindow

Enter a name for the task, select Bandwidth Sizing from the drop-downmenu, and

clickNext.

2. Select an aggregation statistics option from the drop-downmenu as shown in

Figure 191 on page 272.
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Figure 191: Bandwidth Sizing Task, Step 2

The aggregation statistic works together with the task execution recurrence interval

(the period of bandwidth adjustment) that you set up in the scheduling window.

NorthStar aggregates theLSP traffic for the interval basedon theaggregation statistic

you select, and uses that information to calculate the new planned bandwidth. The

options in the Aggregation Statistic drop-downmenu are described in
Table 57 on page 272.

Table 57: Bandwidth Sizing Aggregation Statistics Options

DescriptionAggregation Statistic

Aggregation is based on the selected percentile.80th, 90th, 95th, 99th Percentile

For each interval, the sampleswithin that interval are averaged. If there areN samples
for a particular interval, the result is the sum of all the sample values divided by N.

Average

For each interval, the maximum of the sample values within that interval is used.Max

3. ClickNext to proceed to the scheduling parameters. The Create NewTask - Schedule

window is displayed as shown in Figure 192 on page 273. Youmust schedule the task

to repeat at a specific interval from aminimum of 15 minutes to amaximum of one

day. The default interval is one hour.

NOTE: There is no per-LSP interval. The interval configured here applies
to all LSPs for which bandwidth sizing is enabled.
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Figure 192: Bandwidth Sizing Task, Scheduling

4. Click Submit to complete the addition of the new collection task and add it to the

Task List. Click a completed task in the list to display the results in the lower portion

of the window. There are three tabs in the results window: Summary, Status, and

History.

NOTE: You can have only one bandwidth sizing task per NorthStar server.
If you attempt to add a second, the systemwill prompt you to approve
overwriting the first one.

Viewing LSP Statistics and Bandwidth

In the network information table (Tunnel tab), you can add optional columns related to

bandwidth sizing by hovering over any column heading and clicking the down arrow that

appears. SelectColumns and click the check boxes to add columns for bandwidth sizing
parameters as shown in Figure 193 on page 274.
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Figure 193: Bandwidth Sizing Columns

Once added, these columns display in the network information table the values of the

parameters you configured for the bandwidth sizing-enabled LSPs.

You can view an LSP’s statistics and bandwidth in graphical form by right-clicking an

LSP on the Tunnel tab of the network information table and selecting View LSP Traffic.
An example of the display is shown in Figure 194 on page 274.

Figure 194: Viewing LSP Traffic and Bandwidth

This example shows theactual LSP traffic (blue line) aswell as the signaled (configured)

bandwidth (green line). The hide bandwidth/show bandwidth button allows you to
toggle back and forth between including and not including the bandwidth in the display.

Logs related to bandwidth sizing are stored in /opt/northstar/logs and include:

• bandwidth_sizing.log

• pcs.log
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Using Bandwidth Sizing Together with Zero BandwidthMode

In Administration > SystemSettings, there is an option to enable zero bandwidth
signaling.Bydefault, this functionality isdisabled.Whenenabled,NorthStar canoptimize

resource utilization more effectively andmore aggressively. This is true, with or without

bandwidth sizing, and it affects all PCE-initiated and PCC-delegated LSPs, regardless

of whether they are bandwidth sizing-enabled or not.

When zero bandwidth signaling is enabled and NorthStar is receiving traffic statistics for

bandwidthsizing-enabledLSPs,NorthStardoes the followingat theendof thebandwidth

adjustment period:

• Computes the new planned bandwidth.

• Computes a new path that satisfies the new planned bandwidth.

• Updates the RSVP link utilization based on the new planned bandwidth and the new

path.

• Provisions the new pathwith zero bandwidth as opposed to provisioningwith the new

planned bandwidth.

Data Collection via SNMP

Datacollection viaSNMP isauseful alternative for collectingnetwork statistics in systems

where Juniper Telemetry Interface (JTI) is not available or in multi-vendor systems. Data

collection via SNMP enables the following performancemanagement features:

• Collection of interface statistics using SNMP collection tasks that poll the SNMPMIB

(Juniper Networks and Cisco devices).

• CollectionofLSPstatisticsusingSNMPcollection tasks thatpoll theSNMPMIB(Juniper

Networks and Cisco devices).

Cisco LSP statistics can also be collected by polling the interfaceMIB because in Cisco

devices, an LSP tunnel is a special interface entry.

• Collection of P2MP LSP statistics by polling the Juniper LSPMIB for Juniper Networks

devices, or by polling the standard IFMIB for Cisco devices. Even older Juniper devices

are supported.

• Collection of class of service (CoS) statistics. To collect this data for Juniper Networks

devices, the SNMP collector polls the JUNIPER-COS-MIB.

• The specific OIDs that are collected in SNMP collection tasks are described in tables

Table 58 on page 275, Table 59 on page 276, and Table 60 on page 276.

Table 58: OIDs for Interface and LSP Statistics

Vendor TypeCounterOID Name

GenericifName1.3.6.1.2.1.31.1.1.1.1

GenericifHCOutOctets1.3.6.1.2.1.31.1.1.1.10
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Table 58: OIDs for Interface and LSP Statistics (continued)

Vendor TypeCounterOID Name

GenericifHCOutBroadcastPkts1.3.6.1.2.1.31.1.1.1.13

GenericifHCInOctet1.3.6.1.2.1.31.1.1.1.6

GenericifHCInBroadcastPkts1.3.6.1.2.1.31.1.1.1.9

JunipermplsLspInfoName1.3.6.1.4.1.2636.3.2.5.1.1

JunipermplsLspInfoOctets1.3.6.1.4.1.2636.3.2.5.1.3

Table 59: OIDs for CoS Statistics - Juniper Devices

CounterOID Name

jnxCosQstatQedBytes1.3.6.1.4.1.2636.3.15.4.1.5

jnxCosQstatTxedBytes1.3.6.1.4.1.2636.3.15.4.1.9

jnxCosQstatTotalRedDropBytes1.3.6.1.4.1.2636.3.15.4.1.23

jnxCosIngressQstatQedBytes1.3.6.1.4.1.2636.3.15.7.1.5

jnxCosIngressQstatTxedBytes1.3.6.1.4.1.2636.3.15.7.1.9

jnxCosIngressQstatTotalRedDropBytes1.3.6.1.4.1.2636.3.15.7.1.23

Table 60: OIDs for CoS Statistics - Cisco Devices

TableOID Name

CISCO-CLASS-BASED-QOS-MIB::cbQosServicePolicyTable1.3.6.1.4.1.9.9.166.1.1.1

CISCO-CLASS-BASED-QOS-MIB::cbQosPolicyMapCfgTable1.3.6.1.4.1.9.9.166.1.6.1

CISCO-CLASS-BASED-QOS-MIB::cbQosObjectsTable1.3.6.1.4.1.9.9.166.1.5.1

CISCO-CLASS-BASED-QOS-MIB::cbQosCMCfgTable1.3.6.1.4.1.9.9.166.1.7.1

CISCO-CLASS-BASED-QOS-MIB::
cbQosClassMapStats.cbQosCMPostPolicyByte64

1.3.6.1.4.1.9.9.166.1.15.1.1.10

CISCO-CLASS-BASED-QOS-MIB::cbQosClassMapStats.cbQosCMDropByte641.3.6.1.4.1.9.9.166.1.15.1.1.17
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The process involves the following tasks:

• Installation of Collectors on page 277

• Configure Devices in Device Profile and Test Connectivity on page 277

• Run Device Collection on page 277

• Schedule and Run SNMP Data Collection Tasks on page 277

• Access the Data from the NorthStar Planner on page 282

Installation of Collectors

The collectors are installed in the samemachine as the NorthStar Controller application

server (single-server deployment) by the install.sh script when you install the controller

itself. Once installed, you can see the collector group of processes:

[root@pcs-q-pod05 ~]# supervisorctl status

analytics:elasticsearch          RUNNING   pid 3374, uptime 6:33:42
analytics:esauthproxy            RUNNING   pid 3373, uptime 6:33:42
analytics:logstash               RUNNING   pid 5600, uptime 6:31:15
collector:es_publisher           RUNNING   pid 12899, uptime 0:37:03
collector:task_scheduler         RUNNING   pid 12900, uptime 0:37:03
collector:worker1                RUNNING   pid 3385, uptime 6:33:42
collector:worker2                RUNNING   pid 3387, uptime 6:33:42
collector:worker3                RUNNING   pid 3386, uptime 6:33:42
collector:worker4                RUNNING   pid 3388, uptime 6:33:42

Configure Devices in Device Profile and Test Connectivity

Before you can run SNMP collection, youmust configure login credentials and SNMP

parameters for the devices. In the web UI, from the More Options menu, navigate to

Administration > Device Profile. Select a device and clickModify. Click the Access
Parameters tab to enter login credentials and theSNMPParameters tab to enter SNMP
parameters.

SeeDevice Profile and Connectivity Testing for detailed instructions on setting up devices

with SNMP parameters, and also on testing SNMP connectivity to those devices.

Run Device Collection

Youmust run device collection before attempting to run SNMP traffic collection. This is

necessary to establish the baseline network information including the interfaces and

LSPs. Once device collection has been run, SNMP traffic collection tasks have the

information they need to poll the interfaces and the LSPs.

See Scheduling Device Collection for Analytics via Netconf.

Schedule and Run SNMPData Collection Tasks

NOTE: Completion of device profiles (Administration >Device Profile) and
running device collection are prerequisites for successfully running SNMP
collection.
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To schedule a new SNMP collection task, navigate to Administration > Task Scheduler
from the More Options menu.

1. ClickAdd in theupper right corner. TheCreateNewTaskwindow isdisplayedasshown
in Figure 171 on page 250.

Figure 195: Create New TaskWindow

2. Enter a name for the task and use the drop-downmenu to select the task type as

SNMP Traffic Collection. ClickNext.

The next window displayed offers you the opportunity to collect SNMP traffic for all

devices, select devices, or groups. Figure 196 on page 279 shows this window.
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Figure 196: SNMP Collection Task, Device Collection

3. ClickNext to proceed to the scheduling parameters. The Create NewTask - Schedule

window is displayed as shown in Figure 197 on page 280. At least two collections are

necessary for the calculation of statistics. We recommend setting up automatic

recurrence of the task every 10 to 20minutes.
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Figure 197: SNMP Collection Task, Scheduling

Instead of scheduling recurrence, you can select to chain the task after an

already-scheduled recurring task, so it launches as soon as the other task completes.

When you select the “Chain after another task” radio button, a drop-down list of

recurring tasks is displayed fromwhich to select.

4. Click Submit to complete the addition of the new collection task and add it to the

Task List. Click a completed task in the list to display the results in the lower portion

of the window. There are three tabs in the results window: Summary, Status, and

History.Anexampleof theSummary tab is shown inFigure 198onpage281.Anexample

of the Status tab is shown in Figure 199 on page 281.
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Figure 198: Collection Results for SNMP Traffic Collection Task, Summary Tab

Figure 199: Collection Results for SNMP Traffic Task, Status Tab

NOTE: You can have only one SNMP traffic collection task per NorthStar
server. If you attempt to add a second, the systemwill prompt you to
approve overwriting the first one.

By default, NorthStar only collects statistics from the following interfaces when running

SNMP traffic collection:

• Physical, logical loopback, or logical management interfaces that can be associated

with nodes in NorthStar
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• Logical interfaces associated with links in NorthStar

• Logical interfaces belonging to a VRF

The interface types that can be discovered on devices and that should be used by traffic

collection can bemodified by editing the /opt/northstar/data/northstar.cfg file. Use a

text editing tool such as vi, and use a comma as a separator. For example:

configServer_include_interfaceType=physical, loopbackMgmt, vrfInterface, 
linksInterface 

The supported interface types are:

• physical: Physical interfaces, expressed as the interface namewithout a dot (.) in it.

• loopbackMgmt: Loopback andmanagement interfaces expressed as the interface

name starting with lo, fxp, me, or em.

• vrfIf: Interfaces with which a VRF is associated.

• linksIf: Interfaces on links.

• all: All interfaces

These supported interface types are also commented in the northstar.cfg file.

Access the Data from the NorthStar Planner

Youcanaccess thecollecteddata fromtheNorthStarPlanner for planningandsimulation

purposes. In the NorthStar Planner, navigate to Traffic > Traffic aggregation. You can
aggregate the traffic by hour and create a 24-hour traffic load file for each hour,

aggregating the data for that particular hour across multiple days. The resulting file can

be used as input into the traffic matrix solver.

Related
Documentation

Device Profile and Connectivity Testing•

• Scheduling Device Collection for Analytics via Netconf

Link Latency Collection

You can collect link delay statistics using Link Latency collection tasks that use a ping

operation (Juniper Networks and Cisco devices).

When a link latency collection task is run, the collector issues a ping from one device to

the endZ address of all links to gather round trip time (RTT) statistics. The RTT is the

amount of time in milliseconds fromwhen the ping packet is sent to the time a reply is

received. Theminimum, maximum, and average RTT is calculated based onmultiple

pings.

Youmust run device collection before attempting to run link latency collection. This is

necessary to establish the baseline network information including the interfaces and

LSPs. Once device collection has been run, link latency collection tasks have the

information they need.
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To schedule a new link latency collection task, navigate to Administration > Task
Scheduler from the More Options menu.

1. ClickAdd in theupper right corner. TheCreateNewTaskwindow isdisplayedasshown
in Figure 200 on page 283.

Figure 200: Create New TaskWindow

2. Enter a name for the task and use the drop-downmenu to select the task type as Link

Latency. ClickNext.

In the next window, enter the number of times you would like the ping operation to

repeat.Figure 201 on page 284 shows this window.
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Figure 201: Device Collection Task, Step 2 for Link Latency Collection

3. ClickNext to proceed to the scheduling parameters. The Create NewTask - Schedule

window is displayed as shown in Figure 192 on page 273. You can opt to run the

collection only once, or to repeat it at configurable intervals. The default interval is 15

minutes.
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Figure 202: Link Latency Collection Task, Scheduling

Instead of scheduling recurrence, you can select to chain the task after an

already-scheduled recurring task, so it launches as soon as the other task completes.

When you select the “Chain after another task” radio button, a drop-down list of

recurring tasks is displayed fromwhich to select.

4. Click Submit to complete the addition of the new collection task and add it to the

Task List. Click a completed task in the list to display the results in the lower portion

of the window. There are three tabs in the results window: Summary, Status, and

History.Anexampleof theSummarytab isshown inFigure203onpage286.Anexample

of the Status tab is shown in Figure 204 on page 286.
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Figure 203: Collection Results for Link Latency Collection Task, Summary Tab

Figure 204: Collection Results for Link Latency Task, Status Tab

NOTE: You can have only one link latency traffic collection task per
NorthStar server. If you attempt to add a second, the systemwill prompt
you to approve overwriting the first one.
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LDP Traffic Collection

LDP traffic statistics track the volume of traffic passing through forwarding equivalence

classes. In addition to monitoring the LDP traffic statistics in the NorthStar Controller,

thedatacanalsobe imported into theNorthStarPlanner for capacity planningand failure

simulation studies.

NOTE: Youmust run device collection before attempting to run LDP traffic
collectionsoNorthStar (Toposerver)candiscoverLDP-enabled links.Learning
which links are LDP-enabled allows NorthStar to compute LDP equal cost
paths between sources and destinations.

NOTE: Currently, the LDP traffic collection task only supports Juniper
Networks Junos OS devices. Even if you specify other devices in the task
setup, this task will only run against Junos OS devices.

The device collection task extracts LDP-enabled interfaces from the Junos OS

configuration at the [protocols ldp] and [protocols mpls] hierarchy levels. ConfigServer

correlates these interfaces with the links discovered by Toposerver.

To schedule a new LDP traffic collection task, navigate to Administration > Task
Scheduler from the More Options menu.
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1. Enter a name for the task and use the drop-downmenu to select the task type LDP
Traffic Collection. ClickNext to display the first Create New Task – LDP Traffic

Collection window as shown in Figure 205 on page 288.

Figure 205: LDP Traffic Collection Task, All Devices

Under Select Device(s) to be collected, you can choose All devices, Selective devices,

or Groups as amethod for specifying the devices to be included in the collection task.

For all three of those choices, you can select to use ECMP (the default is yes, with a

value of 6).

If you select “Selectivedevices”, youarepresentedwitha list of all thedevicesavailable

to be included in the collection task. Figure 206 on page 288 shows an example.

Figure 206: LDP Traffic Collection Task, Selective Devices
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Click the check boxes corresponding to the devices you want to include.

If you opt for Groups, you are presentedwith a list of the device groups that have been

configured in Administration > Device Profile, as shown in Figure 207 on page 290.
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Figure 207: LDP Traffic Collection Task, Groups

Click the check boxes corresponding to the groups you want to include.

2. ClickNext to proceed to the scheduling parameters. The Create NewTask - Schedule

window is displayed as shown in Figure 208 on page 291. At least two collections are

necessary for the calculation of demand statistics. We recommend setting up

automatic recurrence of the task every 10 to 20minutes.
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Figure 208: LDP Traffic Collection Task, Scheduling

The option to chain the task after an already-scheduled recurring task is available,

but we do not recommend it for LDP collection. LDP collection is better handled as a

recurring, independent task.

3. Click Submit to complete the addition of the new collection task and add it to the

Task List. The LDP traffic collection task executes show ldp traffic-statistics at

configured intervals for the selected devices. Elasticsearch stores and indexes the

collected the data for further query.

Click a completed task in the list task list to display the results in the lower portion of

thewindow. There are three tabs in the resultswindow:Summary, Status, andHistory.

An example of the Summary tab is shown in Figure 209 on page 292. An example of

the Status tab is shown in Figure 210 on page 292.
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Figure 209: Example Collection Results for LDP Traffic Collection Task, Summary Tab

Figure 210: Example Collection Results for LDP Traffic Collection Task, Status Tab

NOTE: You can have only one LDP traffic collection task per NorthStar
server. If you attempt to add a second, the systemwill prompt you to
approve overwriting the first one.

4. Once the traffic collection task has completed, view the collecteddata in theDemand

tab of the network information table. The Node, Link, and Tunnel tabs are always
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displayed. The other tabs are optionally displayed. Click the plus sign (+) in the tabs

heading bar to add a tab as shown in Figure 211 on page 293.

Figure 211: Adding a Tab to the Network Information Table

The Demand tab lists the LDP Forwarding Equivalent Class (FEC) data, including

Node A, Node Z, IP A, IP Z, and Bandwidth. NorthStar creates the FEC names using

the source name and the destination IP address. Figure 212 on page 293 shows an

example of the Demand tab.

Figure 212: Network Information Table, Demand Tab

5. To view LDP-enabled links in the topologymap, navigate toProtocols in the left pane
and check LDP as shown in Figure 213 on page 294.
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Figure 213: Network Information Table, Demand Tab
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Collection Tasks to Create Network Archives

In the Task Scheduler window, you can launch a collection tasks that creates a network

model in a database, for use in theNorthStar Planner. You also have the option to archive

the network model.

Tunnel design attributes that are configured in the web UI are inherited by the NorthStar

Planner, even though they are never pushed to the router.When you runNetwork Archive

device collection, the tunnel information in the Planner (which came from the router) is

merged with the tunnel information in the Controller (which includes design attributes

that are not pushed to the router). Themerged version is then available in the Planner.

The following design attributes that are configured in the Advanced, Design, and

Scheduling tabs of the Provision LSP window in the web UI are inherited by the Planner

via network archive collection:

• Advanced tab: Symmetric Pair Group, Diversity Group, Diversity Level

• Design tab: Routing Method, Max Delay, Max Hop, Max Cost

• Scheduling tab: all scheduling information

To schedule a new collection task, navigate to Administration > Task Scheduler.

1. ClickAdd in theupper right corner. TheCreateNewTaskwindow isdisplayedasshown
in Figure 171 on page 250.

Figure 214: Create New TaskWindow
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2. Enteranamefor the taskanduse thedrop-downmenu toselect the task typeNetwork
Archive. ClickNext to display the first Create New Task – Network Archive window

as shown in Figure 215 on page 296.

Figure 215: Create New Task–Network Archive

Click the check boxes beside the options in this window to select or deselect them:

• Process Equipment CLI

Equipment CLI data is collected in Netconf collection tasks that include the

Equipment CLI option. The Process Equipment CLI option in Network Archive

collection parses the Equipment CLI data collected in Netconf collection and

generates the Inventory Report available in both the NorthStar Controller and the

NorthStar Planner.

To view Hardware Inventory in the NorthStar Planner, youmust run Netconf

collection with the Equipment CLI collection option (collects the inventory data)

andyoumust runNetworkArchive collectionwith theProcessEquipmentCLI option

(processes the inventory data).
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• Archive network data after processing

This option makes the createdmodel available in the NorthStar Planner under the

Archives tab in the Network Browser window. Otherwise, the result of the Network

Archive collection task is reflected in thenewspec file for theLatestNetworkArchive

in the NorthStar Planner, but it is overwritten by the next Latest Network Archive.

• Include LDP traffic

This option loads the aggregated results of LDP traffic collection into the network

model created by the Network Archive task. The LDP traffic is loaded as demand

with 24 periods of statistics. You can choose up to 60 days’ worth of LDP traffic to

be aggregated, using the specified aggregation statistic, into 24 data points that

represent hours of the day. The options in the Aggregation Statistic drop-down
menu are described in Table 61 on page 297.

NOTE: This option is only applicable if you have scheduled LDP traffic
collection.

Table 61: Aggregation Statistics Options

DescriptionAggregation Statistic

For each of the 24 hours, the maximum of the sample values within that hour is used.Max

For each of the 24 hours, the samples within that hour are averaged. If there are N samples
for a particular hour, the result is the sum of the all the sample values divided by N.

Average

For each of the 24 hours, the X percentile value of the sampleswithin that hour is used. The
X percentile is computed from an equation that takes into consideration the average for
the hour and the standard deviation. The result is that X percent of the sample values lie
at or below the calculated value.

80th, 90th, 95th, 99thPercentile
(X percentile)

Selecting the Include LDP Traffic data option is required for full utilization and

manipulation of traffic load data in the Network Planner.

3. ClickNext to proceed to the scheduling parameters. The Create NewTask - Schedule

windowisdisplayedasshown inFigure 176onpage256.Youcanopt to runthecollection

only once, or to repeat it at configurable intervals. The default interval is 15 minutes.
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Figure 216: Device Collection Task, Scheduling

Instead of scheduling recurrence, you can select to chain the task after an

already-scheduled recurring task, so it launches as soon as the other task completes.

When you select the “Chain after another task” radio button, a drop-down list of

recurring tasks is displayed fromwhich to select.

4. Click Submit to complete the addition of the new collection task and add it to the

Task List. Click a completed task in the list to display the results in the lower portion

of the window. There are three tabs in the results window: Summary, Status, and

History. Figure 217 on page 299 shows an example of the Status tab for a complete

Network Archive collection task.
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Figure 217: Network Archive Collection Results, Status Tab

5. Access the archives in the NorthStar Planner.

The network archive files are stored in the Cassandra database and can be accessed

from there through theNorthStar Planner. SeeNetwork BrowserWindow andNetwork

Browser Recently Opened and Archived Networks in the NorthStar Planner User Guide.

Related
Documentation

Scheduling Device Collection for Analytics on page 250•
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Netflow Collector

Netflow Collector is a network planning and reporting tool in NorthStar Controller. It

provides a way to gather and generate reports on detailed network traffic information.

NorthStar leverages the Junos OS implementation of flowmonitoring and aggregation

using Netflow Version 9 and Version 10 (IPFIX) flow templates. See the following Junos

OS documentation for background:

• Configuring Flow Aggregation to Use Version 9 Flow Templates

• Configuring Flow Aggregation to Use IPFIX Flow Templates on MX, vMX and T Series

Routers, EX Series Switches and NFX250

• Configuring Flow Aggregation to Use IPFIX Flow Templates on PTX Series Routers

The JunosOSon the routers samples the traffic, builds a flow table, and sends thedetails

of the flow table to NorthStar periodically.

NorthStar (Netflow daemon), receives the data from the routers, decodes the records,

performs additional aggregation of the data and creates the demands, stores the data

in the NorthStar database, and shares the information with the PCS. The data is then

available for report creation in the NorthStar Controller and for report creation, planning,

andmodeling in the NorthStar Planner.

NorthStar monitors AS and VPN traffic, and supports both IPv4 and IPv6.

NorthStar Netflow Collector requires:

• Configuration on the routers in the network.

• Initial and periodic device collection to create andmaintain an accurate VPNmodel

in NorthStar. We recommend you execute device collection at least daily.

You can optionally customize Netflow Collector settings in the

/opt/northstar/data/northstar/cfg file on the NorthStar application server.

The following sections describe using Netflow Collector in the NorthStar Controller:

• Configuration for Netflow Collector on page 300

• Viewing Demands in theWeb UI on page 305

• Demand Reports Collection on page 307

Configuration for Netflow Collector

Configuration on the Network Routers

Netflow Collector on the NorthStar Controller requires that the network routers be

configured for flowmonitoring (Netflow v9 or v10) according to the router operating

system documentation.
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NOTE: At present, Juniper devices and Cisco IOS-XR devices are supported,
with both Netflow v9 and v10.

Some important considerations:

• The source address (inline-jflow statement) identifies to the netflow daemon

(netflowd) the device that is reporting the flow. It should be configured as the router’s

loopback address.

• The flow-active-timeout value has a default of 60 seconds. We recommend keeping

it at 60 seconds or less.

This is a Junos OS example showing Netflow v9 configuration statements:

At the interfaces
hierarchy level:

interfaces {
   ge-0/0/1  {
        unit 0 {
            family inet {
                sampling {
                    input;
                }
                address 10.0.21.1/24;
            }
        }
    }
}

At the
forwarding-options

hierarchy level:

forwarding-options {
  sampling {
      nfv9-ipv4 {
          input {
              rate 1;
              run-length 0;
          }
          family inet {
              output {
                  flow-inactive-timeout 15;
                  flow-active-timeout 60;
                  flow-server 172.16.18.1 {
                      port 9000;
                      version9 {
                          template {
                              nfv9-ipv4;
                          }
                       }
                   }
                   inline-jflow {
                       source-address 10.1.0.104;
                   }
              }                 
          }               
      }             
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At the chassis
hierarchy level:

chassis {
    network-services enhanced-ip;
    fpc 0 {
        sampling-instance nfv9-ipv4;
    }
}     

At the services
hierarchy level:

services {
    flow-monitoring {
       version9 {
           template nfv9-ipv4 {
               nexthop-learning enable;  
               template-refresh-rate seconds 60;  
               option-refresh-rate seconds 60;  
               ipv4-template;
           }                   
       }                   
    }                      
}         

This is a Junos OS example showing Netflow v10 configuration statements:

At the interfaces
hierarchy level:

interfaces {
   ge-0/0/1  {
        unit 0 {
            family inet {
                sampling {
                    input;
                }
                address 10.0.21.1/24;
            }
        }
    }
}

At the
forwarding-options

hierarchy level:

forwarding-options {
  sampling {
      instance {
        nfv10-ipv4 {
            input {
                rate 1;
                run-length 0;
            }
            family inet {
                output {
                    flow-inactive-timeout 15;
                    flow-active-timeout 60;
                    flow-server 172.16.18.1 {
                        port 9000;
                        version-ipfix {
                            template {
                                nfv10-ipv4;
                            }
                        }
                    }
                    inline-jflow {
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                        source-address 10.1.0.104;
                    }
                }                 
            }               
        }        
      }         
  }                             
}                 

At the chassis
hierarchy level:

chassis {
    network-services enhanced-ip;
    fpc 0 {
        sampling-instance nfv10-ipv4;
    }
} 

At the chassis
hierarchy level:

services {
    flow-monitoring {
       version-ipfix {
           template nfv10-ipv4 {
               nexthop-learning {
                   enable;  
               }
               template-refresh-rate {
                   seconds 60;  
               }
               option-refresh-rate {
                   seconds 60; 
               } 
               ipv4-template;
           }                   
       }                   
    }                      
}    

Configuration on the NorthStar Application Server

Netflow Collector is installed as part of the Analytics package with NorthStar Controller.

See Installing Data Collectors for Analytics in the NorthStar Controller Getting Started

Guide.

Sampling is configured on the ingress interface. Flows enter the ingress PE which sends

netflow records tonetflowd.Thenetflow records include the information thatdetermines

the flow’s destination, or “prefix”.

On the NorthStar server where you installed the NorthStar analytics package, there are

some settings in the /opt/northstar/data/northstar.cfg file that can be customized for

Netflow, all of which begin with “netflow_”, as described in Table 62 on page 304.
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NOTE: SeePlatformandSoftwareCompatibility for informationonsupported
deployment configurations. The analytics packagemight or might not be
installedon the sameserver as theNorthStar application, dependingon your
deployment configuration.

Table 62: northstar.cfg Netflow Parameters

NotesSetting

The IP address of the server on which the NorthStar analytics package was installed (which
might or might not be the same server on which the NorthStar application was installed).

netflow_collector_address

Default Netflow port is 9000.netflow_port

SSL disabled (default) = 0

SSL enabled = 1

netflow_ssl

The level of information that is captured in the log file at /opt/northstar/logs/netflowd.msg.
The default level is “info”. If more information is required, you can set the level to “debug”, and
the log will include all the flows received from each device, identified by source IP address. You
can also see, for each flow, all the fields that netflowd processes and parses.

netflow_log_level

The default SAMPLING-INTERVAL, if the router does not provide the SAMPLING-INTERVAL in
the Template FlowSet.

NOTE: If you are using Netflow v10 (IPFIX) in the network, youmust manually configure
netflow_sampling_interval in/opt/northstar/data/northstar.cfg. NorthStardoesnot support
automatic extraction of the IPFIX sampling interval.

netflow_sampling_interval

Publishing interval to both Elasticsearch and the PCS. Traffic is aggregated per publishing
interval. The default interval is 60 seconds. This value must be equal to or greater than the
reporting time configured in the router (flow-active-timeout value) to ensure that for every
publishing interval, all active flows are reported.

netflow_publish_interval

SeeSlave Collector Installation for DistributedData Collection in theNorthStar Controller Getting
Started Guide for more information about workers.

netflow_workers

Enabled = 1, Disabled = 0

If enabled, netflowd sends one final update after a flow is no longer active, reporting the
bandwidth as 0. If disabled, the bandwidth value is not reported once a flow has become
inactive, so the last reported active value is the last value displayed.

netflow_ageout

Enabled = 1, Disabled = 0

If enabled, aggregates all traffic from a specific ingress PE router to a specific destination
(prefix) within the defined period of time.

netflow_aggregate_by_prefix

Interval at which statistics are printed to the log file. The default is -1 (never).netflow_stats_interval
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NOTE: If youmake changes to these settings, youmust restart the netflowd
process for the changes to take effect.

Viewing Demands in theWeb UI

The Demand tab in the network information table shows aggregated demands based

on the flowmonitoring of the Netflow Collector. Four aggregation keys are used:

• Ingress PE (device reporting the flow)

• BGP next hop IP address

• VPN (VRF) name (“NONE” if there is no VPN associated with the demand)

• Specification of IPv4 (shown as IP) or IPv6

Thevaluesof the keysare reflected in thenamesof thedemands in the table, for example,

vmx102_10.1.0.10/32_vpn100_IP. Selecting a demand in the table highlights the

corresponding routing path in the topology map.

NOTE: Currently, theability topreviewthepathonthe topologymap is limited
to RSVP-based LSPs (not segment routing). A future release will enhance
this feature.

From the network information table, you can delete demands, but you cannot add or

modify them. Demands are never automatically deleted.

To view demand data in the network information table:

1. The Demand tab is not displayed by default. Click the plus (+) sign in the network

information table header and select Demand from the drop-downmenu as shown

in Figure 218 on page 305.

Figure 218: Adding the Demand Tab to the Network Information Table

Figure 212 on page 293 shows an example of the Demand tab data.
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Figure 219: Network Information Table, Demand Tab

For eachdemand, theDemand tab lists thedemandproperties.Whether thedemand

is associated with a VPN or not is shown in the Owner field. If there is no VPN

associatedwith thedemand, theOwner field isblank.TheMostRecentUpdatecolumn

is updated at every publishing interval. If it is not updated, the flow is no longer active.

2. Right-click a demand in the table and selectViewDemand Traffic. This opens a new
tab in the network information table, displaying a chartwith demand traffic over time.

You can adjust the time period in the upper left corner of the chart display, to show

the past hour, day, seven days, or a custom time period.

3. The Service tab in the network information table displays information about VPNs in

the networkwhichmight be associatedwith some of the flows. The Service tab is not

displayed by default. Click the plus sign (+) on the network information table header

and select Service to open the Service tab. The table includes one row per VPN.

Figure 220 on page 306 shows an example of the Service tab data.

Figure 220: Network Information Table, Service Tab

The Nodes column indicates howmany PE routers are associated with the VPN, and

theNode List column lists them. You can right-click on a VPN row to and selectShow
Detail to see information about each interface on each node. From the detail window,

youcan right-clickonan interfaceandselectShowDemandTraffic to see thedemand
traffic chart for the specific interface. You can adjust the time period in the upper left

corner of the chart display, to show the past hour, day, seven days, or a custom time

period.

You can also ShowDemand Traffic at the VPN level in the Service by right-clicking
the VPN row. The resulting chart displays the total traffic for the VPN.
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Right-click a VPN on the Service tab and select Enable Animated Selection to see
an animated VPN service view in the topology map window. This provides a view of

the network in the context of the VPNs, indicating which parts of the network the

VPNs service. To leave the animated view and return the topologymap to the original

layout, right-click again on the VPN and select Disable Animated Selection.

Demand Reports Collection

Demand reports are generated when you run a Demand Reports collection task from

Administration>TaskScheduler. TheTaskListwindow isdisplayed, showinganyexisting
collection tasks of any type.

1. From the Task List window, click Add in the upper right corner of the window. Give
the new task a name, and select Demand Reports from the Type drop-downmenu

as shown in Figure 221 on page 307.

Figure 221: Select Demand Reports

ClickNext to proceed to the options window.

2. Theoptions for creating the reports are shown inFigure 223onpage309. In theReport

Types tab, select which reports you want to generate. If you select Include AS
Demands, you have the additional option of choosing from a number of AS reports.
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Figure 222: Report Types Tab

Click the Report Options tab.

3. Figure 223 on page 309 shows the Report Options tab.
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Figure 223: Report Options Tab

The traffic is loaded as demand with 24 periods of statistics. You can choose up to

60 days’ worth of traffic which is aggregated using the specified aggregation statistic,

into 24 data points that represent hours of the day. The options in the Aggregation
Statistic drop-downmenu are described in Table 63 on page 309.

Table 63: Aggregation Statistics Options

DescriptionAggregation Statistic

For each of the 24 hours, the maximum of the sample values within that hour is used.Max

For each of the 24 hours, the samples within that hour are averaged. If there are N samples
for a particular hour, the result is the sum of the all the sample values divided by N.

Average

For each of the 24 hours, the X percentile value of the sampleswithin that hour is used. The
X percentile is computed from an equation that takes into consideration the average for
the hour and the standard deviation. The result is that X percent of the sample values lie
at or below the calculated value.

80th, 90th, 95th, 99thPercentile
(X percentile)

Also in this window, you have the opportunity to specify that you want to group data

in the reports according to the groups captured in your saved topology layouts. You

can select all layouts or specific ones. If you select more than one layout, reports are

generated for each.

Figure 224 on page 310 shows the Create New Task – Demand Reports window in

which two saved layouts are selected for data grouping.
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Figure 224: Device Collection Task, Select Saved Layouts for Grouping

See “Group and Ungroup Selected Nodes” on page 57 for information about creating

groups and using the auto-group function, and “Manage Layouts” on page 53 for

information about saving layouts.

ClickNext to proceed to the scheduling parameters.

4. The Create New Task - Schedule window is displayed as shown in

Figure 225 on page 311. You can opt to run the collection only once, or to repeat it at

configurable intervals.
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Figure 225: Device Collection Task, Scheduling

5. Click Submit to complete the addition of the new collection task and add it to the

Task List. Click a completed task in the list to display the results in the lower portion

of the window. There are three tabs in the results window: Summary, Status, and

History. Figure 226 on page 311 shows an example of the Status tab for a completed

DemandReports collection task. The statusnotes indicate the locationsof the reports

that were generated.

Figure 226: Demand Reports Collection Results, Status Tab
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The reports are also available by navigating to Applications > Reports. An example
list of reports is shown in Figure 227 on page 312.

Figure 227: Example List of Demand Reports

Related
Documentation

Group and Ungroup Selected Nodes on page 57•

• Manage Layouts on page 53

• Reports Overview on page 227

LSP Routing Behavior

You can configure NorthStar Controller to automatically reroute LSPs based on interface

traffic or link delay conditions. The parameters that trigger rerouting can be configured

on a global level (applied to all links in the network, in both directions), and you can

override global thresholds with link-specific thresholds.

Analytics Parameters Affecting LSP Routing Behavior

Table 64 on page 313 summarizes the Analytics parameters that affect LSP routing

behavior.
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Table 64: Analytics Parameters Affecting LSP Routing Behavior

How to AccessDescriptionParameter

Administration > AnalyticsUser-defined, global parameter applied
to both Layer 3 link utilization and LSP
delayviolations. It is theminimuminterval
after which the controller reacts to any
traffic/delay violations. Theminimum
value is 1 minute and there is no
maximum. The smaller the value, the
higher thenumberof reroutingprocesses,
andconsequently, thegreater the impact
on the network. It is a mandatory
parameter to trigger a Layer 3 link
utilizationviolationor LSPdelay violation
rerouting process.

Reroute Interval

Administration > AnalyticsUser-defined, global parameter applied
to all links for Layer 3 link utilization
violation scenarios. When this threshold
is exceeded, the controller starts moving
LSPs away from the congested links. It is
a mandatory parameter to enable this
controller behavior when Layer 3 link
utilization violations occur. Once the link
utilization crosses the defined threshold
andnoprevious reroutingprocesseshave
occurred within the defined Reroute
Interval, the reroutingprocess is triggered.

Link Utilization Threshold (%)

Administration > AnalyticsWhen packet loss on a link exceeds this
threshold, the link is considered unstable
and rerouting of traffic to avoid the link
is triggered. To achieve this, NorthStar
creates amaintenance event for each
link, temporarily making the link
unavailable for traffic. The event name
reflects that it was triggered by packet
loss. The event start time is immediate
(the link displays a red M indicating it is
inmaintenancemode) and the end time
is set for onehour later. Because this type
of maintenance event requires manual
completion, the end time is not
significant.

See“MaintenanceEvents”onpage 170for
information on viewing andmanaging
maintenance events, including how to
manually complete a triggered event
once the link has been restored to
stability.

Packet Loss Threshold (%)
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Table 64: Analytics Parameters Affecting LSP Routing Behavior (continued)

How to AccessDescriptionParameter

Administration > AnalyticsUser-defined, global parameter applied
to all the links. The controller
continuouslymonitors the linkdelaysand
computes thedelta for all links. Thedelay
increase is the absolute difference
between two consecutive received link
delays. It is a mandatory parameter to
enable this controller behaviorwhenLSP
delay violations occur.

To reduce unnecessary LSP delay
computation, the PCS server calculates
all LSPs delays only when this delta is
exceeded. If any LSP calculated delay
exceeds its ownMax Delay settings, and
no previous rerouting process has
occurred within the defined Reroute
Interval, then the controller attempts to
perform LSP rerouting.

NOTE: LSP delay is the sum of all the
delays of the links that belong to the LSP
routing path. The controller does not
directly monitor LSP delays.

Link Delay Increase

Applications > Provision LSP (Design
Tab), or modify an existing tunnel from
the network information table by
selecting the tunnel row and clicking
Modify at the bottom of the window.

The REST API can also be used.

User-defined, local parameter applied to
each LSP. It is amandatory parameter to
trigger any LSP delay violation rerouting
process.When an LSP is configuredwith
a Max Delay, and there is also a global
link delay threshold value, the controller
checks the LSP upon LSP delay
violations.

Max Delay

For LSP rerouting basedon link utilization (bandwidth), you can specify a reroute interval

(in minutes) and a link utilization threshold (%). The reroute interval is used to pace

back-to-back rerouting events. LSPs are rerouted when both of the following conditions

are true:

• A link utilization threshold has been crossed.

To avoid unnecessary network churn, NorthStar only considers rerouting an LSP with

traffic or a bandwidth reservationwhen the link utilization threshold has been crossed.

• No previous utilization-triggered reroute has occurred within the configured reroute

interval (in this sense, this timer specifies theminimumtime intervalbetweensuccessive

reroute actions).

When a threshold has been crossed, LSPs with a lower priority setting and higher traffic

are the first to be rerouted, before LSPs with a higher priority setting and lower traffic. If

LSP traffic data is available,NorthStar uses it over bandwidth reservation for determining

whether an LSP should be re-routed. If LSP traffic data is not available, NorthStar

considers LSP bandwidth reservation to make the determination.
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NOTE: For purposes of determining whether an LSP should be rerouted or
not, LSP traffic of 0 is considered as LSP traffic available–the LSPhas traffic
data, but the traffic data is 0. In that case, LSP bandwidth reservation is not
used for evaluation.

When utilization for a link crosses a configured threshold, it appears in the Timeline as

an event, as does any subsequent rerouting.

Forpacket loss-basedanddelay-based rerouting, configurationof real-timeperformance

monitoring (RPM) in Junos and installation of the rpm-log.slax script on the router are

prerequisites. See Configuring Routers to Send JTI Telemetry Data and RPM Statistics to

the Data Collectors in the NorthStar Controller Getting Started Guide. Once this is done,

Junos OS canmonitor the links for packet loss and link latency and capture the results

as syslog events.

For delay-based rerouting, the Link Delay Increase parameter controls when the LSP

delaycalculation (and reroute)are triggered.Only if thedelaymeasuredona link increases

bymore than the link delay increase value (milliseconds), are the LSPs re-optimized. For

delay-based rerouting towork, the LSPsmust be configuredwith aMax Delay constraint

(on the Provision LSP window, Design tab).

Figure228onpage316shows theProvisionLSPDesign tab.The thresholds in thiswindow

use the delay information to derive the metrics of the LSPs, which are, in turn, used by

the devices when choosing which LSPs to use to forward traffic to a given destination.
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Figure 228: Provision LSP, Design Tab Showing Delay Thresholds

Max Delay is used by the NorthStar Path Computation Server (PCS) to constrain the

routing path of an LSP. If this constraint is not met, the LSP is not routed by PCS. Max

Delay is also used by the NorthStar Telemetry module to trigger LSP rerouting.

High Delay Threshold is used to penalize the LSP so it is not used by the data plane as

long as there are other parallel LSPswith lowermetrics. The availability of the LSP is not

restored once the delay is lower than the High Delay Threshold, until the LSP delay

reaches Low Delay Threshold. This prevents excess impact on the network. When the

LSP delay drops below the Low Delay Threshold, its metric is set to Low Delay.

Setting Global Parameters

To set the global configuration parameters, navigate toAdministration >Analytics. The
LSP Routing Behavior window is displayed as shown in Figure 229 on page 317.
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Figure 229: LSP Routing Behavior

For LSP rerouting towork, youmust selectReroute:Enabled in thiswindow,whichcauses
the additional fields to be displayed. Click Save to configure the global settings.

Setting Link-Specific Thresholds

The link utilization threshold, packet loss threshold, and link delay increase can be set at

the link level. Link-level configuration of these thresholds overrides the global settings.

Link level thresholds are set in the Link tab of the network information table. Select a link

and clickModify at the bottom of the table. The Modify Link window is displayed as

shown in Figure 230 on page 318.
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Figure 230: LSP Routing Behavior

In the Analytics tab, you can set any or all of the three thresholds on a per-direction basis

(A-to-Z, Z-to-A) for that specific link.

NOTE: Interface A and Interface Z fieldsmust be populated in a link for the
Analytics tab to be available in the Modify Link window. This information
comes fromNetconf collection, so you can eitherwait for the next scheduled
Netconf collection task to run, or you can create a collection task that runs
immediately.

Viewing Threshold-Related Information

You can view interface traffic, interface delay, and packet loss in chart form by

right-clicking a link in the network information table as shown in Figure 231 on page 319.
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Figure 231: Right-Clicking a Link in the Network Information Table

In the topology map, you can choose to display interface utilization, measured delay, or

packet loss labels for the links. Click the Settings icon on the right side of the topology

view to open the Topology Settings windowwhere you can control link labels and other

display options.

Related
Documentation

• Maintenance Events on page 170

• Viewing Analytics Data in theWeb UI on page 258

• Left Pane Options on page 62

• Provision LSPs

• Interactive Map Features on page 42
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PART 3

Troubleshooting the NorthStar Controller

• Troubleshooting Strategies on page 323

• Frequently Asked Troubleshooting Questions on page 345

• Additional Troubleshooting Resources on page 349
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CHAPTER 11

Troubleshooting Strategies

• NorthStar Controller Troubleshooting Overview on page 323

• NorthStar Controller Troubleshooting Guide on page 324

NorthStar Controller Troubleshooting Overview

In theWeb UI, the Dashboard View and Event View (Applications>Event View) provide
information that can help with troubleshooting.

For additional information to help identify and troubleshoot issues with the Path

Computation Server (PCS) or NorthStar Controller application, you can access the log

files.

NOTE: If you are unable to resolve a problemwith the NorthStar Controller,
we recommend that you forward the debug files generated by the NorthStar
Controller debugging utility to JTAC for evaluation. Currently all debug files
are located in subdirectories under the u/wandl/tmp directory.

To collect debug files, log in to the NorthStar Controller CLI, and execute the
command u/wandl/bin/system-diagnostic.sh filename.

The output is generated and available from the /tmp directory in the

filename.tbz2 debug file.

Table 65 on page 323 lists the NorthStar Controller log files most commonly used to

identify and troubleshoot issueswith the PCS andPCE. All log files are located under the

/opt/northstar/logs directory, with one exception. The pcep_server.log file is located in

/var/log/jnc.

Table 65: NorthStar Controller Log Files

DescriptionLog Files

Log events related to the cassandra database.cassandra.msg

Log files related to maintaining LSP configuration states in NorthStar Controller. LSP
configurationstatesareupdatedbycollectingshowcommandsandNETCONFprovisioning.

configServer.msg
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Table 65: NorthStar Controller Log Files (continued)

HA coordinator log.ha_agent.msg

Interface to transport controller log.mlAdaptor.log

Log files related tocommunicationbetweenNorthStarController anddevices viaNETCONF
sessions.

netconfd.msg

Configuration script log.net_setup.log

Log events related to nodejs.nodejs.msg

Located in /var/log/jnc. Log files related to communication between the PCC and the
PCE in both directions.

pcep_server.log

Log files related to the PCS, which includes any event received by PCS from Toposerver
and any event fromToposerver to PCS including provisioning orders. This log also contains
any communication errors as well as any issues that prevent the PCS from starting up
properly.

pcs.log

Logs files of REST API requests.rest_api.log

Log files related to the topology server.

Contains the record of the events between the PCS and topology server, the topology
server and NTAD, and the topology server and the PCE server

NOTE: Anymessage forwarded to thepcshandler.log file is also forwarded to thepcs.log
file.

toposerver.log

Related
Documentation

NorthStar Controller Troubleshooting Guide on page 324•

• FAQs for Troubleshooting the NorthStar Controller on page 345

NorthStar Controller Troubleshooting Guide

This document includes strategies for identifying whether an apparent problem stems

fromtheNorthStarController or fromthe router, andprovides troubleshooting techniques

for those problems that are identified as stemming from the NorthStar Controller.

Before you begin any troubleshooting investigation, confirm that all system processes

areupand running.A sample list ofprocesses is shownbelow.Youractual list ofprocesses

could be different.

[root@user-PCS ~]# supervisorctl status

collector:es_publisher           RUNNING   pid 2557, uptime 0:02:18
collector:task_scheduler         RUNNING   pid 2558, uptime 0:02:18
collector:worker1                RUNNING   pid 404, uptime 0:07:00
collector:worker2                RUNNING   pid 406, uptime 0:07:00
collector:worker3                RUNNING   pid 405, uptime 0:07:00
collector:worker4                RUNNING   pid 407, uptime 0:07:00
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infra:cassandra                  RUNNING   pid 402, uptime 0:07:01
infra:ha_agent                   RUNNING   pid 1437, uptime 0:05:44
infra:healthmonitor              RUNNING   pid 1806, uptime 0:04:26
infra:license_monitor            RUNNING   pid 399, uptime 0:07:01
infra:prunedb                    RUNNING   pid 395, uptime 0:07:01
infra:rabbitmq                   RUNNING   pid 397, uptime 0:07:01
infra:redis_server               RUNNING   pid 401, uptime 0:07:01
infra:web                        RUNNING   pid 2556, uptime 0:02:18
infra:zookeeper                  RUNNING   pid 396, uptime 0:07:01
listener1:listener1_00           RUNNING   pid 1902, uptime 0:04:15
netconf:netconfd                 RUNNING   pid 2555, uptime 0:02:18
northstar:mladapter              RUNNING   pid 2551, uptime 0:02:18
northstar:npat                   RUNNING   pid 2552, uptime 0:02:18
northstar:pceserver              RUNNING   pid 1755, uptime 0:04:29
northstar:scheduler              RUNNING   pid 2553, uptime 0:02:18
northstar:toposerver             RUNNING   pid 2554, uptime 0:02:18
northstar_pcs:PCServer           RUNNING   pid 2549, uptime 0:02:18
northstar_pcs:PCViewer           RUNNING   pid 2548, uptime 0:02:18
northstar_pcs:configServer       RUNNING   pid 2550, uptime 0:02:18

Restart any processes that display as STOPPED instead of RUNNING.

NOTE: To stop, start, or restart all processes, use the service northstar stop,
service northstar start, and service northstar restart commands.

To access system process status information from the NorthStar Controller Web UI,

navigate toMore Options>Administration and select SystemHealth.

The current CPU%,memory usage, virtual memory usage, and other statistics for each

system process are displayed. Figure 232 on page 325 shows an example.

NOTE: Only processes that are running are included in this display.

Figure 232: Process Status Display

Table 66 on page 325 describes each field displayed in the Process Status table.

Table 66: Descriptions of Process Status Fields

DescriptionField

The name of the NorthStar Controller process.Process
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Table 66: Descriptions of Process Status Fields (continued)

DescriptionField

The Process ID number.PID

TheNorthStarController userpermissions required toaccess informationabout thisprocess.User

NorthStar Controller user group permissions required to access information about this
process.

Group

Displays current percentage of CPU currently in use by this process.CPU%

Displays current percentage of memory currently in use by this process.Memory

Displays current Virtual memory in use by this process.Virtual Memory

The amount of time the CPUwas used for processing instructions for the processCPU Time

Displays the specific command options for the system process.CMD

The troubleshooting information is presented in the following sections:

• NorthStar Controller Log Files on page 326

• Empty Topology on page 329

• Incorrect Topology on page 332

• Missing LSPs on page 332

• PCC That is Not PCEP-Enabled on page 334

• LSP Stuck in PENDING or PCC_PENDING State on page 335

• LSP That is Not Active on page 336

• Disappearing Changes on page 338

• Investigating Client Side Issues on page 341

• Collecting NorthStar Controller Debug Files on page 344

NorthStar Controller Log Files

Throughout your troubleshooting efforts, it can be helpful to view various NorthStar

Controller log files. To access log files:

1. Log in to the NorthStar Controller Web UI.

2. Navigate toMore Options > Administration and select Logs.

A list of NorthStar system log andmessage files is displayed, a truncated example of

which is shown in Figure 233 on page 327.
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Figure 233: Sample of System Log andMessage Files

3. Click the log file or message file that you want to view.

The log file contents are displayed in a pop-up window.

4. Toopen the file ina separatebrowserwindowor tab, clickViewRawLog in thepop-up
window.

5. To close the pop-up window and return to the list of log andmessage files, click X in

the upper right corner of the pop-up window.

Table 65 on page 323 lists the NorthStar Controller log files most commonly used to

identify and troubleshoot issues with the PCS and PCE.
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Table 67: Top NorthStar Controller Troubleshooting Log Files

LocationDescriptionLog File

/var/log/jncLog entries related to the PCEP server. The PCEP server
maintains thePCEPsession.The logcontains information
about communication between the PCC and the PCE in
both directions.

To configure verbose PCEP server logging:

1. From the NorthStar Controller CLI, run pcep_cli.

2. Type set log-level all.

3. Press CTRL-C to exit.

pcep_server.log

/opt/northstar/logsLog entries related to the PCS. The PCS is responsible
for path computation. This log includes events received
by the PCS from the Toposerver, including provisioning
orders. It also contains notification of communication
errors and issues that prevent the PCS from starting up
properly.

pcs.log

/opt/northstar/logsLog entries related to the topology server. The topology
server is responsible for maintaining the topology. These
logs contain the record of the events between the PCS
and the Toposerver, the Toposerver and NTAD, and the
Toposerver and the PCE server

toposerver.log

Table68onpage328 listsadditional log files that canalsobehelpful for troubleshooting.

All of the log files in Table 68 on page 328 are located under the /opt/northstar/logs

directory.

Table 68: Additional Log Files for Troubleshooting NorthStar Controller

DescriptionLog Files

Log events related to the cassandra database.cassandra.msg

HA coordinator log.ha_agent.msg

Interface to transport controller log.mlAdaptor.log

Configuration script log.net_setup.log

Log events related to nodejs.nodejs.msg

Log files related to communication between the PCC and the PCE in both directions.pcep_server.log

Log files related to the PCS, which includes any event received by PCS from Toposerver
andanyevent fromToposerver toPCS includingprovisioningorders. This logalsocontains
any communication errors as well as any issues that prevent the PCS from starting up
properly.

pcs.log
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Table 68: Additional Log Files for Troubleshooting NorthStar Controller (continued)

Logs files of REST API requests.rest_api.log

Log files related to the topology server.

Contains the record of the events between the PCS and topology server, the topology
server and NTAD, and the topology server and the PCE server

NOTE: Any message forwarded to the pcshandler.log file is also forwarded to the
pcs.log file.

toposerver.log

To see logs related to the Junos VM, youmust establish a telnet session to the router.

The default IP address for the Junos VM is 172.16.16.2. The Junos VM is responsible for

maintaining the necessary BGP, ISIS, or OSPF sessions.

Empty Topology

Figure234onpage329 illustrates the flowof information fromthe router to theToposerver

that results in the topology display in the NorthStar Controller UI. When the topology

display is empty, it is likely this flow has been interrupted. Finding outwhere the flowwas

interrupted can guide your problem resolution process.

Figure 234: Topology Information Flow

The topology originates at the routers. For NorthStar Controller to receive the topology,

there must be a BGP-LS, ISIS, or OSPF session from one of the routers in the network to

the Junos VM. Theremust also be an established Network Topology Abstractor Daemon

(NTAD) session between the Junos VM and the Toposerver.
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To check these connections:

1. Using the NorthStar Controller CLI, verify that the NTAD connection between the

Toposerver and the Junos VMwas successfully established as shown in this example:

[root@northstar ~]# netstat -na | grep :450

tcp        0      0 172.16.16.1:55752           172.16.16.2:450             
ESTABLISHED

NOTE: Port 450 is the port used for Junos VM to Toposerver connections.

In the following example, the NTAD connection has not been established:

[root@northstar ~]# netstat -na | grep :450

tcp        0      0 172.16.16.1:55752           172.16.16.2:450             
LISTENING

2. Log in to the Junos VM to confirm whether NTAD is configured to enable topology

export. The grep command below gives you the IP address of the Junos VM.

[root@northstar ~]# grep "ntad_host" /opt/northstar/data/northstar.cfg

ntad_host=172.16.16.2

[root@northstar ~]# telnet 172.16.16.2

Trying 172.16.16.2...
Connected to 172.16.16.2.
Escape character is '^]'.

northstar_junosvm (ttyp0)

login: northstar
Password:

--- JUNOS 14.2R4.9 built 2015-08-25 21:01:39 UTC

This JunOS VM is running in non-persistent mode.
If you make any changes on this JunOS VM,
Please make sure you save to the Host using net_setup.py utility, otherwise 
the config will be lost if this VM is restarted.

northstar@northstar_junosvm> show configuration protocols | display set

set protocols topology-export

If the topology-export statement is missing, the Junos VM cannot export data to the

Toposerver.
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3. Use JunosOS showcommands toconfirmwhether theBGP, ISIS, orOSPF relationship

between the Junos VM and the router is ACTIVE. If the session is not ACTIVE, the

topology information cannot be sent to the Junos VM.

4. On the Junos VM, verify whether the lsdist.0 routing table has any entries:

northstar@northstar_junosvm> show route table lsdist.0 terse | match lsdist.0

lsdist.0: 54 destinations, 54 routes (54 active, 0 holddown, 0 hidden)

If you see only zeros in the lsdist.0 routing table, there is no topology that can be sent.

Review theNorthStarControllerGettingStartedGuide sectionsonconfiguring topology

acquisition.

5. Ensure that there is at least one link in the lsdist.0 routing table. The Toposerver can

only generate an initial topology if it receives at least one NTAD link event. A network

that consists of a single node with no IGP adjacency with other nodes (as is possible

in a lab environment, for example), will not enable the Toposerver to generate a

topology. Figure 235 on page 331 illustrates the Toposerver’s logic process for creating

the initial topology.

Figure 235: Logic Process for Initial Topology Creation

If an initial topology cannot be created for this reason, the toposerver.log generates

an entry similar to the following example:

Dec  9 16:03:57.788514 fe-cluster-03 TopoServer  Did not send the topology 
because no links were found.
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Incorrect Topology

One important functionof theToposerver is to correlate theunidirectional link (interface)

information from the routers into bidirectional links by matching source and destination

IPv4Link_Identifiers fromNTAD linkevents.When the topologydisplayed in theNorthStar

UI does not appear to be correct, it can be helpful to understand how the Toposerver

handles the generation andmaintenance of the bidirectional links.

Generation andmaintenance of bidirectional links is a complex process, but here are

some key points:

• For the two nodes constituting each bidirectional link, the Node ID that was assigned

first (and therefore has the lower Node ID number) is given the Node A designation,

and the other node is given the Node Z designation.

NOTE: The Node ID is assigned when the Toposerver first receives the
Node event fromNTAD.

• Whenever a Node ID is cleared and reassigned (such as during a Toposerver restart or

networkmodel reset), theNode IDsand therefore, theAandZdesignations, canchange.

• The Toposerver receives a Link Update message when a link in the network is added

or modified.

• The Toposerver receives a LinkWithdrawmessage when a link is removed from the

network.

• The Link Update and LinkWithdrawmessages affect the operational status of the

nodes.

• The node operational status, together with the protocol (IGP versus IGP plus MPLS)

determinewhether a link can be used to route LSPs. For a link to be used to route LSPs,

it must have both an operational status of UP and the MPLS protocol active.

Missing LSPs

When your topology is displaying correctly, but you havemissing LSPs, take a look at the

flow of information from the PCC to the Toposerver that results in tunnels being added

to the NorthStar Controller UI, as illustrated in Figure 236 on page 333. The flow begins

with the configuration at the PCC, fromwhich an LSP Update message is passed to the

PCEPserver bywayof aPCEPsessionand then to theToposerver bywayof anAdvanced

Message Queuing Protocol (AMQP) connection.
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Figure 236: LSP Information Flow

To check these connections:

1. Look at the toposerver.log. The log prints amessage every 15 secondswhen it detects

that its connection with the PCEP server has been lost or was never successfully

established. Note that in the following example, the connection between the

Toposerver and the PCEP server is marked as down.

Toposerver log:
Apr 22 16:21:35.016721 user-PCS TopoServer  Warning, did not receive the PCE 
beacon within 15 seconds, marking it as down. Last up: Fri Apr 22 16:21:05 
2016
Apr 22 16:21:35.016901 user-PCS TopoServer  [->PCS] PCE Down: Warning, did not
 receive the PCE beacon within 15 seconds, marking it as down. Last up: Fri 
Apr 22 16:21:05 2016
Apr 22 16:21:50.030592 user-PCS TopoServer  Warning, did not receive the PCE 
beacon within 15 seconds, marking it as down. Last up: Fri Apr 22 16:21:05 
2016
Apr 22 16:21:50.031268 user-PCS TopoServer  [->PCS] PCE Down: Warning, did not
 receive the PCE beacon within 15 seconds, marking it as down. Last up: Fri 
Apr 22 16:21:05 2016

2. Using theNorthStar Controller CLI, verify that thePCEP session between thePCCand

the PCEP server was successfully established as shown in this example:

[root@northstar ~]# netstat -na | grep :4189

tcp        0      0 0.0.0.0:4189                0.0.0.0:*                   
LISTEN
tcp        0      0 172.25.152.42:4189          172.25.155.50:59143         
ESTABLISHED
tcp        0      0 172.25.152.42:4189          172.25.155.48:65083         
ESTABLISHED

NOTE: Port 4189 is the port used for PCC to PCEP server connections.
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Knowing that the session has been established is useful, but it does not necessarily

mean that any data was transferred.

3. Verify whether the PCEP server learned about any LSPs from the PCC.

[root@user-PCS ~]# pcep_cli
# show lsp all list

2016-04-22 17:09:39.696061(19661)[DEBUG]: pcc_lsp_table.begin:
2016-04-22 17:09:39.696101(19661)[DEBUG]: pcc-id:1033771436/172.25.158.61, 
state: 0

2016-04-22 17:09:39.696112(19661)[DEBUG]: START of LSP-NAME-TABLE
…
2016-04-22 17:09:39.705358(19661)[DEBUG]: Summary pcc_lsp_table:
2016-04-22 17:09:39.705366(19661)[DEBUG]:   Summary LSP name tabl:
2016-04-22 17:09:39.705375(19661)[DEBUG]:     
client_id:1033771436/172.25.158.61, state:0,num LSPs:13
2016-04-22 17:09:39.705388(19661)[DEBUG]:     
client_id:1100880300/172.25.158.65, state:0,num LSPs:6
2016-04-22 17:09:39.705399(19661)[DEBUG]:     
client_id:1117657516/172.25.158.66, state:0,num LSPs:23
2016-04-22 17:09:39.705410(19661)[DEBUG]:     
client_id:1134434732/172.25.158.67, state:0,num LSPs:4
2016-04-22 17:09:39.705420(19661)[DEBUG]:   Summary LSP id table:
2016-04-22 17:09:39.705429(19661)[DEBUG]:     
client_id:1033771436/172.25.158.61, state:0, num LSPs:13
2016-04-22 17:09:39.705440(19661)[DEBUG]:     
client_id:1100880300/172.25.158.65, state:0, num LSPs:6
2016-04-22 17:09:39.705451(19661)[DEBUG]:     
client_id:1117657516/172.25.158.66, state:0, num LSPs:23
2016-04-22 17:09:39.705461(19661)[DEBUG]:     
client_id:1134434732/172.25.158.67, state:0, num LSPs:4

In the far right column of the output, you see the number of LSPs that were learned.

If this number is 0, no LSP informationwas sent to thePCEP server. In that case, check

the configuration on the PCC side, as described in the NorthStar Controller Getting

Started Guide.

PCC That is Not PCEP-Enabled

The Toposerver associates the PCEP sessions with the nodes in the topology from the

TED in order to make a node PCEP-enabled. This Toposerver function is hindered if the

IP address used by the PCC to establish the PCEP sessionwas not the one automatically

learned by the Toposerver from the TED. For example, if a PCEP session is established

using the management IP address, the Toposerver will not receive that IP address from

the TED.

WhenthePCCsuccessfullyestablishesaPCEPsession, it sendsaPCC_SYNC_COMPLETE

message to the Toposerver. This message indicates to NorthStar that synchronization

is complete. The following is a sample of the corresponding toposerver log entries,
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showing both the PCC_SYNC_COMPLETEmessage and the PCEP IP address that

NorthStar might or might not recognize:

Dec  9 17:12:11.610225 fe-cluster-03 TopoServer  NSTopo::updateNode (PCCNodeEvent)
 ip: 172.25.155.26 pcc_ip: 172.25.155.26 evt_type: PCC_SYNC_COMPLETE
Dec  9 17:12:11.610230 fe-cluster-03 TopoServer  Adding PCEP flag to pcep_ip: 
172.25.155.26 node_id: 0880.0000.0026 router_ID: 88.0.0.26 protocols: 4
Dec  9 17:12:11.610232 fe-cluster-03 TopoServer  Setting live pcep_ip: 
172.25.155.26 for router_ID: 88.0.0.26

Some options for correcting the problem of an unrecognized IP address are:

• Manually input the unrecognized IP address in the device profile in the NorthStarWeb

UI by navigating toMore Options > Administration > Device Profile.

• Ensure there is at least one LSP originating on the router, which will allow Toposerver

to associate the PCEP session with the node in the TED database.

Once the IP address problem is resolved, and the Toposerver is able to successfully

associate the PCEP session with the node in the topology, it adds the PCEP IP address

to the node attributes as can be seen in the PCS log:

Dec  9 17:12:11.611392 fe-cluster-03 PCServer  [<-TopoServer] routing_key = 
ns_node_update_key
Dec  9 17:12:11.611394 fe-cluster-03 PCServer  [<-TopoServer] NODE UPDATE(Live):
 ID=0880.0000.0026 protocols=(20)ISIS2,PCEP status=UNKNOWN hostname=skynet_26 
router_ID=88.0.0.26 iso=0880.0000.0026 isis_area=490001 AS=41 mgmt_ip=172.25.155.26
 source=NTAD Hostname=skynet_26 pcep_ip=172.25.155.26

LSP Stuck in PENDING or PCC_PENDING State

Once nodes are correctly established as PCEP-enabled, you could start provisioning

LSPs. It is possible for the LSP controller status to indicate PENDING or PCC_PENDING

as seen in the Tunnels tab of theWeb UI network information table (Controller Status

column). This section explains how to interpret those statuses.

When an LSP is being provisioned, the PCS server computes a path that satisfies all the

requirements for the LSP, and then sends a provisioning order to the PCEP server. Log

messages similar to the following example appear in the PCS log while this process is

taking place:

Apr Apr 25 10:06:44.798336 user-PCS PCServer  [->TopoServer] push lsp configlet,
 action=ADD
Apr 25 10:06:44.798341 user-PCS PCServer  
{#012"lsps":[#012{"request-id":928380025,"name":"JTAC","from":"11.0.0.102", 
"to":"11.0.0.104","pcc":"172.25.158.66","bandwidth":"100000","metric":0,"local-protection":false,"type":"primary","association-group-id":0,"path-attributes":{"admin-group":{"exclude":0,"include-all":0,

"include-any":0},"setup-priority":7,"reservation-priority":7,"ero":[{"ipv4-address":"11.102.105.2"},{"ipv4-address":"11.105.107.2"},
 {"ipv4-address":"11.114.117.1"}]}}#012]#012}
Apr 25 10:06:44.802500 user-PCS PCServer  provisioning order sent, status = SUCCESS
Apr 25 10:06:44.802519 user-PCS PCServer  [->TopoServer] Save LSP action, 
id=928380025 event=Provisioning Order(ADD) sent request_id=928380025
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Apr 25 10:06:44.802534 user-PCS PCServer   lsp action=ADD JTAC@11.0.0.102 path= 
controller_state=PENDING

The LSP controller status is PENDING at this point, meaning that the provisioning order

has been sent to the PCEP server, but an acknowledgement has not yet been received.

If an LSP is stuck at PENDING, it suggests that the problem lies with the PCEP server.

You can log into the PCEP server and configure verbose logmessageswhich can provide

additional information of possible troubleshooting value:

pcep_cli
set log-level all

There are also a variety of show commands on the PCEP server that can display useful

information. Just as with Junos OS syntax, you can enter show ? to see the show
command options.

If the PCEP server successfully receives the provisioning order, it performs two actions:

• It forwards the order to the PCC.

• It sends an acknowledgement back to the PCS.

The PCEP server log would show an entry similar to the following example:

2016-04-25 10:06:45.196263(27897)[EVENT]: 172.25.158.66:JTAC UPD RCVD FROM PCC, 
ack 928380025
2016-04-25 10:06:45.196517(27897)[EVENT]: 172.25.158.66:JTAC ADD SENT TO   PCS 
928380025, UP

The LSP controller status changes to PCC_PENDING, indicating that the PCEP server

received the provisioning order and forwarded it on to the PCC, but the PCC has not yet

responded. If an LSP is stuck at PCC_PENDING, it suggests that the problem lieswith the

PCC.

If the PCC receives the provisioning order successfully, it sends a response to the PCEP

server, which in turn, forwards the response to the PCS. When the PCS receives this

response, it clears the LSP controller status completely, indicating that the LSP is fully

provisioned and is not waiting for action from the PCEP server or PCC. The operational

status (Op Status column) then becomes the indicator for the condition of the tunnel.

The PCS log would show an entry similar to the following example:

Apr 25 10:06:45.203909 user-PCS PCServer  [<-TopoServer] JTAC@11.0.0.102, LSP 
event=(0)CREATE request_id=928380025 tunnel_id=9513 lsp_id=1 report_type=ACK

LSP That is Not Active

If an LSP provisioning order is successfully sent and acknowledged, and the controller

status is cleared, it is still possible that the LSP is not up and running. If the operational
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status of the LSP is DOWN, the PCC cannot signal the LSP. This section explores some

of the possible reasons for the LSP operational status to be DOWN.

Utilization is a key concept related to LSPs that are stuck in DOWN. There are two types

of utilization, and they can be different from each other at any specific time:

• Live utilization—This type is used by the routers in the network to signal an LSP path.

This type of utilization is learned from the TED by way of NTAD. Youmight see PCS

log entries such as those in the following example. In particular, note the reservable

bandwidth (reservable_bw) entries that advertise the RSVP utilization on the link:

Apr 25 10:10:11.475686 user-PCS PCServer  [<-TopoServer] LINK UPDATE: 
ID=L11.105.107.1_11.105.107.2 status=UP nodeA=0110.0000.0105 nodeZ=0110.0000.0107
 protocols=(260)ISIS2,MPLS
Apr 25 10:10:11.475690 user-PCS PCServer    [A->Z] ID=L11.105.107.1_11.105.107.2
 IP address=11.105.107.1 bw=10000000000 max_rsvp_bw=10000000000 te_metric=10 
color=0 reservable_bw={9599699968 8599699456 7599699456 7599699456 7599699456 
7599699456 7599699456 7099599360 }
Apr 25 10:10:11.475694 user-PCS PCServer    [Z->A] ID=L11.105.107.1_11.105.107.2
 IP address=11.105.107.2 bw=10000000000 max_rsvp_bw=10000000000 te_metric=10 
color=0 reservable_bw={10000000000 10000000000 10000000000 8999999488 7899999232
 7899999232 7899999232 7899999232 }

• Plannedutilization—This type is usedwithinNorthStarController for pathcomputation.

This utilization is learned from PCEPwhen the router advertises the LSP and

communicates to NorthStar the LSP bandwidth and the path the LSP is to use. You

might see PCS log entries such as those in the following example. In particular, note

the bandwidth (bw) and record route object (RRO) entries that advertise the RSVP
utilization on the link:

Apr 25 10:06:45.208021 feffendy-PCS PCServer  [<-TopoServer] routing_key = 
ns_lsp_link_key
Apr 25 10:06:45.208034 feffendy-PCS PCServer  [<-TopoServer] JTAC@11.0.0.102, 
LSP event=(2)UPDATE request_id=0 tunnel_id=9513 lsp_id=1 report_type=STATE_CHANGE
Apr 25 10:06:45.208039 feffendy-PCS PCServer   JTAC@11.0.0.102, lsp add/update
 event lsp_state=ACTIVE admin_state=UP, delegated=true
Apr 25 10:06:45.208042 feffendy-PCS PCServer   from=11.0.0.102 to=11.0.0.104
Apr 25 10:06:45.208046 feffendy-PCS PCServer   primary path
Apr 25 10:06:45.208049 feffendy-PCS PCServer   association.group_id=128 
association_type=1
Apr 25 10:06:45.208052 feffendy-PCS PCServer    priority=7/7 bw=100000 metric=30
Apr 25 10:06:45.208056 feffendy-PCS PCServer    admin group bits exclude=0 
include_any=0 include_all=0
Apr 25 10:06:45.208059 feffendy-PCS PCServer    PCE initiated
Apr 25 10:06:45.208062 feffendy-PCS PCServer    
ERO=0110.0000.0102--11.102.105.2--11.105.107.2--11.114.117.1
Apr 25 10:06:45.208065 feffendy-PCS PCServer    
RRO=0110.0000.0102--11.102.105.2--11.105.107.2--11.114.117.1
Apr 25 10:06:45.208068 feffendy-PCS PCServer    samepath, state changed

It is possible for the two utilizations to be different enough fromeach other that it causes

interference with successful computation or signalling of the path. For example, if the

planned utilization is higher than the live utilization, a path computation issue could arise

in which the PCS cannot compute the path because it thinks there is no room for it. But
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because the planned utilization is higher than the actual live utilization, there may very

well be room.

It’s also possible for the planned utilization to be lower than the live utilization. In that

case, the PCC does not signal the path because it thinks there is no room for it.

To view utilization in theWeb UI topology map, navigate to Options in the left pane of

the Topology view. If you select RSVP Live Utilization, the topology map reflects the live

utilization that comes from the routers. If you select RSVP Utilization, the topology map

reflects the planned utilization which is computed by the NorthStar Controller based on

planned properties.

A better troubleshooting tool in theWeb UI is the Network Model Audit widget in the

Dashboard view. The Link RSVP Utilization line item reflects whether there are any

mismatches between the live and the planned utilizations. If there are, you can try

executing Sync Network Model from theWeb UI by navigating to Administration >
SystemSettings, and then clicking Advanced Settings in the upper right corner of the
resulting window.

NOTE: The upper right corner button toggles betweenGeneral Settings and
Advanced Settings.

Disappearing Changes

Two options are available in theWeb UI for synchronizing the topology with the live

network. These options are only available to the system administrator, and can be

accessed by first navigating to Administration > SystemSettings, and then clicking
Advanced Settings in the upper right corner of the resulting window.

NOTE: The upper right corner button toggles betweenGeneral Settings and
Advanced Settings.

Figure 237 on page 339 shows the two options that are displayed.
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Figure 237: Synchronization Operations

It is important to be aware that if you execute Reset Network Model in theWeb UI, you

will lose changes that you’ve made to the database. In a multi-user environment, one

user might reset the network model without the knowledge of the other users. When a

reset is requested, the request goes from the PCS server to the Toposerver, and the PCS

log reflects:

Apr 25 10:54:50.385008 user-PCS PCServer  [->TopoServer] Request topology reset

The Toposerver log then reflects that database elements are being removed:

Apr 25 10:54:50.386912 user-PCS TopoServer  Truncating pcs.links...
Apr 25 10:54:50.469722 user-PCS TopoServer  Truncating pcs.nodes...
Apr 25 10:54:50.517501 user-PCS TopoServer  Truncating pcs.lsps...
Apr 25 10:54:50.753705 user-PCS TopoServer  Truncating pcs.interfaces...
Apr 25 10:54:50.806737 user-PCS TopoServer  Truncating pcs.facilities...

The Toposerver then requests a synchronization with both the Junos VM to retrieve the

topology nodes and links, and with the PCEP server to retrieve the LSPs. In this way, the

Toposerver relearns the topology,butanyuserupdatesaremissing. Figure238onpage340

illustrates the flow from the topology reset request to the request for synchronization

with the Junos VM and the PCEP Server.
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Figure 238: Reset Model Request

Upon receipt of the synchronization requests, Junos VM and the PCEP server return

topologyupdates that reflect thecurrent livenetwork. ThePCS log shows this information

being added to the database:

Apr 25 10:54:52.237882 user-PCS PCServer  [<-TopoServer] Update Topology
Apr 25 10:54:52.237894 user-PCS PCServer  [<-TopoServer] Update Topology Persisted
 Nodes (0)
Apr 25 10:54:52.238957 user-PCS PCServer  [<-TopoServer] Update Topology Live 
Nodes (7)
Apr 25 10:54:52.242336 user-PCS PCServer  [<-TopoServer] Update Topology Persisted
 Links (0)
Apr 25 10:54:52.242372 user-PCS PCServer  [<-TopoServer] Update Topology live 
Links (10)
Apr 25 10:54:52.242556 user-PCS PCServer  [<-TopoServer] Update Topology Persisted
 Facilities (1)
Apr 25 10:54:52.242674 user-PCS PCServer  [<-TopoServer] Update Topology Persisted
 LSPs (0)
Apr 25 10:54:52.279716 user-PCS PCServer  [<-TopoServer] Update Topology Live 
LSPs (47)
Apr 25 10:54:52.279765 user-PCS PCServer  [<-TopoServer] Update Topology Finished

Figure 239 on page 341 illustrates the return of topology updates from the Junos VM and

the PCEP Server to the Toposerver and the PCS.
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Figure 239: Model Updates Using Reset Network Model

You should use the Reset Network Model when you want to start over from scratch with

your topology, but if you don’t want to lose user planning data when synchronizing with

the live network, execute theSyncNetworkModel operation instead.With this operation,

the PCS still requests a topology synchronization, but the Toposerver does not delete

the existing elements. Figure 240 on page 341 illustrates the flow from the PCS to the

Junos VM and PCEP server, and the updates coming back to the Toposerver.

Figure 240: Synchronization Request andModel Updates Using Sync Network Model

Investigating Client Side Issues

If you are looking for the source of a problem, and you cannot find it on the server side of

the system, there is a debugging flag that can help you find it on the client side. The flag

enablesdetailedmessageson thewebbrowser consoleaboutwhathasbeenexchanged

between the server and the client. For example, youmight notice that an update is not

reflected in theWeb UI. Using these detailed messages, you can identify possible

miscommunication between the server and the client such as the server not actually

sending the update, for example.
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To enable this debug flag, modify the URL you use to launch theWeb UI as follows:

https://server_address:8443/client/app.html?debug=true

Copyright © 2019, Juniper Networks, Inc.342

NorthStar Controller User Guide



NOTE: If you are already in theWeb UI, it is not necessary to log out; simply
add ?debug=true to the URL and press Enter. The UI reloads.

Figure 241 on page 343 shows an example of the web browser console with
detailed debuggingmessages.

Figure 241: Web Browser Console with Debugging Messages

Accessing the console varies by browser. Figure 242 on page 343 shows an
example: accessing the console on Google Chrome.

Figure 242: Accessing the Google Chrome Console
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Collecting NorthStar Controller Debug Files

If you are unable to resolve a problemwith theNorthStar Controller, we recommend that

you forward the debug files generated by the NorthStar Controller debugging utility to

JTAC for evaluation. Currently all debug files are located in subdirectories under the

u/wandl/tmp directory.

To collect debug files, log in to the NorthStar Controller CLI, and execute the command

u/wandl/bin/system-diagnostic.sh filename.

The output is generated and is available from the /tmp directory in the filename.tbz2

debug file.

Related
Documentation

• FAQs for Troubleshooting the NorthStar Controller on page 345

• Managing the Path Computation Server and Path Computation Element Services on

the NorthStar Controller on page 355
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CHAPTER 12

Frequently Asked Troubleshooting
Questions

• FAQs for Troubleshooting the NorthStar Controller on page 345

FAQs for Troubleshooting the NorthStar Controller

The following frequently asked questions (FAQs) are provided to help answer questions

youmight have about troubleshooting NorthStar Controller features, functionality, and

behavior.

• What commands can I use to stop, start, or restart NorthStar?

service northstar stop

service northstar start

service northstar restart

NOTE: DONOTUSE supervisorctl stop all, supervisorctl start all, or
supervisorctl restart all. Starting and stopping processes out of order can
cause unexpected issues.

• Should I usean "in-band"or "out-of-band"management interface for thePCEPsession?

We recommend in-bandmanagement, but if in-band is not an option, out-of-band

managementwill workwith some limitations. If you use an out-of-bandmanagement

interface as the PCEP local address, configure PCCmanagement IP addressmapping.

NOTE: We also recommend that you use the router loopback IP address
asthePCEPlocaladdresswith theassumptionthat the loopback IPaddress
is also the TE router ID.

• What is an "ethernet” node andwhy is “ethernet" node shown even though there are only

two routers on that link?

Ethernetnode representsaswitchorhub in thebroadcastenvironment.Unlessexplicitly

configuredotherwise,OSPFand IS-ISperformadjacency inbroadcastmode.Displaying
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this "ethernet" in the network topology makes it possible to detect which part of the

network has non-explicit point-to-point Interior GatewayProtocol (IGP) configuration.

• The OSPF Broadcast link doesn't sync up, and the NorthStar Controller UI displays an

isolated router and an isolated Ethernet node. What is the problem here?

Verify that each router's interface that is connected to the isolated subnet is configured

with the family mpls enable statement (for routers running Junos OS).

• The PCEP session between the PCC and PCE stays in the "connecting" state. Why isn't

the connection established?

Verify that the PE router has been correctly configured as a PCC, for example:

• Enable external control of LSPs from the PCC router to the NorthStar Controller:

[edit protocols]
user@PE1# setmpls lsp-external-controller pccd

• Specify the NorthStar Controller (northstar1) as the PCE that the PCC connects to,
and specify the NorthStar Controller host external IP address as the destination

address:

[edit protocols]
user@PE1# set pcep pce northstar1 destination-ipv4-address <IP-address>

• Configure the destination port for the PCC router that connects to the NorthStar

Controller (PCE server) using the TCP-based PCEP:

[edit protocols]
user@PE1# set pcep pce northstar1 destination-port 4189

• Youmust also make sure no firewall (or anything else) is blocking the traffic.

• Does the NorthStar Controller UI show the LSP and topology events in real time?

In most cases, the LSP and topology events are displayed in real time. However, the

PCScanperformsomeevent aggregation to reduceprotocol communication between

the server and client if the PCS receives toomany events from the network.

• The /var/log/jnc/pcep_server.log file does not contain any information. How can I get

more verbose PCEP logging?

1. From the NorthStar Controller CLI, run pcep_cli.

2. Type set log-level all

3. Press CTRL-C to exit.
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Related
Documentation

• NorthStar Controller Troubleshooting Guide on page 324

• NorthStar Controller Troubleshooting Overview on page 323
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CHAPTER 13

Additional Troubleshooting Resources

• NorthStar Controller Fail-Safe Mode on page 349

• Enabling the SNMP Daemon on NorthStar Controller on page 351

• Managing the Path Computation Server and Path Computation Element Services on

the NorthStar Controller on page 355

NorthStar Controller Fail-SafeMode

The Cassandra database is a key component of NorthStar Controller operation, with or

without HA. Loss of connectivity to the Cassandra database results in service disruption

for NorthStar northbound interface users because the web UI and REST API become

unavailable. In that event, NorthStar enters into a fail-safe mode that allows users to

retain visibility of the network through NorthStar and enables basic NorthStar functions

until the Cassandra database problem can be corrected.

NOTE: Because Apache Cassandra is an open source software, Cassandra
troubleshooting strategies arewell documented elsewhere. These are some
sample web sites:

• Main: Cassandra Documentation

http://cassandra.apache.org/doc/latest/

• Supplemental: CassandraWiki

https://wiki.apache.org/cassandra/ArticlesAndPresentations

• DataStax Enterprise

https://docs.datastax.com/en/dse-trblshoot/doc/index.html

In the case of simple loss of connectivity to the Cassandra database, the NorthStar

processes are actually still running, and there is no service disruption for LSPs controlled

by NorthStar or for newly delegated LSPs created on the routers. However, when you

attempt to access the NorthStar web UI, you see an error message such as:

{"error":"All host(s) tried for query failed. First host tried, 
172.25.152.169:9042: Host considered as DOWN. See innerErrors."}
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When this error is detected by the web server (nodejs), it switches to fail-safe mode so

users can have view-only access.

Loss of connectivity to Cassandra can be compounded by restarting processes in an

attempt to resolve theproblem.RestartingNorthStar processesmight seem likeanatural

troubleshooting step to take when you cannot access the web UI or the REST API. But

if the web UI and REST API are unavailable because connectivity to Cassandra has been

lost, restarting Toposerver and the web server cannot succeed. This results in service

disruption for LSPs controlled by NorthStar. Also, restarting the NorthStar processes

does not correct the Cassandra connectivity problem.

In this case, theweb server and Toposerver switch to fail-safemode, providing view-only

access. Toposerver loads the network topology from the latest network snapshot saved

in the file system.

Fail-SafeMode Functionality

The trigger for fail-safemode is that theCassandradatabase isunavailable. In theabsence

of Cassandra, fail-safe mode cannot emulate full NorthStar functionality, but it does

provide the following:

• The PCEP server and Path Computation Server (PCS) remain running. The web server

(nodejs), Toposerver, and task_scheduler remain running, but in fail-safe mode.

• Even if the Cassandra database has been corrupted, fail-safe mode works.

• Even if only one server in a NorthStar cluster is up and running, fail-safe mode works.

• A fail-safe mode landing page is provided in the NorthStar web UI. Admin user login is

required to access the landing page. Figure 243 on page 350 shows the fail-safemode

landing page. Note the change in color of the topmenu bar and the notation, (Safe
Mode), in the upper right corner.

Figure 243: Fail-Safe Mode Landing Page

• In fail-safemode, existing delegated or PCE-initiated LSPs can be rerouted by the PCS

in the event of network outages.

Copyright © 2019, Juniper Networks, Inc.350

NorthStar Controller User Guide



• Toposerver does not use the Cassandra database to load the networkmodel. Instead,

it loads the network model based on the latest network snapshot collected by the

NorthStar file system. During normal NorthStar operation, the file system collects and

stores network snapshots hourly (by default).

• If HA switchover occurs while Cassandra is inaccessible, the HA agent is still able to

elect an active node as part of fail-safe mode. The NorthStar processes from the new

active node start in fail-safemodewhen they discover that Cassandra is not available.

• While in fail-safe mode, the status of the NorthStar cluster is displayed for all users

via a banner in the web UI. The NorthStar health reporting function also reports the

status of nodes, even when they are down.

Limitations of Fail-SafeMode

Fail-safe mode is intended for temporary use until the Cassandra database can be

restored, and therefore has the following limitations:

• You cannot provision, add, or delete new LSPs.

• There is noguarantee that anetwork snapshot is available. If a snapshot is not available

(possibly due to the timing of hourly snapshot creation and HA switchover activities),

only live data can be visualized in NorthStar Controller. No user-defined properties can

be loaded and considered by NorthStar.

• Onceyouhave restored thecluster tonormaloperation, youmustmanually exit fail-safe

mode by restarting nodejs (infra:web), Toposerver, and task_scheduler:

# supervisorctl restart infra:web collector_main:task_scheduler 
northstar:toposerver

Enabling the SNMPDaemon on NorthStar Controller

TheSNMPdaemon(SNMPD) responds toSNMPrequestpackets. This sectiondescribes

and provides examples for enabling and running SNMPD on the NorthStar Controller.

SNMPD is useful if you prefer tomonitor the NorthStar server using your ownmonitoring

system.

The following net-SNMPman page is a good resource for additional information and

configuration help:

http://www.net-snmp.org/docs/man/snmpd.conf.html

Perform the steps that follow to enable SNMPD on the NorthStar server. Run all

commands in this procedure as the root user on the NorthStar server.

1. Juniper Networks provides a sample snmpd.conf file in the NorthStar build in the

following directory:

/opt/northstar/utils/examples/snmpd.conf

Copy the sample file to your local /usr/share/snmp/ directory.
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2. Modify the /usr/share/snmp/snmpd.conf file to include your company’s settings.

3. Start the service:

#service snmpd start

4. Configure the service to turn on in the event of a reboot:

#chkconfig snmpd on

5. Confirm that your server is listening on port 161 (default snmpd):

#netstat -na | grep 161

6. Wait fiveminutes for trap collection, then check your SNMP collection device or host.

The sample snmpd.conf file included with the NorthStar build sends the following

traps by default:

• Physical location

• Contact information

• Running processes (the supervisord process has been predefined)

• Mounted filesystems (/ and /home have been pre-established)

• System load on themachine, including memory and CPU

The trap2sink line in the sample configuration file tells the host the address of the

traps receiver.

Sample snmpd.conf file included with the NorthStar build:

# snmpd.conf
#
#   - created by the snmpconf configuration program
#
###########################################################################
# SECTION: System Information Setup
#
#   This section defines some of the information reported in
#   the "system" mib group in the mibII tree.

# syslocation: The [typically physical] location of the system.
#   Note that setting this value here means that when trying to
#   perform an snmp SET operation to the sysLocation.0 variable will make
#   the agent return the "notWritable" error code.  IE, including
#   this token in the snmpd.conf file will disable write access to
#   the variable.
#   arguments:  location_string

syslocation Unknown (edit /etc/snmp/snmpd.conf)
syslocation  Bridgewater 
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# syscontact: The contact information for the administrator
#   Note that setting this value here means that when trying to
#   perform an snmp SET operation to the sysContact.0 variable will make
#   the agent return the "notWritable" error code.  IE, including
#   this token in the snmpd.conf file will disable write access to
#   the variable.
#   arguments:  contact_string

syscontact Root <root@localhost> (configure /etc/snmp/snmp.local.conf)
syscontact  “John Doe”
syscontact  "John Doe"

# sysservices: The proper value for the sysServices object.
#   arguments:  sysservices_number

sysservices 78

###########################################################################
# SECTION: Extending the Agent
#
#   You can extend the snmp agent to have it return information
#   that you yourself define.

# pass_persist: Run a persistant process that intepretes the request for an 
entire tree.
#   The pass program defined here will get called for all
#   requests below a certain point in the mib tree.  It is then
#   responsible for returning the right data beyond that point.
#   The pass_persist scripts must be able to stay running and accept input
#   from stdin.
#   
#   arguments: miboid program
#   
#   example: pass_persist .1.3.6.1.4.1.2021.255 /path/to/local/pass_persisttest
#   
#   See the snmpd.conf manual page for further information.

pass_persist   

# dlmod: dynamically extend the agent using a shared-object
#   arguments:  module-name module-path

dlmod   

###########################################################################
# SECTION: Monitor Various Aspects of the Running Host
#
#   The following check up on various aspects of a host.

# proc: Check for processes that should be running.
#     proc NAME [MAX=0] [MIN=0]
#   
#     NAME:  the name of the process to check for.  It must match
#            exactly (ie, http will not find httpd processes).
#     MAX:   the maximum number allowed to be running.  Defaults to 0.
#     MIN:   the minimum number to be running.  Defaults to 0.
#   
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#   The results are reported in the prTable section of the UCD-SNMP-MIB tree
#   Special Case:  When the min and max numbers are both 0, it assumes
#   you want a max of infinity and a min of 1.
#   The following line will be monitoring the supervisord process.

proc  /opt/northstar/thirdparty/python/bin/supervisord 1 1 

# disk: Check for disk space usage of a partition.
#   The agent can check the amount of available disk space, and make
#   sure it is above a set limit.  
#   
#    disk PATH [MIN=100000]
#   
#    PATH:  mount path to the disk in question.
#    MIN:   Disks with space below this value will have the Mib's errorFlag 
set.
#           Can be a raw integer value (units of kB) or a percentage followed
 by the %
#           symbol.  Default value = 100000.
#   
#   The results are reported in the dskTable section of the UCD-SNMP-MIB tree
# The following will monitor the root and home filesystems.

disk  / 
disk  /home 

# load: Check for unreasonable load average values.
#   Watch the load average levels on the machine.
#   
#    load [1MAX=12.0] [5MAX=12.0] [15MAX=12.0]
#   
#    1MAX:   If the 1 minute load average is above this limit at query
#            time, the errorFlag will be set.
#    5MAX:   Similar, but for 5 min average.
#    15MAX:  Similar, but for 15 min average.
#   
#   The results are reported in the laTable section of the UCD-SNMP-MIB tree

load  5 5 5

# file: Check on the size of a file.
#   Display a files size statistics.
#   If it grows to be too large, report an error about it.
#   
#    file /path/to/file [maxsize_in_kilobytes]
#   
#      if maxsize is not specified, assume only size reporting is needed.
#   
#   The results are reported in the fileTable section of the UCD-SNMP-MIB tree

file   

###########################################################################
# SECTION: Access Control Setup
#
#   This section defines who is allowed to talk to your running
#   snmp agent.

# rouser: a SNMPv3 read-only user
#   arguments:  user [noauth|auth|priv] [restriction_oid]
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rouser  northstar  

# rocommunity: a SNMPv1/SNMPv2c read-only access community name
#   arguments:  community [default|hostname|network/bits] [oid]

rocommunity  northstar  

##########################################################################
# SECTION: Trap Destinations
#
#   Here we define who the agent will send traps to.

# trap2sink: A SNMPv2c trap receiver
#   arguments: host [community] [portnum]

trap2sink  192.168.1.161 

#
# Unknown directives read in from other files by snmpconf
#
com2sec notConfigUser  default       public
group   notConfigGroup v1           notConfigUser
group   notConfigGroup v2c           notConfigUser
view    systemview    included   .1.3.6.1.2.1.1
view    systemview    included   .1.3.6.1.2.1.25.1.1
access  notConfigGroup ""      any       noauth    exact  systemview none none
dontLogTCPWrappersConnects yes

Related
Documentation

Managing the Path Computation Server and Path Computation Element Services on

the NorthStar Controller on page 355

•

Managing the Path Computation Server and Path Computation Element Services on
the NorthStar Controller

To perform administrative tasks, you can run commands from the NorthStar Controller

CLI to stop, start, or restartPathComputationServer (PCS)orPathComputationElement

(PCE) services that run on the NorthStar Controller.

We recommend that you run the PCS restart commandwhen encountering either of the

following scenarios:

• If you suspect that the networkmodel is out-of-sync—for example, when LSPs are still

displayed from the UI but the LSPs are no longer on the router.

• If the admin status of LSPs appears to be stuck in “PENDING” when you attempt to

provision LSPs—from the NorthStar Controller UI, the LSPs are displayed as PENDING

and are not provisioned to router.

To manage services on the NorthStar Controller:

1. From the CLI, log in to the NorthStar Controller PCS, for example:
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[northstar_manager-bash-4.1]$ ssh root@10.92.23.31

2. From the prompt, enter username root and password northstar.

Related
Documentation

• NorthStar Controller Troubleshooting Overview on page 323

• FAQs for Troubleshooting the NorthStar Controller on page 345

• NorthStar Controller Troubleshooting Guide on page 324
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